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Preface  
This users guide provides documentation and examples on how to use the OpenModelica system, both for the 
Modelica beginners and advanced users. 
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Chapter 1  
 
Introduction 

The OpenModelica system described in this document has both short-term and long-term goals: 

• The short-term goal is to develop an efficient interactive computational environment for the Modelica 
language, as well as a rather complete implementation of the language. It turns out that with support of 
appropriate tools and libraries, Modelica is very well suited as a computational language for 
development and execution of both low level and high level numerical algorithms, e.g. for control 
system design, solving nonlinear equation systems, or to develop optimization algorithms that are 
applied to complex applications. 

• The longer-term goal is to have a complete reference implementation of the Modelica language, 
including simulation of equation based models and additional facilities in the programming 
environment, as well as convenient facilities for research and experimentation in language design or 
other research activities. However, our goal is not to reach the level of performance and quality 
provided by current commercial Modelica environments that can handle large models requiring 
advanced analysis and optimization by the Modelica compiler. 

The long-term research related goals and issues of the OpenModelica open source implementation of a 
Modelica environment include but are not limited to the following: 

• Development of a complete formal specification of Modelica, including both static and dynamic 
semantics. Such a specification can be used to assist current and future Modelica implementers by 
providing a semantic reference, as a kind of reference implementation. 

• Language design, e.g. to further extend the scope of the language, e.g. for use in diagnosis, structural 
analysis, system identification, etc., as well as modeling problems that require extensions such as partial 
differential equations, enlarged scope for discrete modeling and simulation, etc. 

• Language design to improve abstract properties such as expressiveness, orthogonality, declarativity, 
reuse, configurability, architectural properties, etc. 

• Improved implementation techniques, e.g. to enhance the performance of compiled Modelica code by 
generating code for parallel hardware. 

• Improved debugging support for equation based languages such as Modelica, to make them even easier 
to use. 

• Easy-to-use specialized high-level (graphical) user interfaces for certain application domains. 
• Visualization and animation techniques for interpretation and presentation of results. 
• Application usage and model library development by researchers in various application areas. 
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The OpenModelica environment provides a test bench for language design ideas that, if successful, can be 
submitted to the Modelica Association for consideration regarding possible inclusion in the official Modelica 
standard. 

The current version of the OpenModelica environment allows most of the expression, algorithm, and 
function parts of Modelica to be executed interactively, as well as equation models and Modelica functions to 
be compiled into efficient C code. The generated C code is combined with a library of utility functions, a run-
time library, and a numerical DAE solver.  

1.1 System Overview 
The OpenModelica environment consists of several interconnected subsystems, as depicted in Figure 1-1-1 
below. 
 

• 
 

Modelica 
Compiler 

Interactive 
session handler 

Execution 

Graphical Model 
Editor/Browser 

Textual  
Model Editor 

    

Modelica 
Debugger 

OMNotebook 
DrModelica  

Model Editor 

MDT Eclipse Plugin  
Editor/Browser 

OMOptim 
Optimization  
Subsystem 

 
Figure 1-1-1.  The architecture of the OpenModelica environment. Arrows denote data and control flow. The 
interactive session handler receives commands and shows results from evaluating commands and expressions that 
are translated and executed. Several subsystems provide different forms of browsing and textual editing of 
Modelica code. The debugger currently provides debugging of an extended algorithmic subset of Modelica 

The following subsystems are currently integrated in the OpenModelica environment: 

• An interactive session handler, that parses and interprets commands and Modelica expressions for 
evaluation, simulation, plotting, etc. The session handler also contains simple history facilities, and 
completion of file names and certain identifiers in commands.  

• A Modelica compiler subsystem, translating Modelica to C code, with a symbol table containing 
definitions of classes, functions, and variables. Such definitions can be predefined, user-defined, or 
obtained from libraries. The compiler also includes a Modelica interpreter for interactive usage and 
constant expression evaluation. The subsystem also includes facilities for building simulation 
executables linked with selected numerical ODE or DAE solvers. 

• An execution and run-time module. This module currently executes compiled binary code from 
translated expressions and functions, as well as simulation code from equation based models, linked 
with numerical solvers. In the near future event handling facilities will be included for the discrete and 
hybrid parts of the Modelica language. 
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• Eclipse plugin editor/browser. The Eclipse plugin called MDT (Modelica Development Tooling) 
provides file and class hierarchy browsing and text editing capabilities, rather analogous to previously 
described Emacs editor/browser. Some syntax highlighting facilities are also included. The Eclipse 
framework has the advantage of making it easier to add future extensions such as refactoring and cross 
referencing support. 

• OMNotebook DrModelica model editor. This subsystem provides a lightweight notebook editor, 
compared to the more advanced Mathematica notebooks available in MathModelica. This basic 
functionality still allows essentially the whole DrModelica tutorial to be handled. Hierarchical text 
documents with chapters and sections can be represented and edited, including basic formatting. Cells 
can contain ordinary text or Modelica models and expressions, which can be evaluated and simulated. 
However, no mathematical typesetting facilities are yet available in the cells of this notebook editor. 

• Graphical model editor/browser OMEdit. This is a graphical connection editor, for component based 
model design by connecting instances of Modelica classes, and browsing Modelica model libraries for 
reading and picking component models. The graphical model editor also includes a textual editor for 
editing model class definitions, and a window for interactive Modelica command evaluation. 

• Optimization subsystem OMOptim. This is an optimization subsystem for OpenModelica, currently for 
design optimization choosing an optimal set of design parameters for a model. The current version has 
a graphical user interface, provides genetic optimization algorithms and Pareto front optimization, 
works integrated with the simulators and automatically accesses variables and design parameters from 
the Modelica model. 

• Modelica debugger. The current implementation of debugger provides debugging for an extended 
algorithmic subset of Modelica, excluding equation-based models and some other features, but 
including some meta-programming and model transformation extensions to Modelica. This is a 
conventional full-feature debugger, using Eclipse for displaying the source code during stepping, 
setting breakpoints, etc. Various back-trace and inspection commands are available. The debugger also 
includes a data-view browser for browsing hierarchical data such as tree- or list structures in extended 
Modelica. 

1.2 Interactive Session with Examples 
The following is an interactive session using the interactive session handler in the OpenModelica environment, 
called OMShell –  the OpenModelica Shell). Most of these examples are also available in the OpenModelica 
notebook UsersGuideExamples.onb in the testmodels (C:/OpenModelica/share/doc/omc/testmodels/) 
directory, see also Chapter 4. 

1.2.1 Starting the Interactive Session 

The Windows version which at installation is made available in the start menu as OpenModelica-
>OpenModelica Shell which responds with an interaction window: 
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We enter an assignment of a vector expression, created by the range construction expression 1:12, to be stored 
in the variable x. The value of the expression is returned. 
>> x := 1:12 
 {1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12} 

1.2.2   Using Compiler Debug Trace Flags in Interactive Mode 

When running OMC in interactive mode (for instance using OMShell) one can make use of some of the 
compiler debug trace flags defined in section 2.1.2 in the System Documentation. Here we give a few example 
sessions. 
 

Example Session 1 
 

OpenModelica 1.9.0 
Copyright (c) OSMC 2002-2013 
To get help on using OMShell and OpenModelica, type "help()" and press enter. 
 
>> setDebugFlags("failtrace") 
true 
 
>> model A Integer t = 1.5; end A;  //The type is Integer but 1.5 is of Real Type 
{A} 
 
>> instantiateModel(A) 
"/*- CevalScript.cevalGenerateFunctionDAEs failed( instantiateModel )*/ 
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/*- CevalScript.cevalGenerateFunction failed(instantiateModel)*/ 
- Inst.makeBinding failed 
- Inst.instElement failed: COMPONENT(t in/out: mod: = 1.5 tp: Integer var :VAR, 
baseClass: <nothing>) 
Scope: A 
- Inst.instClassdef failed 
class :A 
- Inst.instClass: A failed 
Inst.instClassInProgram failed 
" 
Error: Type mismatch in modifier, expected type Integer, got modifier =1.5 of type Real 
Error: Error occured while flattening model A 
Error: Type mismatch in modifier, expected type Integer, got modifier =1.5 of type Real 
Error: Error occured while flattening model A 
 

 
Example Session 2 
 

OpenModelica 1.9.0 
Copyright (c) OSMC 2002-2013 
To get help on using OMShell and OpenModelica, type "help()" and press enter. 
 
>> setDebugFlags("dump") 
true 
---DEBUG(dump)--- 
IEXP(Absyn.CALL(Absyn.CREF_IDENT("setDebugFlags", []), 
FUNCTIONARGS(Absyn.STRING("dump"), ))) 
---/DEBUG(dump)--- 
" 
---DEBUG(dump)--- 
IEXP(Absyn.CALL(Absyn.CREF_IDENT("getErrorString", []), FUNCTIONARGS(, ))) 
---/DEBUG(dump)— 
 
>> model B Integer k = 10; end B; 
{B} 
---DEBUG(dump)--- 
Absyn.PROGRAM([ 
Absyn.CLASS("B", false, false, false, Absyn.R_MODEL, 
Absyn.PARTS([Absyn.PUBLIC([Absyn.ELEMENTITEM(Absyn.ELEMENT(false, _, Absyn.UNSPECIFIED 
, "component", Absyn.COMPONENTS(Absyn.ATTR(false, false, Absyn.VAR, Absyn.BIDIR, 
[]),Integer,[Absyn.COMPONENTITEM(Absyn.COMPONENT("k",[], SOME(Absyn.CLASSMOD([], 
SOME(Absyn.INTEGER(10))))), NONE())]), Absyn.INFO("", false, 1, 9, 1, 23)), NONE))])], 
NONE()), Absyn.INFO("", false, 1, 1, 1, 30)) 
],Absyn.TOP) 
---/DEBUG(dump)--- 
" 
---DEBUG(dump)--- 
IEXP(Absyn.CALL(Absyn.CREF_IDENT("getErrorString", []), FUNCTIONARGS(, ))) 
---/DEBUG(dump)— 
 
>> instantiateModel(B) 
"fclass B 
Integer k = 10; 
end B; 
" 
---DEBUG(dump)--- 
IEXP(Absyn.CALL(Absyn.CREF_IDENT("instantiateModel", []), 
FUNCTIONARGS(Absyn.CREF(Absyn.CREF_IDENT("B", [])), ))) 
---/DEBUG(dump)--- 
" 
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---DEBUG(dump)--- 
IEXP(Absyn.CALL(Absyn.CREF_IDENT("getErrorString", []), FUNCTIONARGS(, ))) 
---/DEBUG(dump)— 
 
>> simulate(B, startTime=0, stopTime=1, numberOfIntervals=500, tolerance=1e-4) 
record SimulationResult 
resultFile = "B_res.plt" 
end SimulationResult; 
---DEBUG(dump)--- 
#ifdef __cplusplus 
extern "C" { 
#endif 
#ifdef __cplusplus 
} 
#endif 
IEXP(Absyn.CALL(Absyn.CREF_IDENT("simulate", []), 
FUNCTIONARGS(Absyn.CREF(Absyn.CREF_IDENT("B", [])), startTime = Absyn.INTEGER(0), 
stopTime = Absyn.INTEGER(1), numberOfIntervals = Absyn.INTEGER(500), tolerance = 
Absyn.REAL(0.0001)))) 
---/DEBUG(dump)--- 
" 
---DEBUG(dump)--- 
IEXP(Absyn.CALL(Absyn.CREF_IDENT("getErrorString", []), FUNCTIONARGS(, ))) 
---/DEBUG(dump)-- 

 
 
Example Session 3 
 

OpenModelica 1.9.0 
Copyright (c) OSMC 2002-2013 
To get help on using OMShell and OpenModelica, type "help()" and press enter. 
 
>> setDebugFlags("failtrace") 
true 
 
>> model C Integer a; Real b; equation der(a) = b; der(b) = 12.0; end C; 
{C} 
 
>> instantiateModel(C) 
"/*- CevalScript.cevalGenerateFunctionDAEs failed( instantiateModel )*/ 
/*- CevalScript.cevalGenerateFunction failed(instantiateModel)*/ 
- Static.elabCall failed 
function: der posargs: a 
- Static.elabExp failed: der(a) 
Scope: C 
- instEquationCommon failed for eqn: der(a) = b; in scope:C 
- instEquation failed eqn:der(a) = b; 
- Inst.instClassdef failed 
class :C 
- Inst.instClass: C failed 
Inst.instClassInProgram failed 
" 
Error: Illegal derivative. der(a) where a is of type Integer, which is not a subtype of 
Real 
Error: Wrong type or wrong number of arguments to der(a)'. 
Error: Error occured while flattening model C 
Error: Illegal derivative. der(a) where a is of type Integer, which is not a subtype of 
Real 
Error: Wrong type or wrong number of arguments to der(a)'. 
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Error: Error occured while flattening model C 

1.2.3 Trying the Bubblesort Function 

Load the function bubblesort, either by using the pull-down menu File->Load Model, or by explicitly 
giving the command: 
>> loadFile("C:/OpenModelica1.9.0/share/doc/omc/testmodels/bubblesort.mo") 

true 

The function bubblesort is called below to sort the vector x in descending order. The sorted result is returned 
together with its type. Note that the result vector is of type Real[:], instantiated as Real[12], since this is 
the declared type of the function result. The input Integer vector was automatically converted to a Real 
vector according to the Modelica type coercion rules. The function is automatically compiled when called if 
this has not been done before. 
>> bubblesort(x) 
{12.0,11.0,10.0,9.0,8.0,7.0,6.0,5.0,4.0,3.0,2.0,1.0} 

Another call: 
>> bubblesort({4,6,2,5,8}) 
{8.0,6.0,5.0,4.0,2.0} 

It is also possible to give operating system commands via the system utility function. A command is provided 
as a string argument. The example below shows the system utility applied to the UNIX command cat, which 
here outputs the contents of the file bubblesort.mo to the output stream. However, the cat command does not 
boldface Modelica keywords – this improvement has been done by hand for readability. 
>> cd("C:/OpenModelica1.9.0/share/doc/omc/testmodels/") 
>> system("cat bubblesort.mo") 

function bubblesort 
  input Real[:] x; 
  output Real[size(x,1)] y; 
protected 
  Real t; 
algorithm 
  y := x; 
  for i in 1:size(x,1) loop 
    for j in 1:size(x,1) loop 
      if y[i] > y[j] then 
        t := y[i]; 
        y[i] := y[j]; 
        y[j] := t; 
      end if;  
    end for; 
  end for; 
end bubblesort; 

1.2.4 Trying the system and cd Commands 

Note: Under Windows the output emitted into stdout by system commands is put into the winmosh console 
windows, not into the winmosh interaction windows. Thus the text emitted by the above cat command would 
not be returned. Only a success code (0 = success, 1 = failure) is returned to the winmosh window. For 
example:  
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>> system("dir") 
0 

>> system("Non-existing command") 
1 

Another built-in command is cd, the change current directory command. The resulting current directory is 
returned as a string. 
>> cd() 
" C:/OpenModelica1.9.0/share/doc/omc/testmodels/" 
 
>> cd("..") 
" C:/OpenModelica1.9.0/share/doc/omc/" 
 
>> cd("C:/OpenModelica1.9.0/share/doc/omc/testmodels/") 
" C:/OpenModelica1.9.0/share/doc/omc/testmodels/" 

1.2.5 Modelica Library and DCMotor Model 

We load a model, here the whole Modelica standard library, which also can be done through the File->Load 
Modelica Library menu item: 
>> loadModel(Modelica) 
true 

We also load a file containing the dcmotor model: 
>> loadFile("C:/OpenModelica1.9.0/share/doc/omc/testmodels/dcmotor.mo") 
true 

It is simulated: 
>> simulate(dcmotor,startTime=0.0,stopTime=10.0) 

record 
    resultFile = "dcmotor_res.plt" 
end record 

We list the source code of the model: 
>> list(dcmotor) 

"model dcmotor 
  Modelica.Electrical.Analog.Basic.Resistor r1(R=10); 
  Modelica.Electrical.Analog.Basic.Inductor i1; 
  Modelica.Electrical.Analog.Basic.EMF emf1; 
  Modelica.Mechanics.Rotational.Inertia load; 
  Modelica.Electrical.Analog.Basic.Ground g; 
  Modelica.Electrical.Analog.Sources.ConstantVoltage v; 
 
equation  
  connect(v.p,r1.p); 
  connect(v.n,g.p); 
  connect(r1.n,i1.p); 
  connect(i1.n,emf1.p); 
  connect(emf1.n,g.p); 
  connect(emf1.flange_b,load.flange_a); 
end dcmotor; 
" 

We test code instantiation of the model to flat code: 
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>> instantiateModel(dcmotor) 

"fclass dcmotor 
Real r1.v "Voltage drop between the two pins (= p.v - n.v)"; 
Real r1.i "Current flowing from pin p to pin n"; 
Real r1.p.v "Potential at the pin"; 
Real r1.p.i "Current flowing into the pin"; 
Real r1.n.v "Potential at the pin"; 
Real r1.n.i "Current flowing into the pin"; 
parameter Real r1.R = 10 "Resistance"; 
Real i1.v "Voltage drop between the two pins (= p.v - n.v)"; 
Real i1.i "Current flowing from pin p to pin n"; 
Real i1.p.v "Potential at the pin"; 
Real i1.p.i "Current flowing into the pin"; 
Real i1.n.v "Potential at the pin"; 
Real i1.n.i "Current flowing into the pin"; 
parameter Real i1.L = 1 "Inductance"; 
parameter Real emf1.k = 1 "Transformation coefficient"; 
Real emf1.v "Voltage drop between the two pins"; 
Real emf1.i "Current flowing from positive to negative pin"; 
Real emf1.w "Angular velocity of flange_b"; 
Real emf1.p.v "Potential at the pin"; 
Real emf1.p.i "Current flowing into the pin"; 
Real emf1.n.v "Potential at the pin"; 
Real emf1.n.i "Current flowing into the pin"; 
Real emf1.flange_b.phi "Absolute rotation angle of flange"; 
Real emf1.flange_b.tau "Cut torque in the flange"; 
Real load.phi "Absolute rotation angle of component (= flange_a.phi = flange_b.phi)"; 
Real load.flange_a.phi "Absolute rotation angle of flange"; 
Real load.flange_a.tau "Cut torque in the flange"; 
Real load.flange_b.phi "Absolute rotation angle of flange"; 
Real load.flange_b.tau "Cut torque in the flange"; 
parameter Real load.J = 1 "Moment of inertia"; 
Real load.w "Absolute angular velocity of component"; 
Real load.a "Absolute angular acceleration of component"; 
Real g.p.v "Potential at the pin"; 
Real g.p.i "Current flowing into the pin"; 
Real v.v "Voltage drop between the two pins (= p.v - n.v)"; 
Real v.i "Current flowing from pin p to pin n"; 
Real v.p.v "Potential at the pin"; 
Real v.p.i "Current flowing into the pin"; 
Real v.n.v "Potential at the pin"; 
Real v.n.i "Current flowing into the pin"; 
parameter Real v.V = 1 "Value of constant voltage"; 
equation 
  r1.R * r1.i = r1.v; 
  r1.v = r1.p.v - r1.n.v; 
  0.0 = r1.p.i + r1.n.i; 
  r1.i = r1.p.i; 
  i1.L * der(i1.i) = i1.v; 
  i1.v = i1.p.v - i1.n.v; 
  0.0 = i1.p.i + i1.n.i; 
  i1.i = i1.p.i; 
  emf1.v = emf1.p.v - emf1.n.v; 
  0.0 = emf1.p.i + emf1.n.i; 
  emf1.i = emf1.p.i; 
  emf1.w = der(emf1.flange_b.phi); 
  emf1.k * emf1.w = emf1.v; 
  emf1.flange_b.tau = -(emf1.k * emf1.i); 
  load.w = der(load.phi); 
  load.a = der(load.w); 
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  load.J * load.a = load.flange_a.tau + load.flange_b.tau; 
  load.flange_a.phi = load.phi; 
  load.flange_b.phi = load.phi; 
  g.p.v = 0.0; 
  v.v = v.V; 
  v.v = v.p.v - v.n.v; 
  0.0 = v.p.i + v.n.i; 
  v.i = v.p.i; 
  emf1.flange_b.tau + load.flange_a.tau = 0.0; 
  emf1.flange_b.phi = load.flange_a.phi; 
  emf1.n.i + v.n.i + g.p.i = 0.0; 
  emf1.n.v = v.n.v; 
  v.n.v = g.p.v; 
  i1.n.i + emf1.p.i = 0.0; 
  i1.n.v = emf1.p.v; 
  r1.n.i + i1.p.i = 0.0; 
  r1.n.v = i1.p.v; 
  v.p.i + r1.p.i = 0.0; 
  v.p.v = r1.p.v; 
  load.flange_b.tau = 0.0; 
end dcmotor; 
" 

We plot part of the simulated result: 
>> plot({load.w,load.phi}) 
true 
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1.2.6 The val() function 

The val(variableName,time) scription function can be used to retrieve the interpolated value of a simulation 
result variable at a certain point in the simulation time, see usage in the BouncingBall simulation below. 

1.2.7 BouncingBall and Switch Models 

We load and simulate the BouncingBall example containing when-equations and if-expressions (the Modelica 
keywords have been bold-faced by hand for better readability): 
>> loadFile("C:/OpenModelica1.9.0/share/doc/omc/testmodels/BouncingBall.mo") 

true 

>> list(BouncingBall) 
"model BouncingBall 
  parameter Real e=0.7 "coefficient of restitution"; 
  parameter Real g=9.81 "gravity acceleration"; 
  Real h(start=1) "height of ball"; 
  Real v "velocity of ball"; 
  Boolean flying(start=true) "true, if ball is flying"; 
  Boolean impact; 
  Real v_new; 
equation  
  impact=h <= 0.0; 
  der(v)=if flying then -g else 0; 
  der(h)=v; 
  when {h <= 0.0 and v <= 0.0,impact} then 
    v_new=if edge(impact) then -e*pre(v) else 0; 
    flying=v_new > 0; 
    reinit(v, v_new); 
  end when; 
end BouncingBall;" 

Instead of just giving a simulate and plot command, we perform a runScript command on a .mos 
(Modelica script) file sim_BouncingBall.mos that contains these commands: 
loadFile("BouncingBall.mo"); 
simulate(BouncingBall, stopTime=3.0); 
plot({h,flying});  

The runScript command: 
>> runScript("sim_BouncingBall.mos") 
"true 
record 
    resultFile = "BouncingBall_res.plt" 
end record 
true 
true" 
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We enter a switch model, to test if-equations (e.g. copy and paste from another file and push enter): 
>> model Switch 
  Real v; 
  Real i; 
  Real i1; 
  Real itot; 
  Boolean open; 
equation 
  itot = i + i1; 

  if open then 
    v = 0; 
  else 
    i = 0; 
  end if; 
   1 - i1 = 0; 
   1 - v - i = 0; 
   open = time >= 0.5; 
end Switch; 
Ok 

>> simulate(Switch, startTime=0, stopTime=1);  

Retrieve the value of itot at time=0 using the val(variableName,time) function: 
>> val(itot,0) 
1 

Plot itot and open: 
>> plot({itot,open}) 
true 
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We note that the variable open switches from false (0) to true (1), causing itot to increase from 1.0 to 2.0. 

1.2.8 Clear All Models 

Now, first clear all loaded libraries and models: 
>> clear() 
true 

List the loaded models – nothing left: 
>> list() 
"" 

1.2.9 VanDerPol Model and Parametric Plot 

We load another model, the VanDerPol model (or via the menu File->Load Model): 
>> loadFile("C:/OpenModelica1.9.0/share/doc/omc/testmodels/VanDerPol.mo")) 
true 

It is simulated: 
>> simulate(VanDerPol) 
record 
    resultFile = "VanDerPol_res.plt" 
end record 

It is plotted: 
plotParametric(x,y); 
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Perform code instantiation to flat form of the VanDerPol model: 
>> instantiateModel(VanDerPol) 

"fclass VanDerPol 
Real x(start=1.0); 
Real y(start=1.0); 
parameter Real lambda = 0.3; 
equation 
  der(x) = y; 
  der(y) = -x + lambda * (1.0 - x * x) * y; 
end VanDerPol; 
" 

1.2.10 Using Japanese or Chinese Characters 

Japenese, Chinese, and other kinds of UniCode characters can be used within quoted (single quote) identifiers, 
see for example the variable name to the right in the plot below: 
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1.2.11 Scripting with For-Loops, While-Loops, and If-Statements 

A simple summing integer loop (using multi-line input without evaluation at each line into OMShell requires 
copy-paste as one operation from another document): 
>> k := 0; 
   for i in 1:1000 loop 
     k := k + i; 
   end for; 

>> k 
500500 

A nested loop summing reals and integers:: 
>> g := 0.0; 
   h := 5; 
   for i in {23.0,77.12,88.23} loop 
     for j in i:0.5:(i+1) loop 
       g := g + j; 
       g := g + h / 2; 
     end for; 
     h := h + g; 
   end for; 

By putting two (or more) variables or assignment statements separated by semicolon(s), ending with a variable, 
one can observe more than one variable value: 
>> h;g 
1997.45 
1479.09 

A for-loop with vector traversal and concatenation of string elements: 
>> i:=""; 
   lst := {"Here ", "are ","some ","strings."}; 
   s := ""; 
   for i in lst loop 
     s := s + i; 
   end for; 

>> s 
"Here are some strings." 

Normal while-loop with concatenation of 10 "abc " strings: 
>> s:=""; 
   i:=1; 
   while i<=10 loop 
     s:="abc "+s; 
     i:=i+1; 
   end while; 

>> s 
"abc abc abc abc abc abc abc abc abc abc " 

A simple if-statement. By putting the variable last, after the semicolon, its value is returned after evaluation: 
>> if 5>2 then a := 77; end if; a 
77 

An if-then-else statement with elseif: 
>> if false then 
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     a := 5; 
   elseif a > 50 then 
     b:= "test"; a:= 100; 
   else 
     a:=34; 
   end if; 

Take a look at the variables a and b: 
>> a;b 

100 
"test" 

1.2.12 Variables, Functions, and Types of Variables 

Assign a vector to a variable: 
>> a:=1:5 
{1,2,3,4,5} 

Type in a function: 
>> function MySqr input Real x; output Real y; algorithm y:=x*x; end MySqr; 
Ok 

Call the function: 
>> b:=MySqr(2) 
4.0 

Look at the value of variable a: 
>> a 
{1,2,3,4,5} 

Look at the type of a: 
>> typeOf(a) 
"Integer[]" 

Retrieve the type of b: 
>> typeOf(b) 
"Real" 
 

What is the type of MySqr? Cannot currently be handled. 
>> typeOf(MySqr) 
Error evaluating expr. 

List the available variables: 
>> listVariables() 
{currentSimulationResult, a, b} 

Clear again: 
>> clear() 
true 
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1.2.13 Getting Information about Error Cause 

Call the function getErrorString() in order to get more information about the error cause after a 
simulation failure: 
>> getErrorString() 

1.2.14 Alternative Simulation Output Formats  

There are several output format possibilities, with mat being the default. plt and mat are the only formats that 
allow you to use the val() or plot() functions after a simulation. Compared to the speed of plt, mat is 
roughly 5 times for small files, and scales better for larger files due to being a binary format. The csv format is 
roughly twice as fast as plt on data-heavy simulations. The plt format allocates all output data in RAM 
during simulation, which means that simulations may fail due applications only being able to address 4GB of 
memory on 32-bit platforms. Empty does no output at all and should be by far the fastest. The csv and plt 
formats are suitable when using an external scripts or tools like gnuplot to generate plots or process data. The 
mat format can be post-processed in MATLAB1 or Octave2

simulate(... , outputFormat="mat") 

. 

simulate(... , outputFormat="csv") 

simulate(... , outputFormat="plt") 

simulate(... , outputFormat="empty") 

It is also possible to specify which variables should be present in the result-file. This is done by using POSIX 
Extended Regular Expressions3

// Default, match everything 

. The given expression must match the full variable name (^ and $ symbols are 
automatically added to the given regular expression). 

simulate(... , variableFilter=".*") 

// match indices of variable myVar that only contain the numbers using combinations 

// of the letters 1 through 3 

simulate(... , variableFilter="myVar\\[[1-3]*\\]") 

// match x or y or z 

simulate(... , variableFilter="x|y|z") 

1.2.15 Using External Functions 

See Chapter 12 for more information about calling functions in other programming languages. 

1.2.16 Using Parallel Simulation via OpenMP Multi-Core Support 

Faster simulations on multi-core computers can be obtained by using a new OpenModelica feature that 
automatically partitions the system of equations and schedules the parts for execution on different cores using 

                                                 
1 http://www.mathworks.com/products/matlab/ 
2 http://www.gnu.org/software/octave/ 
3 http://en.wikipedia.org/wiki/Regular_expression 

http://www.mathworks.com/products/matlab�
http://www.gnu.org/software/octave/�
http://en.wikipedia.org/wiki/Regular_expression�
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shared-memory OpenMP based execution. The speedup obtained is dependent on the model structure, whether 
the system of equations can be partitioned well. This version in the OpenModelica 1.8 release is an 
experimental version without load balancing. The following command, not yet available from the 
OpenModelica GUI, will run a parallel simulation on a model: 
omc +d=openmp model.mo 

1.2.17 Loading Specific Library Version 

There exist many different versiosn of Modelica libraries which are not compatible. It is possible to keep 
multiple versions of the same library stored in the directory given by calling getModelicaPath(). By calling 
loadModel(Modelica,{"3.2"}), OpenModelica will search for a directory called "Modelica 3.2" or a file 
called "Modelica 3.2.mo". It is possible to give several library versions to search for, giving preference for a 
pre-release version of a library if it is installed. If the searched version is "default", the priority is: no version 
name (Modelica), main release version (Modelica 3.1), pre-release version (Modelica 3.1Beta 1) and unordered 
versions (Modelica Special Release). 

The loadModel command will also look at the uses annotation of the top-level class after it has been 
loaded. Given the following package, Complex 1.0 and ModelicaServices 1.1 will also be loaded into the AST 
automatically. 
package Modelica 
  annotation(uses(Complex(version="1.0"), ModelicaServices(version="1.1"))) 
end Modelica; 

1.2.18 Calling the Model Query and Manipulation API 

In the OpenModelica System Documentation, an external API (application programming interface) is described 
which returns information about models and/or allows manipulation of models. Calls to these functions can be 
done interactively as below, but more typically by program clients to the OpenModelica Compiler (OMC) 
server. Current examples of such clients are the OpenModelica MDT Eclipse plugin, OMNotebook, the 
OMEdit graphic model editor, etc. This API is untyped for performance reasons, i.e., no type checking and 
minimal error checking is done on the calls. The results of a call is returned as a text string in Modelica syntax 
form, which the client has to parse. An example parser in C++ is available in the OMNotebook source code, 
whereas another example parser in Java is available in the MDT Eclipse plugin. 

Below we show a few calls on the previously simulated BouncingBall model. The full documentation on 
this API is available in the system documentation. First we load and list the model again to show its structure: 
>>loadFile("C:/OpenModelica1.9.0/share/doc/omc/testmodels/BouncingBall.mo") 
true 

>>list(BouncingBall) 

"model BouncingBall 
  parameter Real e=0.7 "coefficient of restitution"; 
  parameter Real g=9.81 "gravity acceleration"; 
  Real h(start=1) "height of ball"; 
  Real v "velocity of ball"; 
  Boolean flying(start=true) "true, if ball is flying"; 
  Boolean impact; 
  Real v_new; 
equation 
  impact=h <= 0.0; 
  der(v)=if flying then -g else 0; 
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  der(h)=v; 
  when {h <= 0.0 and v <= 0.0,impact} then 
    v_new=if edge(impact) then -e*pre(v) else 0; 
    flying=v_new > 0; 
    reinit(v, v_new); 
  end when; 
end BouncingBall; 
" 

Different kinds of calls with returned results: 
>>getClassRestriction(BouncingBall) 
"model" 

>>getClassInformation(BouncingBall) 
{"model","","",{false,false,false},{"writable",1,1,18,17}} 

>>isFunction(BouncingBall) 
false 

>>existClass(BouncingBall) 
true 

>>getComponents(BouncingBall) 
{{Real,e,"coefficient of restitution", "public", false, false, false, 
"parameter", "none", "unspecified"}, 
{Real,g,"gravity acceleration", 
"public", false, false, false, "parameter", "none", "unspecified"}, 
{Real,h,"height of ball", "public", false, false, false, 
"unspecified", "none", "unspecified"}, 
{Real,v,"velocity of ball", 
"public", false, false, false, "unspecified", "none", "unspecified"}, 
{Boolean,flying,"true, if ball is flying", "public", false, false, 
false, "unspecified", "none", "unspecified"}, 
{Boolean,impact,"", 
"public", false, false, false, "unspecified", "none", "unspecified"}, 
{Real,v_new,"", "public", false, false, false, "unspecified", "none", 
"unspecified"}} 

>>getConnectionCount(BouncingBall) 
0 

>>getInheritanceCount(BouncingBall) 
0 

>>getComponentModifierValue(BouncingBall,e) 
0.7 

>>getComponentModifierNames(BouncingBall,e) 
{} 

>>getClassRestriction(BouncingBall) 
"model" 

>>getVersion() // Version of the currently running OMC 
"1.6" 

1.2.19 Quit OpenModelica 

Leave and quit OpenModelica: 
>> quit() 
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1.2.20 Dump XML Representation 

The command dumpXMLDAE dumps an XML representation of a model, according to several optional 
parameters. 
dumpXMLDAE(modelname[,asInSimulationCode=<Boolean>] [,filePrefix=<String>] 
[,storeInTemp=<Boolean>] [,addMathMLCode =<Boolean>])  

This command dumps the mathematical representation of a model using an XML representation, with optional 
parameters. In particular, asInSimulationCode defines where to stop in the translation process (before 
dumping the model), the other options are relative to the file storage: filePrefix for specifying a different 
name and storeInTemp to use the temporary directory. The optional parameter addMathMLCode gives the 
possibility to don't print the MathML code within the xml file, to make it more readable. Usage is trivial, just: 
addMathMLCode=true/false (default value is false). 

1.2.21 Dump Matlab Representation 

The command export dumps an XML representation of a model, according to several optional parameters. 
exportDAEtoMatlab(modelname);  

This command dumps the mathematical representation of a model using a Matlab representation. Example: 
$ cat daequery.mos 
loadFile("BouncingBall.mo"); 
exportDAEtoMatlab(BouncingBall); 
readFile("BouncingBall_imatrix.m"); 
 
$ omc daequery.mos  
true 
"The equation system was dumped to Matlab file:BouncingBall_imatrix.m" 

 " 
% Incidence Matrix 
% ==================================== 
% number of rows: 6 
IM={[3,-6],[1,{'if', 'true','==' {3},{},}],[2,{'if', 'edge(impact)' 
{3},{5},}],[4,2],[5,{'if', 'true','==' {4},{},}],[6,-5]}; 
VL = {'foo','v_new','impact','flying','v','h'}; 
 

 
EqStr = {'impact = h <= 0.0;','foo = if impact then 1 else 2;','when {h <= 0.0 AND v 
<= 0.0,impact} then v_new = if edge(impact) then (-e) * pre(v) else 0.0; end 
when;','when {h <= 0.0 AND v <= 0.0,impact} then flying = v_new > 0.0; end 
when;','der(v) = if flying then -g else 0.0;','der(h) = v;'}; 
 
OldEqStr={'fclass BouncingBall','parameter Real e = 0.7 "coefficient of 
restitution";','parameter Real g = 9.81 "gravity acceleration";','Real h(start = 1.0) 
"height of ball";','Real v "velocity of ball";','Boolean flying(start = true) "true, 
if ball is flying";','Boolean impact;','Real v_new;','Integer foo;','equation','  
impact = h <= 0.0;','  foo = if impact then 1 else 2;','  der(v) = if flying then -g 
else 0.0;','  der(h) = v;','  when {h <= 0.0 AND v <= 0.0,impact} then','  v_new = if 
edge(impact) then (-e) * pre(v) else 0.0;','  flying = v_new > 0.0;','  
reinit(v,v_new);','  end when;','end BouncingBall;',''};" 
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1.3 Summary of Commands for the Interactive Session Handler 
The following is the complete list of commands currently available in the interactive session hander. 
simulate(modelname) Translate a model named modelname and simulate it. 
simulate(modelname[,startTime=<Real>][,stopTime=<Real>][,numberOfIntervals 

=<Integer>][,outputInterval=<Real>][,method=<String>] 
[,tolerance=<Real>][,fixedStepSize=<Real>] 
[,outputFormat=<String>]) Translate and simulate a model, with 
optional start time, stop time, and optional number of simulation intervals or 
steps for which  the simulation results will be computed. More intervals will 
give higher time resolution, but occupy more space and take longer to 
compute. The default number of intervals is 500. It is possible to choose 
solving method, default is “dassl”, “euler” and “rungekutta” are also 
available. Output format “mat” is default. “plt” and “mat” (MATLAB) are 
the only ones that work with the val() command, “csv” (comma separated 
values) and “empty” (no output) are also available (see chapter 1.2.14). 

plot(vars)  Plot the variables given as a vector or a scalar, e.g. plot({x1,x2}) or 
plot(x1). 

plotParametric(var1, var2)  Plot var2 relative to var1 from the most recently simulated model, e.g. 
plotParametric(x,y). 

cd()  Return the current directory. 
cd(dir)  Change directory to the directory given as string. 
clear()  Clear all loaded definitions. 
clearVariables()  Clear all defined variables. 
dumpXMLDAE(modelname, ...) Dumps an XML representation of a model, according to several optional 

parameters. 
exportDAEtoMatlab(name) Dumps a Matlab representation of a model. 

instantiateModel(modelname)Performs code instantiation of a model/class and return a string containing 
the flat class definition. 

list()  Return a string containing all loaded class definitions. 
list(modelname)  Return a string containing the class definition of the named class. 
listVariables()  Return a vector of the names of the currently defined variables. 
loadModel(classname) Load model or package of name classname from the path indicated by the 

environment variable OPENMODELICALIBRARY. 
loadFile(str)  Load Modelica file (.mo) with name given as string argument str. 
readFile(str)  Load file given as string str and return a string containing the file content. 
runScript(str)  Execute script file with file name given as string argument str. 
system(str)  Execute str as a system(shell) command in the operating system; return 

integer success value. Output into stdout from a shell command is put into 
the console window. 

timing(expr)  Evaluate expression expr and return the number of seconds (elapsed time) 
the evaluation took. 
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typeOf(variable)  Return the type of the variable as a string. 
saveModel(str,modelname) Save the model/class with name modelname in the file given by the string 

argument str. 
val(variable,timePoint)  Return the (interpolated) value of the variable at time timePoint. 
help() Print this helptext (returned as a string). 
quit() Leave and quit the OpenModelica environment 

 

1.4 References  
Peter Fritzson, Peter Aronsson, Håkan Lundvall, Kaj Nyström, Adrian Pop, Levon Saldamli, and David 

Broman. The OpenModelica Modeling, Simulation, and Software Development Environment. 
In Simulation News Europe, 44/45, December 2005. See also:  http://www.openmodelica.org. 

Peter Fritzson. Principles of Object-Oriented Modeling and Simulation with Modelica 2.1, 940 pp., ISBN 
0-471-471631, Wiley-IEEE Press, 2004. 

The Modelica Association. The Modelica Language Specification Version 3.0, Sept 2007. 
http://www.modelica.org. 
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Chapter 2  
 
OMEdit – OpenModelica Connection Editor 

OMEdit – OpenModelica Connection Editor is the new Graphical User Interface for graphical model editing in 
OpenModelica. It is implemented in C++ using the Qt 4.8 graphical user interface library and supports the 
Modelica Standard Library version 3.1 that is included in the latest OpenModelica installation. This chapter 
gives a brief introduction to OMEdit and also demonstrates how to create a DCMotor model using the editor. 

OMEdit provides several user friendly features for creating, browsing, editing, and simulating models: 

• Modeling – Easy model creation for Modelica models. 
• Pre-defined models – Browsing the Modelica Standard library to access the provided models. 
• User defined models – Users can create their own models for immediate usage and later reuse. 
• Component interfaces – Smart connection editing for drawing and editing connections between model 

interfaces. 
• Simulation – Subsystem for running simulations and specifying simulation parameters start and stop 

time, etc. 
• Plotting – Interface to plot variables from simulated models. 

2.1 Starting OMEdit 

2.1.1 Microsoft Windows 

OMEdit can be launched using the executable placed in 
OpenModelicaInstallationDirectory/bin/OMEdit/OMEdit.exe. Alternately, choose 
OpenModelica > OpenModelica Connection Editor from the start menu in Windows. A splash screen 
similar to the one shown in Figure 2-1 will appear indicating that it is starting OMEdit. 

2.1.1 Linux 

Start OMEdit by either selecting the corresponding menu application item or typing “OMEdit” at  the shell or 
command prompt. 

2.1.2 Mac OS X 

?? fill in 
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Figure 2-1: OMEdit Splash Screen. 

2.2 MainWindow & Browsers 
The MainWindow contains several dockable browsers, 

• Search Browser 
• Libraries Browser 
• Documentation Browser 
• Variables Browser 
• Messages Browser 

Figure 2-2 shows the MainWindow and browsers. 
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Figure 2-2: OMEdit MainWindow and Browsers. 

The default location of the browsers are shown in Figure 2-2. All browsers except for Message Browser can 
be docked into left or right column. The Messages Browser can be docked into left,right or bottom areas. If 
you want OMEdit to remember the new docked position of the browsers then you must enable Preserve 
User's GUI Customizations option, see section 2.8.1. 

2.2.1 Search Browser 

 
Figure 2-3: Search Browser. 
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The loaded Modelica classes can be searched by typing any part of the class name. It is also possible to search 
the Modelica class if one knows the text string that is used within it but Within Modelica text checkbox 
should be checked for this feature to work. 

2.2.2 Libraries Browser 

Shows the list of loaded Modelica classes. Each item of the Libraries Browser has context menu for easy 
manipulation and usage of the class. The classes are shown in a tree structure with name and icon. The 
protected classes are not shown by default. If you want to see the protected classes then you must enable the 
Show Protected Classes option, see section 2.8.1. 

 
Figure 2-4: Libraries Browser. 
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2.2.3 Documentation Browser 

Displays the HTML documentation of Modelica classes. It contains the navigation buttons for moving forward 
and backward. 

 
Figure 2-5: Documentation Browser. 

2.2.4 Variables Browser 

The class variables are structured in the form of the tree and are displayed in the Variables Browser. Each 
variable has a checkbox. Ticking the checkbox will plot the variable values. There is a search box on the top for 
searching the variable in the tree. 
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Figure 2-6: Variables Browser. 

2.2.5 Messages Browser 

Shows the list of errors. Following kinds of error can occur, 

• Syntax 
• Grammar 
• Translation 
• Symbolic 
• Simulation 
• Scripting 

Messages Browser contains some manipulation buttons on the right side which allows filtering of the error 
messages. The browser has a context menu for copying and deleting the error messages. 

 
Figure 2-7: Messages Browser. 
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2.3 Perspectives 
OMEdit has four different perspectives, 

• Welcome Perspective 
• Modeling Perspective 
• Plotting Perspective 
• Interactive Simulation Perspective 

The perspective tabs are loacted at the bottom right of the MainWindow. The user can switch between the 
perspectives by choosing/clicking the perspective tab. 

2.3.1 Welcome Perspective 

The Welcome Perspective shows the list of recent files and the list of latest news from openmodelica.org. 
See Figure 2-8. 

 
Figure 2-8: OMEdit Welcome Perspective. 

https://www.openmodelica.org/�
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2.3.2 Modeling Perspective 

The Modeling Perpective provides the interface where user can create and design their models. See Figure 
2-9. 

 
Figure 2-9: OMEdit Modeling Perspective. 

The Modeling Perspective interface can be viewed in two different modes, the tabbed view and 
subwindow view, see section 2.8.1. 

2.3.3 Plotting Perspective 

The Plotting Perspective shows the simulation results of the models. Plotting Perspective will 
automatically become active when the simulation of the model is finished successfully. It will also become 
active when user opens any of the OpenModelica’s supported result file. Similar to Modeling Perspective 
this perspective can also be viewed in two different modes, the tabbed view and subwindow view, see 
section 2.8.1. 
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Figure 2-10: OMEdit Plotting Perspective. 

2.3.4 Interactive Simulation Perspective 

Will be available soon. 

2.4 Modeling a Model 

2.4.1 Creating a New Modelica class 

Creating a new Modelica class in OMEdit is rather straightforward. Choose any of the following methods, 

• Select File > New Modelica Class from the menu. 
• Click on New Modelica Class toolbar button. 
• Click on the Create New Modelica Class button available at the left bottom of Welcome 

Perspective. 
• Press Ctrl+N. 
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2.4.2 Opening a Modelica File 

Choose any of the following methods to open a Modelica file, 

• Select File > Open Modelica File(s) from the menu. 
• Click on Open Modelica File(s) toolbar button. 
• Click on the Open Modelica File(s) button available at the right bottom of Welcome Perspective. 
• Press Ctrl+O. 

2.4.3 Opening a Modelica File with Encoding 

Select File > Open/Convert Modelica File(s) With Encoding from the menu. It is also possible to 
convert files to UTF-8. 

2.4.4 Model Widget 

For each Modelica class one Model Widget is created. It has a statusbar and a view area. The statusbar 
contains buttons for navigation between the views and labels for information. The view area is used to display 
the icon, diagram and text layers of Modelica class. See Figure 2-11. 

 
Figure 2-11: Model Widget showing the Diagram View. 
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2.4.5 Adding Component Models 

Drag the models from the Libraries Browser and drop them on either Diagram or Icon View of Model 
Widget. 

2.4.6 Making Connections 

In order to connect one component model to another the user first needs to enable the connect mode from the 
toolbar. See Figure 2-12. 

 
Figure 2-12: Connect/Unconnect Mode toolbar button. 

2.5 Simulating a Model 
The OMEdit Simulation Dialog can be launched by, 

• Selecting Simulation > Simulate from the menu. (requires a model to be active in ModelWidget) 
• Clicking on the Simulate toolbar button. (requires a model to be active in ModelWidget) 
• Pressing keyboard shortcut Ctrl+B. (requires a model to be active in ModelWidget) 
• Right clicking the model from the Libraries Browser and choosing Simulate. 

2.5.1 General Tab 

• Start Time – the simulation start time. 
• Stop Time – the simulation stop time. 
• Method – the simulation solver. 
• Tolerance – the simulation tolerance. 
• Compiler Flags (Optional) – the optional C compiler flags. 

 
Figure 2-13: Simulation Dialog General Tab. 
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2.5.2 Output Tab 

• Number of Intervals – the simulation number of intervals. 
• Output Format – the simulation result file output format. 
• File Name (Optional) – the simulation result file name. 
• Variable Filter (Optional). 
• Show Generated File – Displays the generated files in a dialog box. 

 
Figure 2-14: Simulation Dialog Output Tab. 

2.5.3 Simulation Flags Tab 

• Model Setup File (Optional) – specifies a new setup XML file to the generated simulation code. 
• Initialization Method (Optional) – specifies the initialization method. 
• Optimization Method (Optional) – specifies the initialization optimization method. 
• Equation System Initialization File (Optional) – specifies an external file for the initialization of the 

model. 
• Equation System Initialization Time (Optional) – specifies a time for the initialization of the model. 
• Clock (Optional) – the type of clock to use. 
• Linear Solver (Optional) – specifies the linear solver method. 
• Non Linear Solver (Optional) – specifies the nonlinear solver. 
• Linearization (Optional) – specifies a time where the linearization of the model should be performed. 
• Output Variables (Optional) – outputs the variables a, b and c at the end of the simulation to the 

standard output. 
• Profiling – creates a profiling HTML file. 
• CPU Time – dumps the cpu-time into the result file. 
• Logging (Optional) – specifies a new setup XML file to the generated simulation code. 
• Enable All Warnings – outputs all warnings. 
 DASSL Solver Information – prints additional information about dassl solver. 
 Debug – prints additional debug information. 
 Dynamic State Selection Information – outputs information about dynamic state selection. 
 Jacobians Dynamic State Selection Information – outputs jacobain of the dynamic state 

selection. 
 Event Iteration – additional information during event iteration. 
 Verbose Event System – verbose logging of event system. 
 Initialization – prints additional information during initialization. 
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 Jacobians Matrix – outputs the jacobian matrix used by dassl. 
 Non Linear Systems – logging for nonlinear systems. 
 Verbose Non Linear Systems – verbose logging of nonlinear systems. 

 
Figure 2-15: Simulation Dialog Simulation Flags Tab. 
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 Jacobians Non Linear Systems – outputs the jacobian of nonlinear systems. 
 Initialization Residuals – outputs residuals of the initialization. 
 Simulation Process – additional information about simulation process. 
 Solver Process – additional information about solver process. 
 Final Initialization Solution – final solution of the initialization. 
 Timer/Event/Solver Statistics – additional statistics about timer/events/solver. 
 Util. 
 Zero Crossings – additional information about the zerocrossings. 

• Additional Simulation Flags (Optional) – specify any other simulation flag. 

2.6 Plotting the Simulation Results 
Successful simulation of model produces the result file which contains the instance variables that are candidate 
for plotting. Variables Browser will show the list of such instance variables. Each variable has a checkbox, 
checking it will plot the variable. See Figure 2-10.  

2.6.1 Types of Plotting 

2.6.1.1 Time Plot 

The plotting type depends on the active Plot Window. By default the plotting type is Time Plot. It plots the 
variable over the simulation time. You can have multiple Time Plot windows by clicking on New Plot 
Window toolbar button. See Figure 2-16. 

 
Figure 2-16: New Plot Window toolbar button. 

2.6.1.2 Plot Parametric 

Draws a two-dimensional parametric diagram, between variables x and y, with y as a function of x. You can 
have multiple Plot Parametric windows by clicking on the New Plot Parametric toolbar button. See Figure 
2-17. 

 
Figure 2-17: New Plot Parametric toolbar button. 

2.7 How to Create User Defined Shapes – Icons 
Users can create shapes of their own by using the shape creation tools available in OMEdit.  

• Line Tool – Draws a line. A line is created with a minimum of two points. In order to create a line, the 
user first selects the line tool from the toolbar and then click on the Icon/Diagram View; this will 
start creating a line. If a user clicks again on the Icon/Diagram View a new line point is created. In 
order to finish the line creation, user has to double click on the Icon/Diagram View. 
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• Polygon Tool – Draws a polygon. A polygon is created in a similar fashion as a line is created. The only 
difference between a line and a polygon is that, if a polygon contains two points it will look like a line 
and if a polygon contains more than two points it will become a closed polygon shape. 

• Rectangle Tool – Draws a rectangle. The rectangle only contains two points where first point indicates 
the starting point and the second point indicates the ending the point. In order to create rectangle, the 
user has to select the rectangle tool from the toolbar and then click on the Icon/Diagram View, this 
click will become the first point of rectangle. In order to finish the rectangle creation, the user has to 
click again on the Icon/Diagram View where he/she wants to finish the rectangle. The second click 
will become the second point of rectangle. 

• Ellipse Tool – Draws an ellipse. The ellipse is created in a similar way as a rectangle is created. 
• Text Tool – Draws a text label. 
• Bitmap Tool – Draws a bitmap container. 

The shape tools are located in the toolbar. See Figure 2-18. 

 
Figure 2-18: User defined shapes. 

The user can select any of the shape tools and start drawing on the Icon/Diagram View. The shapes created 
on the Diagram View of Model Widget are part of the diagram and the shapes created on the Icon View 
will become the icon representation of the model. 

For example, if a user creates a model with name testModel and add a rectangle using the rectangle tool 
and a polygon using the polygon tool, in the Icon View of the model. The model’s Modelica Text will 
appear as follows: 
model testModel 
annotation(Icon(graphics = {Rectangle(rotation = 0, lineColor = {0,0,255}, fillColor = 
{0,0,255}, pattern = LinePattern.Solid, fillPattern = FillPattern.None, lineThickness 
= 0.25, extent = {{ -64.5,88},{63, -22.5}}),Polygon(points = {{ -47.5, -29.5},{52.5, -
29.5},{4.5, -86},{ -47.5, -29.5}}, rotation = 0, lineColor = {0,0,255}, fillColor = 
{0,0,255}, pattern = LinePattern.Solid, fillPattern = FillPattern.None, lineThickness 
= 0.25)})); 
end testModel; 

In the above code snippet of testModel, the rectangle and a polygon are added to the icon 
annotation of the model. Similarly, any user defined shape drawn on a Diagram View of the 
model will be added to the diagram annotation of the model. 
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2.8 Settings 
OMEdit allows users to save several settings which will be remembered across different sessions of OMEdit. 
The Options Dialog can be used for reading and writing the settings. 

 
Figure 2-19: Options Dialog. 

2.8.1 General 

• General 
 Language – Sets the application language. 
 Working Directory – Sets the application working directory. 
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 Preserve User’s GUI Customizations – If true then OMEdit will remember its windows and 
toolbars positions and sizes. 

 Global Precision Value – Sets the global precision value for all the floating point spin boxes. 
• Libraries Browser 
 Show Protected Classes – Sets the application language. 

• Modeling View Mode 
 Tabbed View/SubWindow View – Sets the view mode for modeling. 

• Plotting View Mode 
 Tabbed View/SubWindow View – Sets the view mode for plotting. 

• Default View 
 Icon View/DiagramView/Modelica Text View/Documentation View – If no preferredView 

annotation is defined then this setting is used to show the respective view when user double 
clicks on the class in the Libraries Browser. 

• Enable Auto Save 
 Auto Save interval – Sets the auto save interval value. The minimum possible interval value is 

60 seconds. 
 Enable Auto Save for single classes – Enables the auto save for one class saved in one file. 
 Enable Auto Save for one file packages – Enables the auto save for packages saved in one file. 

2.8.2 Libraries 

• System Libraries – The list of system libraries that should be loaded every time OMEdit starts. 
• Force loading of Modelica Standard Library – If true then Modelica and ModelicaReference will 

always load even if user has removed them from the list of system libraries. 
• User Libraries – The list of user libraries/files that should be loaded every time OMEdit starts. 
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Figure 2-20: Libraries settings. 

2.8.3 Modelica Text Editor 

• General 
 Enable Syntax Highlighting – Enable/Disable the syntax highlighting for the Modelica Text 

Widget. 
 Enable Line Wrapping – Enable/Disable the line wrapping for the Modelica Text Widget. 



51 

 
 

 

 
Figure 2-21: Modelica Text Editor settings. 

• Fonts and Colors 
 Font Family – Contains the names list of available fonts. 
 Font Size – Sets the font size. 
 Items – List of categories used of syntax highlighting the code. 
 Item Color – Sets the color for the selected item. 
 Preview – Shows the demo of the syntax highlighting. 

2.8.4 Graphical Views 

• Extent 
 Left – Defines the left extent point for the view. 
 Bottom – Defines the bottom extent point for the view. 
 Right – Defines the right extent point for the view. 
 Top – Defines the top extent point for the view. 
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Figure 2-22: Graphical Views settings. 

• Grid 
 Horizontal – Defines the horizontal size of the view grid. 
 Vertical – Defines the vertical size of the view grid. 

• Component 
 Scale factor – Defines the initial scale factor for the component dragged on the view. 
 Preserve aspect ratio – If true then the component’s aspect ratio is preserved while scaling. 

2.8.5 Simulation 

• Simulation 
 Matching Algorithm – Sets the matching algorithm for simulation. 
 Index Reduction Method – Sets the index reduction method for simulation. 

 
Figure 2-23: Simulation settings. 
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2.8.6 Notifications 

• Notifications 
 Always quit without prompt – If true then OMEdit will quit without prompting the user. 
 Show item dropped on itself message – If true then a message will pop-up when a class is 

dragged and dropped on itself. 
 Show model is defined as partial and component will be added as replaceable message – If 

true then a message will pop-up when a partial class is added to another class. 
 Show component is declared as inner message – If true then a message will pop-up when an 

inner component is added to another class. 
 Show save model for bitmap insertion message – If true then a message will pop-up when 

user tries to insert a bitmap from a local directory to an unsaved class. 

 
Figure 2-24: Notifications settings. 

2.8.7 Line Style 

• Line Style 
 Color – Sets the line color. 
 Pattern – Sets the line pattern. 
 Thickness – Sets the line thickness. 
 Start Arrow – Sets the line start arrow. 
 End Arrow – Sets the line end arrow. 
 Arrow Size – Sets the start and end arrow size. 
 Smooth – If true then the line is drawn as a Bezier curve. 
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Figure 2-25: Line Style settings. 

2.8.8 Fill Style 

• Fill Style 
 Color – Sets the fill color. 
 Pattern – Sets the fill pattern. 

 
Figure 2-26: Fill Style settings. 

2.8.9 Curve Style 

• Curve Style 
 Pattern – Sets the curve pattern. 
 Thickness – Sets the curve thickness. 

 
Figure 2-27: Curve Style settings. 
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Chapter 3  
 
2D Plotting 

This chapter covers the 2D plotting available in OpenModelica via OMNotebook, OMShell and command line 
script. The plotting is based on OMPlot application. 

3.1 Example 
class HelloWorld 
  Real x(start = 1); 
  parameter Real a = 1; 
equation 
  der(x) = - a * x; 
end HelloWorld; 

To create a simple time plot the above model HelloWorld is simulated. To reduce the amount of simulation 
data in this example the number of intervals is limited with the argument numberOfIntervals=10. The 
simulation is started with the command below. 
simulate(HelloWorld, startTime=0, stopTime=4, numberOfIntervals=10); 

When the simulation is finished the file HelloWorld res.plt contains the simulation data. The contents of 
the file is the following (some formatting has been applied). 
0                      1 
4.440892098500626e-013 0.9999999999995559 
0.4444444444444444     0.6411803884299349 
0.8888888888888888     0.411112290507163 
1.333333333333333      0.2635971381157249 
1.777777777777778      0.1690133154060587 
2.222222222222222      0.1083680232218813 
2.666666666666667      0.06948345122279623 
3.111111111111112      0.04455142624447787 
3.555555555555556      0.02856550078454138 
4                      0.01831563888872685 

Diagrams are now created with the new OMPlot program by using the following command. 
plot(x); 

seems to correspond well with the data. 
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Figure 3-1: Simple 2D plot of the HelloWorld example. 

By re-simulating and saving results at many more points, e.g. using the default 500 intervals, a much smoother 
plot can be obtained. 
simulate(HelloWorld, startTime=0, stopTime=4, numberOfIntervals=500); 

plot(x); 

 
Figure 3-2: Simple 2D plot of the HelloWorld example with larger number of points. 

3.2 Plotting Commands and their Options 
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All of these commands can have any number of optional arguments to further customize the the resulting 
diagram. The available options and their allowed values are listed below. 

 
Option  Default value Description 
fileName The result of the last 

simulation 
The name of the result-file containing the variables to 
plot 

grid true Determines whether or not a grid is shown in the 
diagram. 

title “” This text will be used as the diagram title. 
logX false Determines whether or not the horizontal axis is 

logarithmically scaled. 
logY false Determines whether or not the vertical axis is 

logarithmically scaled. 
xLabel “time” This text will be used as the horizontal label in the 

diagram. 
yLabel “” This text will be used as the vertical label in the 

diagram. 
xRange {0, 0} Determines the horizontal interval that is visible in the 

diagram. {0, 0} will select a suitable range. 
yRange {0, 0} Determines the vertical interval that is visible in the 

diagram. {0, 0} will select a suitable range. 
curveWidth 1.0 Defines the width of the curve. 
curveStyle 1 Defines the style of the curve.  

SolidLine=1, DashLine=2, DotLine=3, DashDotLine=4, 
DashDotDotLine=5, Sticks=6, Steps=7. 

legendPosition “top” Defines the position of the legend in the diagram. 
Possible values are left, right, top, bottom and none. 

externalWindow false Opens a new OMPlot window if set to true otherwise 
update the current opened window. 

 

 

Command  Description 
plot(x) Creates a diagram with data from the last simulation that 

had a variable named x. 
plot({x,y,..., z}) Like the previous command, but with several variables. 
plotParametric(x, y) Creates a parametric diagram with data from the last 

simulated variables named x and y. 
plotParametric(x, {y1,y2}) Like the previous command, but with several variables. 
plotAll() Creates a diagram with all variables from the last 

simulated model as functions of time. 
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Chapter 4  
 
OMNotebook with DrModelica and DrControl 

This chapter covers the OpenModelica electronic notebook subsystem, called OMNotebook, together with the 
DrModelica tutoring system for teaching Modelica, and DrControl for teaching control together with Modelica. 
Both are using such notebooks. 

4.1 Interactive Notebooks with Literate Programming 
Interactive Electronic Notebooks are active documents that may contain technical computations and text, as 
well as graphics. Hence, these documents are suitable to be used for teaching and experimentation, simulation 
scripting, model documentation and storage, etc. 

4.1.1 Mathematica Notebooks 

Literate Programming (Knuth 1984) is a form of programming where programs are integrated with 
documentation in the same document. Mathematica notebooks (Wolfram 1997) is one of the first WYSIWYG 
(What-You-See-Is-What-You-Get) systems that support Literate Programming. Such notebooks are used, e.g., 
in the MathModelica modeling and simulation environment, e.g. see Figure 4-1below and Chapter 19 in 
(Fritzson 2004) 

4.1.2 OMNotebook 

The OMNotebook software (Axelsson 2005, Fernström 2006)  is a new open source free software that gives an 
interactive WYSIWYG (What-You-See-Is-What-You-Get) realization of Literate Programming, a form of 
programming where programs are integrated with documentation in the same document.  

The OMNotebook facility is actually an interactive WYSIWYG (What-You-See-Is-What-You-Get) 
realization of Literate Programming, a form of programming where programs are integrated with 
documentation in the same document. OMNotebook is a simple open-source software tool for an electronic 
notebook supporting Modelica.  

A more advanced electronic notebook tool, also supporting mathematical typesetting and many other 
facilities, is provided by Mathematica notebooks in the MathModelica environment, see Figure 4-1. 
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Figure 4-1.  Examples of Mathematica notebooks in the MathModelica modeling and simulation environment. 

Traditional documents, e.g. books and reports, essentially always have a hierarchical structure. They are 
divided into sections, subsections, paragraphs, etc. Both the document itself and its sections usually have 
headings as labels for easier navigation. This kind of structure is also reflected in electronic notebooks. Every 
notebook corresponds to one document (one file) and contains a tree structure of cells. A cell can have different 
kinds of contents, and can even contain other cells. The notebook hierarchy of cells thus reflects the hierarchy 
of sections and subsections in a traditional document such as a book. 

4.2 DrModelica Tutoring System – an Application of OMNotebook 
Understanding programs is hard, especially code written by someone else. For educational purposes it is 
essential to be able to show the source code and to give an explanation of it at the same time.  

Moreover, it is important to show the result of the source code’s execution. In modeling and simulation it is 
also important to have the source code, the documentation about the source code, the execution results of the 
simulation model, and the documentation of the simulation results in the same document. The reason is that the 
problem solving process in computational simulation is an iterative process that often requires a modification 
of the original mathematical model and its software implementation after the interpretation and validation of 
the computed results corresponding to an initial model. 

Most of the environments associated with equation-based modeling languages focus more on providing 
efficient numerical algorithms rather than giving attention to the aspects that should facilitate the learning and 
teaching of the language. There is a need for an environment facilitating the learning and understanding of 
Modelica. These are the reasons for developing the DrModelica teaching material for Modelica and for 
teaching modeling and simulation.  
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An earlier version of DrModelica was developed using the MathModelica (now Wolfram SystemModeler) 
environment. The rest of this chapter is concerned with the OMNotebook version of DrModelica and on the 
OMNotebook tool itself. 

DrModelica has a hierarchical structure represented as notebooks. The front-page notebook is similar to a 
table of contents that holds all other notebooks together by providing links to them. This particular notebook is 
the first page the user will see (Figure 4-2). 
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Figure 4-2.  The front-page notebook of the OMNotebook version of the DrModelica tutoring system. 

In each chapter of DrModelica the user is presented a short summary of the corresponding chapter of the book 
“Principles of Object-Oriented Modeling and Simulation with Modelica 2.1” by Peter Fritzson. The summary 
introduces some keywords, being hyperlinks that will lead the user to other notebooks describing the keywords 
in detail. 

 
Figure 4-3.  The HelloWorld class simulated and plotted using the OMNotebook version of DrModelica. 
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Now, let us consider that the link “HelloWorld” in DrModelica Section is clicked by the user. The new 
HelloWorld notebook (see Figure 4-3), to which the user is being linked, is not only a textual description but 
also contains one or more examples explaining the specific keyword. In this class, HelloWorld, a differential 
equation is specified. 

No information in a notebook is fixed, which implies that the user can add, change, or remove anything in a 
notebook. Alternatively, the user can create an entirely new notebook in order to write his/her own programs or 
copy examples from other notebooks. This new notebook can be linked from existing notebooks. 

 
Figure 4-4.  DrModelica Chapter on Algorithms and Functions in the main page of the OMNotebook version of 
DrModelica. 

When a class has been successfully evaluated the user can simulate and plot the result, as previously depicted 
in Figure 4-3 for the simple HelloWorld example model.  
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After reading a chapter in DrModelica the user can immediately practice the newly acquired information by 
doing the exercises that concern the specific chapter. Exercises have been written in order to elucidate language 
constructs step by step based on the pedagogical assumption that a student learns better “using the strategy of 
learning by doing”. The exercises consist of either theoretical questions or practical programming assignments. 
All exercises provide answers in order to give the user immediate feedback.  

Figure 4-4 shows part of Chapter 9 of the DrModelica teaching material. Here the user can read about 
language constructs, like algorithm sections, when-statements, and reinit equations, and then practice 
these constructs by solving the exercises corresponding to the recently studied section. 

 

 
Figure 4-5.  Exercise 1 in Chapter 9 of DrModelica 

Exercise 1 from Chapter 9 is shown in Figure 4-5. In this exercise the user has the opportunity to practice 
different language constructs and then compare the solution to the answer for the exercise. Notice that the 
answer is not visible until the Answer section is expanded. The answer is shown in Figure 4-6. 
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Figure 4-6.  The answer section to Exercise 1 in Chapter 9 of DrModelica. 



65 

 
 

 

4.3 DrControl Tutorial for Teaching Control Theory 
DrControl is an interactive OMNotebook document aimed at teaching control theory. It is included in the 
OpenModelica distribution and appears under the directory OpenModelica1.9.0/share/ 
omnotebook/drcontrol. 

The front-page of DrControl resembles a linked table of content that can be used as a navigation center. The 
content list contains topics like:  

• Getting started 
• The control problem in ordinary life 
• Feedback loop 
• Mathematical modeling 
• Transfer function 
• Stability 
• Example of controlling a DC-motor 
• Feedforward compensation 
• State-space form 
• State observation 
• Closed loop control system. 
• Reconstructed system 
• Linear quadratic optimization 
• Linearization 

Each entry in this list leads to a new notebook page where either the theory is explained with Modelica 
examples or an exercise with a solution is provided to illustrate the background theory. Below we show a few 
sections of DrControl. 

4.3.1 Feedback Loop 

One of the basic concepts of control theory is using feedback loops either for neutralizing the disturbances from 
the surroundings or a desire for a smoother output. 

In Figure 4-7, control of a simple car model is illustrated where the car velocity on a road is controlled, first 
with an open loop control, and then compared to a closed loop system with a feedback loop. The car has a mass 
m, velocity y, and aerodynamic coefficient α. The θ is the road slope, which in this case can be regarded as 
noise.  
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Figure 4-7.  Feedback loop 

Lets look at the Modelica model for the open loop controlled car:  
 

 
 model NoFeedback 
  import SI = Modelica.SIunits; 
  SI.Velocity y        "No noise";  
  SI.Velocity yNoise   "With noise";  
  parameter SI.Mass m = 1500; 
  parameter Real alpha = 200; 
  parameter SI. ngle theta = 5*3.14/180;  
  parameter SI.Acceleration g = 9.82; 
  SI.Force u; 
  SI.Velocity r = 20 "Reference signal"; 
 equation 
  m*der(y)=u - alpha*y;  
  m*der(yNoise)= u - alpha*yNoise – 
     m*g*sin(theta); 
  u = 250A*r; 
 end NoFeedback; 

By applying a road slope angle different from zero the car velocity is influenced which can be regarded as 
noise in this model. The output signal in Figure 4-8 is stable but an overshoot can be observed compared to the 
reference signal. Naturally the overshoot is not desired and the student will in the next exercise learn how to get 
rid of this undesired behavior of the system.  
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Figure 4-8.  Open loop control example. 

The closed car model with a proportional regulator is shown below:  
 

 
 

model WithFeedback 
  import SI = Modelica.SIunits; 
  SI.Velocity y       "Output, No noise";   
  SI.Velocity yNoise  "Output With noise";   
  parameter SI.Mass m = 1500; 
  parameter Real alpha = 250; 
  parameter SI.Angle theta = 5*3.14/180;  
  parameter SI.Acceleration g = 9.82; 
  SI.Force u; 
  SI.Force uNoise; 
  SI.Velocity r = 20   "Reference signal"; 
equation 
  m*der(y) = u - alpha*y;  
  m*der(yNoise) = uNoise - alpha*yNois – 
    m*g*sin(theta);  
  u = 5000*(r - y); 
  uNoise = 5000*(r - yNoise); 
end WithFeedback; 

By using the information about the current level of the output signal and re-tune the regulator the output 
quantity can be controlled towards the reference signal smoothly and without an overshoot, as shown in Figure 
4-9.  

In the above simple example the flat modeling approach was adopted since it was the fastest one to quickly 
obtain a working model. However, one could use the object oriented approach and encapsulate the car and 
regulator models in separate classes with the Modelica connector mechanism in between.  



68                        
 

 

 
Figure 4-9.  Closed loop control example. 

4.3.2 Mathematical Modeling with Characteristic Equations 

In most systems the relation between the inputs and outputs can be described by a linear differential equation. 
Tearing apart the solution of the differential equation into homogenous and particular parts is an important 
technique taught to the students in engineering courses, also illustrated in Figure 4-10. 

 

 
Now let us examine a second order system: 

 
 

 
model NegRoots 
  Real y; 
  Real der_y; 
  parameter Real a1 = 3; 
  parameter Real a2 = 2; 
equation 
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  der_y = der(y); 
  der(der_y) + a1*der_y + a2*y = 1;  
end NegRoots; 

Choosing different values for a1 and a2 leads to different behavior as shown in Figure 4-11 and Figure 4-12. 
 

 
Figure 4-10.  Mathematical modeling with characteristic equation. 

In the first example the values of a1 and a2 are chosen in such way that the characteristic equation has negative 
real roots and thereby a stable output response, see Figure 4-11.  
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Figure 4-11.  Characteristic eq. with real negative roots. 

The importance of the sign of the roots in the characteristic equation is illustrated in Figure 4-11 and Figure 
4-12, e.g., a stable system with negative real roots and an unstable system with positive imaginary roots 
resulting in oscillations. 
model NegRoots 
  Real y; 
  Real der_y; 
  parameter Real a1 = -2; 
  parameter Real a2 = 10; 
equation 
  der_y = der(y); 
  der(der_y) + a1*der_y + a2*y = 1;  
end NegRoots; 
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Figure 4-12.   Characteristic eq. with positive imaginary roots. 
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Figure 4-13.  Step and pulse (weight function) response. 

 
The theory and application of Kalman filters is also explained in the interactive course material.  

 

 
Figure 4-14.  Theory background about Kalman filter. 

In reality noise is present in almost every physical system under study and therefore the concept of noise is also 
introduced in the course material, which is purely Modelica based.  
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Figure 4-15.  Comparison of a noisy system with feedback link in DrControl. 
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4.4 OpenModelica Notebook Commands 
OMNotebook currently supports the commands and concepts that are described in this section. 

4.4.1 Cells 

Everything inside an OMNotebook document is made out of cells. A cell basically contains a chunk of data. 
That data can be text, images, or other cells. OMNotebook has four types of cells: headercell, textcell, 
inputcell, and groupcell. Cells are ordered in a tree structure, where one cell can be a parent to one or 
more additional cells. A tree view is available close to the right border in the notebook window to display the 
relation between the cells. 

• Textcell – This cell type is used to display ordinary text and images. Each textcell has a style that 
specifies how text is displayed. The cell´s style can be changed in the menu Format->Styles, 
example of different styles are: Text, Title, and Subtitle. The Textcell type also has support for 
following links to other notebook documents. 

• Inputcell – This cell type has support for syntax highlighting and evaluation. It is intended to be used 
for writing program code, e.g. Modelica code. Evaluation is done by pressing the key combination 
Shift+Return or Shift+Enter. All the text in the cell is sent to OMC (OpenModelica 
Compiler/interpreter), where the text is evaluated and the result is displayed below the inputcell. By 
double-clicking on the cell marker in the tree view, the inputcell can be collapsed causing the result to 
be hidden. 

• Groupcell – This cell type is used to group together other cell. A groupcell can be opened or closed. 
When a groupcell is opened all the cells inside the groupcell are visible, but when the groupcell is 
closed only the first cell inside the groupcell is visible. The state of the groupcell is changed by the user 
double-clicking on the cell marker in the tree view. When the groupcell is closed the marker is changed 
and the marker has an arrow at the bottom. 

4.4.2 Cursors 

An OMNotebook document contains cells which in turn contain text. Thus, two kinds of cursors are needed for 
positioning, text cursor and cell cursor: 

• Textcursor – A cursor between characters in a cell, appearing as a small vertical line. Position the 
cursor by clicking on the text or using the arrow buttons. 

• Cellcursor – This cursor shows which cell currently has the input focus. It consists of two parts. The 
main cellcursor is basically just a thin black horizontal line below the cell with input focus. The 
cellcursor is positioned by clicking on a cell, clicking between cells, or using the menu item Cell-
>Next Cell or Cell->Previous Cell. The cursor can also be moved with the key combination 
Ctrl+Up or Ctrl+Down. The dynamic cellcursor is a short blinking horizontal line. To make this visible, 
you must click once more on the main cellcursor (the long horizontal line). NOTE: In order to paste 
cells at the cellcursor, the dynamic cellcursor must be made active by clicking on the main cellcursor 
(the horizontal line). 
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4.4.3 Selection of Text or Cells 

To perform operations on text or cells we often need to select a range of characters or cells. 

• Select characters – There are several ways of selecting characters, e.g. double-clicking on a word, 
clicking and dragging the mouse, or click followed by a shift-click at an adjacent positioin selects the 
text between the previous click and the position of the most recent shift-click. 

• Select cells – Cells can be selected by clicking on them. Holding down Ctrl and clicking on the cell 
markers in the tree view allows several cells to be selected, one at a time. Several cells can be selected 
at once in the tree view by holding down the Shift key. Holding down Shift selects all cells between last 
selected cell and the cell clicked on. This only works if both cells belong to the same groupcell. 

4.4.4 File Menu 

The following file related operations are available in the file menu: 

• Create a new notebook – A new notebook can be created using the menu File->New or the key 
combination Ctrl+N. A new document window will then open, with a new document inside. 

• Open a notebook – To open a notebook use File->Open in the menu or the key combination Ctrl+O. 
Only files of the type .onb or .nb can be opened. If a file does not follow the OMNotebook format or 
the FullForm Mathematica Notebook format, a message box is displayed telling the user what is wrong. 
Mathematica Notebooks must be converted to fullform before they can be opened in OMNotebook. 

• Save a notebook – To save a notebook use the menu item File->Save or File->Save As. If the 
notebook has not been saved before the save as dialog is shown and a filename can be selected. 
OMNotebook can only save in xml format and the saved file is not compatible with Mathematica. Key 
combination for save is Ctrl+S and for save as Ctrl+Shift+S. The saved file by default obtains the file 
extension .onb. 

• Print – Printing a document to a printer is done by pressing the key combination Ctrl+P or using the 
menu item File->Print. A normal print dialog is displayed where the usually properties can be 
changed. 

• Import old document – Old documents, saved with the old version of OMNotebook where a different 
file format was used, can be opened using the menu item File->Import->Old OMNotebook file. 
Old documents have the extension .xml. 

• Export text – The text inside a document can be exported to a text document. The text is exported to this 
document without almost any structure saved. The only structure that is saved is the cell structure. Each 
paragraph in the text document will contain text from one cell. To use the export function, use menu 
item File->Export->Pure Text. 

• Close a notebook window – A notebook window can be closed using the menu item File->Close or 
the key combination Ctrl+F4. Any unsaved changes in the document are lost when the notebook 
window is closed. 

• Quitting OMNotebook – To quit OMNotebook, use menu item File->Quit or the key combination 
Crtl+Q. This closes all notebook windows; users will have the option of closing OMC also. OMC will 
not automatically shutdown because other programs may still use it. Evaluating the command quit() has 
the same result as exiting OMNotebook. 
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4.4.5 Edit Menu 

• Editing cell text – Cells have a set of of basic editing functions. The key combination for these are: 
Undo (Ctrl+Z), Redo (Ctrl+Y), Cut (Ctrl+X), Copy (Ctrl+C) and Paste (Ctrl+V). These functions can 
also be accessed from the edit menu; Undo (Edit->Undo), Redo (Edit->Redo), Cut (Edit->Cut), 
Copy (Edit->Copy) and Paste (Edit->Paste). Selection of text is done in the usual way by double-
clicking, triple-clicking (select a paragraph), dragging the mouse, or using (Ctrl+A) to select all text 
within the cell. 

• Cut cell – Cells can be cut from a document with the menu item Edit->Cut or the key combination 
Ctrl+X. The cut function will always cut cells if cells have been selected in the tree view, otherwise the 
cut function cuts text. 

• Copy cell – Cells can be copied from a document with the menu item Edit->Copy or the key 
combination Ctrl+C. The copy function will always copy cells if cells have been selected in the tree 
view, otherwise the copy function copy text. 

• Paste cell – To paste copied or cut cells the cell cursor must be selected in the location where the cells 
should be pasted. This is done by clicking on the cell cursor. Pasteing cells is done from the menu Edit-
>Paste or the key combination Ctrl+V. If the cell cursor is selected the paste function will always paste 
cells. OMNotebook share the same application-wide clipboard. Therefore cells that have been copied 
from one document can be pasted into another document. Only pointers to the copied or cut cells are 
added to the clipboard, thus the cell that should be pasted must still exist. Consequently a cell can not 
be pasted from a document that has been closed. 

• Find – Find text string in the current notebook, with the options match full word, match cell, search 
within closed cells. Short command Ctrl+F. 

• Replace – Find and replace text string in the current notebook, with the options match full word, match 
cell, search+replace within closed cells. Short command Ctrl+H. 

• View expression – Text in a cell is stored internally as a subset of HTML code and the menu item Edit-
>View Expression let the user switch between viewing the text or the internal HTML representation. 
Changes made to the HTML code will affect how the text is displayed. 

4.4.6 Cell Menu 

• Add textcell – A new textcell is added with the menu item Cell->Add Cell (previous cell style) or the 
key combination Alt+Enter. The new textcell gets the same style as the previous selected cell had. 

• Add inputcell – A new inputcell is added with the menu item Cell->Add Inputcell or the key 
combination Ctrl+Shift+I. 

• Add groupcell – A new groupcell is inserted with the menu item Cell->Groupcell or the key 
combination Ctrl+Shift+G. The selected cell will then become the first cell inside the groupcell.  

• Ungroup groupcell – A groupcell can be ungrouped by selecting it in the tree view and using the menu 
item Cell->Ungroup Groupcell or by using the key combination Ctrl+Shift+U. Only one groupcell 
at a time can be ungrouped. 

• Split cell – Spliting a cell is done with the menu item Cell->Split cell or the key combination 
Ctrl+Shift+P. The cell is splited at the position of the text cursor. 

• Delete cell – The menu item Cell->Delete Cell will delete all cells that have been selected in the 
tree view. If no cell is selected this action will delete the cell that have been selected by the cellcursor. 
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This action can also be called with the key combination Ctrl+Shift+D or the key Del (only works when 
cells have been selected in the tree view). 

• Cellcursor – This cell type is a special type that shows which cell that currently has the focus. The cell 
is basically just a thin black line. The cellcursor is moved by clicking on a cell or using the menu item 
Cell->Next Cell or Cell->Previous Cell. The cursor can also be moved with the key 
combination Ctrl+Up or Ctrl+Down. 

4.4.7 Format Menu 

• Textcell – This cell type is used to display ordinary text and images. Each textcell has a style that 
specifies how text is displayed. The cells style can be changed in the menu Format->Styles, 
examples of different styles are: Text, Title, and Subtitle. The Textcell type also have support 
for following links to other notebook documents. 

• Text manipulation – There are a number of different text manipulations that can be done to change the 
appearance of the text. These manipulations include operations like: changing font, changing color and 
make text bold, but also operations like: changing the alignment of the text and the margin inside the 
cell. All text manipulations inside a cell can be done on single letters, words or the entire text. Text 
settings are found in the Format menu. The following text manipulations are available in OMNotebook: 

  > Font family 
  > Font face (Plain, Bold, Italic, Underline) 
  > Font size 
  > Font stretch 
  > Font color 
  > Text horizontal alignment 
  > Text vertical alignment 
  > Border thickness 
  > Margin (outside the border) 
  > Padding (inside the border) 

4.4.8 Insert Menu 

• Insert image – Images are added to a document with the menu item Insert->Image or the key 
combination Ctrl+Shift+M. After an image has been selected a dialog appears, where the size of the 
image can be chosen. The images actual size is the default value of the image. OMNotebook stretches 
the image accordantly to the selected size. All images are saved in the same file as the rest of the 
document. 

• Insert link – A document can contain links to other OMNotebook file or Mathematica notebook and to 
add a new link a piece of text must first be selected. The selected text make up the part of the link that 
the user can click on. Inserting a link is done from the menu Insert->Link or with the key 
combination Ctrl+Shift+L. A dialog window, much like the one used to open documents, allows the 
user to choose the file that the link refers to. All links are saved in the document with a relative file path 
so documents that belong together easily can be moved from one place to another without the links 
failing. 
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4.4.9 Window Menu 

• Change window – Each opened document has its own document window. To switch between those use 
the Window menu. The window menu lists all titles of the open documents, in the same order as they 
were opened. To switch to another document, simple click on the title of that document. 

4.4.10 Help Menu 

• About OMNotebook – Accessing the about message box for OMNotebook is done from the menu Help-
>About OMNotebook. 

• About Qt – To access the message box for Qt, use the menu Help->About Qt. 
• Help Text – Opening the help text (document OMNotebookHelp.onb) for OMNotebook can be done in 

the same way as any OMNotebook document is opened or with the menu Help->Help Text. The 
menu item can also be triggered with the key F1. 

4.4.11 Additional Features 

• Links – By clicking on a link, OMNotebook will open the document that is referred to in the link. 
• Update link – All links are stored with relative file path. Therefore OMNotebook has functions that 

automatically updating links if a document is resaved in another folder. Every time a document is 
saved, OMNotebook checks if the document is saved in the same folder as last time. If the folder has 
changed, the links are updated. 

• Evaluate several cells – Several inputcells can be evaluated at the same time by selecting them in the 
treeview and then pressing the key combination Shift+Enter or Shift+Return. The cells are evaluated in 
the same order as they have been selected. If a groupcell is selected all inputcells in that groupcell are 
evaluated, in the order they are located in the groupcell. 

• Command completion – Inputcells have command completion support, which checks if the user is 
typing a command (or any keyword defined in the file commands.xml) and finish the command. If the 
user types the first two or three letters in a command, the command completion function fills in the rest. 
To use command completion, press the key combination Ctrl+Space or Shift+Tab. The first command 
that matches the letters written will then appear. Holding down Shift and pressing Tab (alternative 
holding down Ctrl and pressing Space) again will display the second command that matches. Repeated 
request to use command completion will loop through all commands that match the letters written. 
When a command is displayed by the command completion functionality any field inside the command 
that should be edited by the user is automatically selected. Some commands can have several of these 
fields and by pressing the key combination Ctrl+Tab, the next field will be selected inside the 
command.  
  > Active Command completion: Ctrl+Space / Shift+Tab  
  > Next command:  Ctrl+Space / Shift+Tab  
  > Next field in command: Ctrl+Tab’ 

• Generated plot – When plotting a simulation result, OMC uses the program Ptplot to create a plot. 
From Ptplot OMNotebook gets an image of the plot and automatically adds that image to the output 
part of an inputcell. Like all other images in a document, the plot is saved in the document file when the 
document is saved.  

• Stylesheet –OMNotebook follows the style settings defined in stylesheet.xml and the correct style is 
applied to a cell when the cell is created. 
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• Automatic Chapter Numbering – OMNotebook automatically numbers different chapter, subchapter, 
section and other styles. The user can specify which styles should have chapter numbers and which 
level the style should have. This is done in the stylesheet.xml file. Every style can have a 
<chapterLevel> tag that specifies the chapter level. Level 0 or no tag at all, means that the style should 
not have any chapter numbering. 

• Scrollarea – Scrolling through a document can be done by using the mouse wheel. A document can also 
be scrolled by moving the cell cursor up or down.  

• Syntax highlighter – The syntax highlighter runs in a separated thread which speeds up the loading of 
large document that contains many Modelica code cells. The syntax highlighter only highlights when 
letters are added, not when they are removed. The color settings for the different types of keywords are 
stored in the file modelicacolors.xml. Besides defining the text color and background color of 
keywords, whether or not the keywords should be bold or/and italic can be defined. 

• Change indicator – A star (*) will appear behind the filename in the title of notebook window if the 
document has been changed and needs saving. When the user closes a document that has some unsaved 
change, OMNotebook asks the user if he/she wants to save the document before closing. If the 
document never has been saved before, the save-as dialog appears so that a filename can be choosen for 
the new document. 

• Update menus – All menus are constantly updated so that only menu items that are linked to actions 
that can be performed on the currently selected cell is enabled. All other menu items will be disabled. 
When a textcell is selected the Format menu is updated so that it indicates the text settings for the text, 
in the current cursor position. 
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Chapter 5  
 
Interactive Simulation 

In order to offer a user-interactive and time synchronous simulation, OpenModelica has an additional 
subsystem to fulfill general requirements on such simulations.  

This module is part of the simulation runtime core and is called “OpenModelica Interactive” (OMI). OMI 
will result in an executable simulation application, such as the non interactive simulation. The executable file 
will be generated by the OMC, which contains the full Modelica model as C/C++ code with all required 
equations, conditions and different solvers to simulate a whole system or a single system component. This 
executable file offers a non-interactive and an interactive simulation runtime. 

The following are some general functionalities of an interactive simulation runtime: 

• The user will be able to stimulate the system during a running system simulation and to observe its’ 
reaction immediately. 

• Simulation runtime behavior will be controllable and adaptable to offer an interaction with a user. 
• A user will receive simulation results during a simulation synchronous to the real-time. Since network 

process time and some other factors like scheduling of processes from the operation system this is not 
given at any time. 

• In order to offer a stable simulation, a runtime will inform a user interface of errors and consequential 
simulation aborts. 

• Simulation results will not under-run or exceed a tolerance compared to a thoroughly reliable value, for 
a correct simulation. 

• Communication between a simulation runtime and a user interface will use a well defined interface and 
be base on a common technology, in this case network communication. 

Note that OMI is available in an easy-to-use way from OMEdit, see Section Error! Reference source not 
found.. 

5.1 OpenModelica Interactive 

5.1.1 Interactively Changeable Parameters 

An important modification/addition to the semantics of the Modelica language during interactive simulation is 
the fact that parameters are changeable while simulating interactively using OMI. All properties using the 
prefix “parameter” can be changed during an interactive simulation. The fully qualified name is used as a 
unique identifier, so a parameter value can be found and changed regardless of its hierarchical position in the 
model. 
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5.1.2 OpenModelica Interactive Components description 

Control

Transfer

Simulation
Control

Simulation
DataFlow

 OpenModelica Interactive  
(As Server/Service) 

Interactive GUI 
(As Client) 

Simulation Units Communication Units 

OMI Subsystem 

 
Figure 5-1.  OpenModelica interactive communication architecture.. 

The OpenModelica Interactive subsystem is also separated into different modules, following are important for 
the user to communicate with: 

• Control: The “Control” module is the interface between OMI and a UI. It is implemented as a single 
thread to support parallel tasks and independent reactivity. As the main controlling and communication 
instance at simulation initialization phase and while simulation is running it manages simulation 
properties and also behavior. A client can permanently send operations as messages to the “Control” 
unit, it can react at any time to feedback from the other internal OMI components and it also sends 
messages to a client, for example error or status messages. 

• Transfer: Similar to a consumer, the “Transfer” thread tries to get simulation results from a result 
manager and sends them to the UI immediately after starting a simulation. If the communication takes 
longer than a calculation step, it is also possible to create more than one consumer. The “Transfer” uses 
a property filter mask containing all property names whose result values are important for the UI. The 
UI must set this mask using the “setfilter” operation from chapter 2.1.3.2, otherwise the transfer sends 
only the actual simulation time. This is very useful for increasing the communication speed while 
sending results to the UI. 

5.1.3 Communication Interface 

The network communication technology “TCP/IPv4” (later IPv6) will be used to send and receive messages. 
Each system has its own server and client implementations to receive and send messages respectively. The 
Control and Transfer are the OMI components which are designated for a communication over TCP/IP. 
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5.1.4 Network configuration Settings 
Name Description URL 
Control Server Waits for requests from the UI By Default, waits for connection on: 

127.0.0.1:10501 
Control Client Replies to the UI and sends other 

synchronization messages to it 
By Default, tries to connect on: 
127.0.0.1:10500 

Transfer Client Sends simulation results to a UI By Default, tries to connect on: 
127.0.0.1:10502 

OMI server and client components: Communication behaviour and configuration by default 
 

Name Description URL 
Control Client Requests to the OMI Control Server By Default, tries to connect on: 

127.0.0.1:10501 
Control Server Waits for information from the OMI 

Control Client 
By Default, waits for connection on: 
127.0.0.1:10500 

Transfer Server Waits for simulation results from the 
OMI Transfer Client 

By Default, waits for connection on: 
127.0.0.1:10502 

UI server and client components: Suggested configuration by default 

5.1.4.1 Operation Messages 

To use messages parsing there is a need to specify a communications protocol. 
A string message begins with a specified prefix and ends with a specified suffix.  
The prefix describes the request type, for example an operation. Depending on the request type, some 

additional information and parameters can append on it. The suffix is to check if the message has been received 
correctly and if the sender has created it correctly. All parts should be separated with “#”. 

A sequence number is helpful to manage operation request and reply, a UI has to send a sequence number 
combined with an operation. 

The following are all available message strings between a UI and the OMI system: 
 
Request from UI to Control 
 
UI Request Description OMI::Control Reply 
start#SEQ#end Starts or continues the simulation done#SEQ#end 
pause#SEQ#end Pauses the running simulation done#SEQ#end 
stop#SEQ#end Stops the running simulation and 

resets all values to the beginning 
done#SEQ#end 

shutdown#SEQ#end Shuts the simulation down done#SEQ#end 
setfilter#SEQ# 
var1:var2# 
par1:par2# 
end 

Sets the filter for variables and 
parameters which should send from 
OMI to the client UI 

done#SEQ#end 

useindex#SEQ#end Uses indexes as attribute names. The 
index will be used at transmitting 
results to a client. This will cause 
much less data to transmit. (??Not 
implemented yet) 

done#SEQ#end 

setcontrolclienturl#SEQ# 
ip#port# 

Changes the IP and port of the 
Control Server. Otherwise the 

done#SEQ#end 
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end default configuration will be used. 
settransferclienturl#SEQ# 
ip#port# 
end 

Changes the IP and port of the 
Control Server. Otherwise the 
default configuration will be used. 

done#SEQ#end 

changetime#SEQ#Tn#end Changes the simulation time and 
goes back to a specific time step 

done#SEQ#end 

changevalue#SEQ#Tn# 
par1=2.3:par2=33.3# 
end 

Changes the value of the appended 
parameters and stets the simulation 
time back to the point where the user 
clicked in the UI  

done#SEQ#end 

error#TYPE#end Error handling not implemented yet Error: * 

Table 5-1 Available messages from a UI to OMI (Request-Reply) 
 

 Messages from Control to UI 
 
OMI::Control Description UI 
Error: MESSAGE If an error occurs the OMI::Control 

generates an error messages and 
sends the messages with the prefix 
“Error:” to the UI (not implemented 
yet) 

Up to the UI developers 

Table 5-2 Available messages from OMI::Control to UI 
 

Messages from Transfer to UI 
 
OMI::Transfer Description UI 
result#ID#Tn# 
var1=Val:var2=Val# 
par1=Val:par2=Val# 
end 

Sends the simulation result for a time 
step Tn to the client UI, using the 
property names as identifier. Maybe 
a result ID is important to identify 
the results which are obsolete (not 
implemented yet). 

None 

result#ID#Tn# 
1=Val:2=Val# 
1=Val:2=Val# 
end 

Sends the simulation result for a time 
step Tn to the client UI, using an 
index as identifier. This requires a 
convention about the used index 
mask. Transfer optimization. 
NOTE: Operation from UI needed, 
Mask creation using the standard 
array index is recommended. 
Maybe a result ID is important to 
identify the results which are 
obsolete (not implemented yet). 

None 

Table 5-3 Available messages from OMI::Transfer to UI 
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5.1.5 Interactive Simulation general Procedure 

Note that OMI is available in an easy-to-use way from OMEdit, see Section Error! Reference source not 
found., as an alternative to the procedure described below. 

 

5.1.5.1 Initialize an Interactive Simulation Session 

Start the OpenModelica Shell or OMNotebook  which is available in the start menu as  
OpenModelica->OpenModelica Shell or OpenModelica->OMNotebook. 

 

 
 

1. Load a model or file.  
Optional: You can check if your model or file has been loaded correctly with the operation “list()” 

2. Build the model using the operation “buildModel(…)” with the following parameters: 
a) Model main class name: Name of the main class of your model.  
b) numberOfIntervals: Number of output values in an interval of one second. For Example: 
“numberOfIntervall=5” means that 5 results will be put out every one second (0s, 0.2s, 0.4s, 0.6s, 0.8s, 
1.0s…).    
c) Note: You can use all parameters which are accepted from the operation “buildModel” except the 
parameters “Start” and “Stop”. These parameters are unnecessary because an interactive simulation 
always starts at the time “0s” and runs as long as it won’t be stopped or aborted. 

3. Execute the created simulation runtime with the parameter “-interactive” and with a port for the control 
server optionally “-port xxxxx”. After starting the runtime it will wait until a client connects to its 
control server port. Now you can enter the operations mentioned above. 

5.1.6 Interactive Simulation Example 

In this chapter we will explain how to simulate a Modelica system interactively. This procedure should be a 
default step by step procedure for using OMI with a UI. 

5.1.6.1 How to get an example Modelica Model 

The application sample for Windows is present in C:\OpenModelica1.9.0\share\doc\omc\interactive-simulation. 
Also read C:\OpenModelica1.8.0\share\doc\omc\interactive-simulation\README.txt. 
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The source code for the client is in the Subversion repository: trunk/SimulationRuntime/interactive.  
An application test is in the Subversion repository here: trunk/testsuite/openmodelica/interactive-simulation.  
See here how to get the code: https://www.openmodelica.org/index.php/developer/source-code  

5.1.6.2 Create the simulation runtime 

We will use an example system based on a demonstration model which is given in the Modelica book by Peter 
Fritzson [[2], Page 386]. 

 
Figure 5-2.  TanksConnectedPI structure diagram. 

Please follow the steps to create an executable simulation runtime file.  

1. Start OMShell “Start->OpenModelica->OpenModelica Shell” 
2. Enter the operation “loadModel(TwoTanks)”  

NOTE: We assume that the TwoTanks model is in the ModelicaLibary OM installation folder 
(…\OpenModelica1.9.0\ModelicaLibrary\TwoTanks) otherwise please load the file from its location 
(…\OpenModelica1.9.0\share\doc\omc\interactive-simulation\*.zip). 

3. Use the “buildModel” operation with the following parameters to build the TwoTanks model:  
buildModel(TwoTanks.TanksConnectedPI, numberOfIntervals=5) 

 

5.1.6.3 Start an interactive Simulation Session 

Start the created simulation runtime it should be located in the “tmp” folder of the OM installation folder 
(…\OpenModelica1.9.0\tmp\TwoTanks.TanksConnectedPI.exe)  

https://www.openmodelica.org/index.php/developer/source-code�
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Use the b “-interactive –port xxxxx”. NOTE: If the default port (10501) should be used ignore the 
parameter “–port”. Now the simulation runtime will be waiting until a UI client has been connected on its port. 

Start the client: “client.exe”. 

 

 
 
(Deprecated: Now enter “start” into the console and wait until the client is successfully connected.) 
 
Enter following operation for the simulation runtime: 
setcontrolclienturl#1#127.0.0.1#10500#end 
settransferclienturl#2#127.0.0.1#10502#end 
setfilter#3#tank1.h#source.flowLevel#end 

 
Start the simulation with: start#4#end 

NOTE: After starting the simulation your keyboard entries and the results will be displayed in the same console 
and you can’t see what you are typing. Please pause the simulation first than enter a longer operation string. 
 
Pause the simulation with: pause#5#end 
 
Change a Value with: changevalue#6#xx.x#source.flowLevel=0.04#end.  

For example if time is higher than 60 and lower than 200 enter  
 changevalue#6#60.0#source.flowLevel=0.0004#end 
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Shutdown the simulation runtime and the environment with: shutdown#7#end 
 
 

5.2 OPC and OPC UA Interfaces 
In addition to OMI, OpenModelica can also be stimulated through the OPC interface. At the moment OPC DA 
and OPC UA interfaces are supported. As OPC UA is seen as the technology that will replace the regular OPC 
in the future, the OPC UA implementation is concentrated on more than OPC DA. 

5.2.1 Introduction to the OPC Interfaces 

In this chapter, the basics of OPC are explained. In addition, a literature survey [OPC_1] has been made for the 
project “OPC Interfaces in OpenModelica”. In that survey, OPC is explained on a higher level generally as well 
as from the viewpoint of OpenModelica. 

OPC is a set of specifications which defines a common interface for communication between software 
packages and hardware devices of different kinds. The most used of the OPC interfaces, OPC DA (3.00) 
specification [OPC_2], defines how to get and set data in real time devices using client-server communication 
paradigm and Ethernet based communication. OPC DA uses Microsoft COM (Component Object Model) 
technology. 

The next generation of OPC specifications is OPC Unified Architecture. It combines the different OPC 
interfaces under one specification. The basic idea behind OPC UA is the same even though the technology 
behind is different. Unlike the regular OPC specification, OPC UA is platform independent and has new 
features, such as method calls, included. A binary transfer protocol is provided for a better performance, as well 
as the XML based one. The OPC UA specification is defined in a 13-part specification downloadable in OPC 
Foundation homepage [OPC_3]. 

Since OPC and OPC UA are rather large specifications, their usage cannot be discussed here in detail. For a 
deeper understanding of the technology behind OPC and OPC UA the reader should get familiar with the 
interface specifications above. However, for both of the interfaces there exist test clients which can be used to 
utilize the interfaces in a quick and easy manner. A couple of test clients are introduced in section 5.2.3. 

5.2.2 Implemented Features 

Both the OPC UA and the OPC DA interface (combined with the Simulation Control (SC) interface) provide a 
very similar functionality. Thus only OPC UA is discussed extensively here. In subsection 5.2.2.2 the most 
noteworthy differences in features between OPC UA and OPC are discussed. 

To utilize either of the OPC interfaces, the OPC branch needs to be merged to c_runtime. UA Server is linked 
to the simulation executable by adding -lOPCregistry -lua_server at the end of the compiling script. OPC DA 
server is linked to the simulation executable by adding -lOPCregistry -lOPCKit at the end of the compiling 
script. At the moment there is no option in the OMC to do this automatically. 
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5.2.2.1 OPC UA 

After an OPC UA client has established a connection to an OpenModelica simulation, the following features 
can be utilized. In Figure 5-3 UA Expert connected to an OpenModelica simulation (‘dcmotor’) with the OPC UA 
server included, a view of the UA Expert test client is shown. The client is connected to an example 
OpenModelica simulation, namely the ‘dcmotor’ [OPC_4]. In the following, all the examples use Figure 5-3 
UA Expert connected to an OpenModelica simulation (‘dcmotor’) with the OPC UA server included to explain the 
concepts. 
 

 
Figure 5-3 UA Expert connected to an OpenModelica simulation (‘dcmotor’) with the OPC UA server 
included 

Browse 

The data structure (in OPC UA terminology: address space) of the OpenModelica simulation can be browsed. 
The address space consists of nodes and references between them. The part of the address space in which all 
the elements of the simulation are is a tree under the ‘Simulation’ node. This is shown in the left plane in 
Figure 5-3. In addition, the three methods are there as nodes as well; these methods are discussed later. 



90                        
 

 

Read 

Values of variables and parameters can be read through OPC UA after each simulation step. In addition to that, 
OPC UA offers some metadata, the majority of which is not utilized, though. The value and the metadata can 
be found on the right plane in Figure 5-3. 

Write 

Values of attributes and parameters can also be altered during the simulation between the simulation steps. 
When a value has been changed, the simulation is initialized with the new values and continued. This is needed 
if variables are wished to be changed, however a parameter change would not require this. Hence the 
implementation should be fixed on this matter. 

Subscribe 

Variable (and parameter) values can be subscribed. There are two alternative types of subscription: The first 
option is that the OPC UA server sends the value of the subscribed variable to the client each time after a 
defined time interval has passed (real time). The other one is that the value is sent to the client after each 
simulation step. In UA Expert, variables can be subscribed by dragging them to the middle plane. 

Start, Stop, Step 

The simulation can be controlled by the three methods: start(), stop(), and step(). With the OPC UA server 
included, the OpenModelica simulation starts in a stopped state. With start() and stop() methods this state can 
be changed. The simulation can also be run one step at a time with step(). 

5.2.2.2 OPC DA and Simulation Control (SC) 

The OPC DA server offers roughly the same functionality than the OPC UA server. The biggest conceptual 
difference between the two specifications is groups: Before variables and parameters can be used in any way 
they have to be grouped. A group is an entity consisting of items. A group can contain any variables and 
parameters as items. The other major differences between the two interfaces are described in the following. 

Browse 

The data structure of OPC DA is a tree consisting of branches and leaves. The leaves correspond to variables 
and parameters whereas the branches form the tree-like structure (e.g. ‘load’ and ‘flange_a’ are shown as 
branches in the dcmotor example).  

Read 

Reading values doesn’t differ much from OPC UA, except that the items read have to be grouped. There is also 
almost no metadata available through the OPC DA. 

Write 

There are no major differences. 

Subscribe 

The biggest difference in OPC DA is that single items cannot be subscribed. Instead, a subscription can be 
made for a group. 

Start, Stop, Step 

OPC DA interface doesn’t enable methods as such. Thus a proprietary interface, Simulation Control (SC), is 
used. In practice this means that in addition to the OPC DA client an SC client must be run alongside. 
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5.2.3 Test clients 

There are free test clients available in the Internet to test the OPC and OPC UA interfaces. One test client for 
each interface is shortly presented below. In addition, a test client for the SC interface is published as part of 
OpenModelica. 

UA Expert by Unified Automation is an OPC UA test client with a GUI. It supports all the functionalities 
provided by the OPC UA in OpenModelica. The latest version of UA Expert can be downloaded for free from 
the Unified Automation homepage [OPC_5]. 

For OPC DA there are numerous test clients available. The one which was most used for testing the OPC server 
is MatrikonOPC Explorer. It supports all the OPC DA functionalities needed to access data in OpenModelica. 
As well as UA Expert, this test client has a graphical user interface. The latest version of MatrikonOPC 
Explorer can be downloaded for free from the MatrikonOPC homepage [OPC_6]. 

As the SC interface is a non-standard interface, there are no clients for it in the Internet. SimpleOPCClient is a 
small test client for OPC and SC interfaces published with OpenModelica. Besides some basic OPC features, 
this test client allows the simulation to be controlled, i.e. start(), stop(), and step() functions can be used with it. 
Unlike the commercial products above, SimpleOPCClient is published in source code format. 

5.2.4 References 

[OPC_1] OPC Interfaces in OpenModelica – Technical Specification (Task 5.3); Online: 
https://openmodelica.org/svn/OpenModelica/trunk/doc/opc/ 
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http://opcfoundation.org/DownloadFile.aspx?CM=3&RI=67&CN=KEY&CI=283&CU=6 
(Accessed 9 June 2011). 

[OPC_3] The OPC Foundation – The Interoperability Standard for a Connected World; Online: 
http://opcfoundation.org/ (Accessed 8 June 2011). 

[OPC_4] OpenModelica: DC Motor model; Online: https://openmodelica.ida.liu.se/svn/ 
OpenModelica/tags/OPENMODELICA_1_5_0/Examples/dcmotor.mo (Accessed 10 June 
2011). 

[OPC_5] Unified Automation GmbH | OPC UA Clients; Online: http://www.unified-
automation.com/opc-ua-clients/ (Accessed 9 June 2011). 

[OPC_6] MatrikonOPC: Free OPC Downloads; Online: http://www.matrikonopc.com/downloads/ 
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Chapter 6  
 
Model Import and Export with FMI 1.0 

The new standard for model exchange with Functional Mockup Interface (FMI) 1.0 allows export of pre-
compiled models, i.e., C-code or binary code, from a tool for import in another tool, and vice versa. The FMI 
model exchange standard is Modelica independent. Import and export works both between different Modelica 
tools, or between certain non-Modelica tools and Modelica tools. OpenModelica supports FMI 1.0 import as 
well as FMI 1.0 export.  

6.1 FMI Import 
To import the FMU package use the OpenModelica command importFMU, 
function importFMU 
  input String filename "the fmu file name"; 
  input String workdir = "<default>" "The output directory for imported FMU files. 
<default> will put the files to current working directory."; 
  input Integer loglevel = 2 
"loglevel_nothing=0;loglevel_fatal=1;loglevel_error=2;loglevel_warning=3;loglevel_info
=4;loglevel_verbose=5;loglevel_debug=6"; 
  input Boolean fullPath = false "When true the full output path is returned otherwise 
only the file name."; 
  output String generatedFileName "Returns the full path of the generated file."; 
end importFMU; 

The command could be used from command line interface, OMShell, OMNotebook or MDT. The importFMU 
command is also integrated with OMEdit. Select FMI > Import FMI the FMU package is extracted in the 
directory specified by workdir, since the workdir parameter is optional so if its not specified then the 
current directory of omc is used. You can use the cd() command to see the current location. 

The implementation supports FMI for Model Exchange 1.0 and FMI for Co-Simulation 1.0 stand-alone. The 
support for FMI Co-Simulation 1.0 tool coupling is still under development. 

The FMI Import is currently a prototype. The prototype has been tested in OpenModelica with several 
examples. It has also been tested with example FMUs from FMUSDK and Dymola. A more fullfleged version 
for FMI Import will be released in the near future. 
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Figure 6-1: Example of FMU Import in OpenModelica where a bouncing ball model is imported. 

6.2 FMI Export 
To export the FMU use the OpenModelica command translateModelFMU(ModelName) from command 
line interface, OMShell, OMNotebook or MDT. The export FMU command is also integrated with OMEdit. 
Select FMI > Export FMI the FMU package is generated in the current directory of omc. You can use the 
cd() command to see the current location.  

After the command execution is complete you will see that a file ModelName.fmu has been created. As 
depicted in Figure 6-2, we first changed the current directory to C:/OpenModelica1.7.0/bin , then we 
loaded a Modelica file with BouncingBall example model and finally created an FMU for it using the 
translateModelFMU call.  
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Figure 6-2: OMShell screenshot for creating an FMU 

A log file for FMU creation is also generated named ModelName_FMU.log. If there are some errors while 
creating FMU they will be shown in the command line window and logged in this log file as well.  
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Chapter 7  
 
OMOptim – Optimization with OpenModelica 

7.1 Introduction 
OMOptim is a tool dedicated to optimization of Modelica models. By optimization, one should understand a 
procedure which minimizes/maximizes one or more objectives by adjusting one or more parameters. 

OMOptim 0.9 contains meta-heuristic optimization algorithms which allow optimizing all sorts of models 
with following functionalities: 

• One or several objectives optimized simultaneously 
• One or several parameters (integer or real variables) 

However, the user must be aware of the large number of simulations an optimization might require. 

7.2 Preparing the Model 
Before launching OMOptim, one must prepare the model in order to optimize it.  

7.2.1 Parameters 

An optimization parameter is picked up from all model variables. The choice of parameters can be done using 
the OMOptim interface.  

For all intended parameters, please note that: 

• The corresponding variable is constant

• The corresponding variable should play an 

 during all simulations. The OMOptim optimization in version 
0.9 only concerns static parameters’ optimization i.e. values found for these parameters will be constant 
during all simulation time. 

input

7.2.2 Constraints 

 role in the model i.e. its modification influences model 
simulation results. 

If some constraints should be respected during optimization, they must be defined in the Modelica model itself. 
For instance, if mechanical stress must be less than 5 N.m-2, one should write in the model: 

assert( mechanicalStress < 5, “Mechanical stress too high”); 
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If during simulation, the variable mechanicalStress exceeds 5 N.m-2, the simulation will stop and be considered 
as a failure. 

7.2.3 Objectives 

As parameters, objectives are picked up from model variables. Objectives’ values are considered by the 
optimizer at the final time

7.3 Set problem in OMOptim 

. 

7.3.1 Launch OMOptim 

OMOptim can be launched using the executable placed in OpenModelicaInstallationDirectory/bin/ 
OMOptim/OMOptim.exe. Alternately, choose OpenModelica > OMOptim from the start menu. 

7.3.2 Create a new project 

To create a new project, click on menu File -> New project 
Then set a name to the project and save it in a dedicated folder. The created file created has a .min 

extension. It will contain information regarding model, problems, and results loaded. 

7.3.3 Load models 

First, you need to load the model(s) you want to optimize. To do so, click on Add .mo  button on main window 
or select menu Model -> Load Mo file… 

When selecting a model, the file will be loaded in OpenModelica which runs in the background. 
While OpenModelica is loading the model, you could have a frozen interface. This is due to multi-threading 

limitation but the delay should be short (few seconds). 
You can load as many models as you want. 
If an error occurs (indicated in log window), this might be because:  

• Dependencies have not been loaded before (e.g. modelica library) 
• Model use syntax incompatible with OpenModelica. 

7.3.3.1 Dependencies 

OMOptim should detect dependencies and load corresponding files. However, it some errors occur, please load 
by yourself dependencies.  You can also load Modelica library using Model->Load Modelica library. 

When the model correctly loaded, you should see a window similar to Figure 7-1. 
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Figure 7-1.  OMOptim window after having loaded model. 

7.3.4 Create a new optimization problem 

Problem->Add Problem->Optimization 
A dialog should appear. Select the model you want to optimize. Only Model can be selected (no Package, 

Component, Block…). 
A new form will be displayed. This form has two tabs. One is called Variables, the other is called 

Optimization. 
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 Figure 7-2.  Forms for defining a new optimization problem. 

7.3.4.1 List of Variables is Empty 

If variables are not displayed, right click on model name in model hierarchy, and select Read variables.  
 

 
Figure 7-3.  Selecting read variables, set parameters, and selecting simulator. 

7.3.5 Select Optimized Variables 

To set optimization, we first have to define the variables the optimizer will consider as free i.e. those that it 
should find best values of. To do this, select in the left list, the variables concerned. Then, add them to 
Optimized variables by clicking on corresponding button ( ). 
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For each variable, you must set minimum and maximum values it can take. This can be done in the 
Optimized variables table. 

7.3.6 Select objectives 

Objectives correspond to the final values of chosen variables. To select these last, select in left list variables 
concerned and click  button of Optimization objectives table. 

For each objective, you must: 

• Set minimum and maximum values it can take. If a configuration does not respect these values, this 
configuration won’t be considered. You also can set minimum and maximum equals to “-“ : it will then  

• Define whether objective should be minimized or maximized. 

This can be done in the Optimized variables table. 

7.3.7 Select and configure algorithm 

After having selected variables and objectives, you should now select and configure optimization algorithm. To 
do this, click on Optimization tab. 

Here, you can select optimization algorithm you want to use. In version 0.9, OMOptim offers three different 
genetic algorithms. Let’s for example choose SPEA2Adapt which is an auto-adaptative genetic algorithm. 

By clicking on parameters… button, a dialog is opened allowing defining parameters. These are: 

• Population size

• 

: this is the number of configurations kept after a generation. If it is set to 50, your final 
result can’t contain more than 50 different points. 
Off spring rate

• 

: this is the number of children per adult obtained after combination process. If it is set to 
3, each generation will contain 150 individual (considering population size is 50). 
Max generations

• 

: this number defines the number of generations after which optimization should stop. 
In our case, each generation corresponds to 150 simulations. Note that you can still stop optimization 
while it is running by clicking on stop button (which will appear once optimization is launched). 
Therefore, you can set a really high number and still stop optimization when you want without losing 
results obtained until there. 
Save frequency

• 

: during optimization, best configurations can be regularly saved. It allows to analyze 
evolution of best configurations but also to restart an optimization from previously obtained results. A 
Save Frequency parameter set to 3 means that after three generations, a file is automatically created 
containing best configurations. These files are named iteraion1.sav, iteration2.sav and are store in Temp 
directory, and moved to SolvedProblems directory when optimization is finished. 
ReinitStdDev

7.3.7.1 Use start file 

: this is a specific parameter of EAAdapt1. It defines whether standard deviation of 
variables should be reinitialized. It is used only if you start optimization from previously obtained 
configurations (using Use start file option). Setting it to yes (1) will, in most of cases, lead to a spread 
research of optimized configurations, forgetting parameters’ variations’ reduction obtained in previous 
optimization. 

As indicated before, it is possible to pursue an optimization finished or stopped. To do this, you must enable 
Use start file option and select file from which optimization should be started. This file is an iteration_.sav file 
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created in previous optimization. It is stored in corresponding SolvedProblems folder (iteration10.sav 
corresponds to the tenth generation of previous optimization). 

Note that this functionality can only work with same variables and objectives. However, minimum, 
maximum of variables and objectives can be changed before pursuing an optimization. 

7.3.8 Launch 

You can now launch Optimization by clicking Launch button. 

7.3.9 Stopping Optimization 

Optimization will be stopped when the generation counter will reach the generation number defined in 
parameters. However, you can still stop the optimization while it is running without loosing obtained results. 
To do this, click on Stop button. Note that this will not immediately stop optimization: it will first finish the 
current generation. 

This stop function is especially useful when optimum points do not vary any more between generations. 
This can be easily observed since at each generation, the optimum objectives values and corresponding 
parameters are displayed in log window. 

7.4 Results 
The result tab appear when the optimization is finished. It consists of two parts: a table where variables are 
displayed and a plot region. 

7.4.1 Obtaining all Variable Values 

During optimization, the values of optimized variables and objectives are memorized. The others are not.  To 
get these last, you must recomputed corresponding points. To achieve this, select one or several points in 
point’s list region and click on recompute. 

For each point, it will simulate model setting input parameters to point corresponding values. All values of 
this point (including those which are not optimization parameters neither objectives). 
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7.5 Window Regions in OMOptim GUI 

 
Figure 7-4. Window regions in OMOptim GUI. 
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Chapter 8  
 
MDT – The OpenModelica Development Tooling 
Eclipse Plugin 

8.1 Introduction 
The Modelica Development Tooling (MDT) Eclipse Plug-In as part of OMDev – The OpenModelica 
Development Environment integrates the OpenModelica compiler with Eclipse. MDT, together with the 
OpenModelica compiler, provides an environment for working with Modelica development projects. 

The following features are available: 

• Browsing support for Modelica projects, packages, and classes 
• Wizards for creating Modelica projects, packages, and classes 
• Syntax color highlighting 
• Syntax checking 
• Browsing of the Modelica Standard Library or other libraries 
• Code completion for class names and function argument lists 
• Goto definition for classes, types, and functions 
• Displaying type information when hovering the mouse over an identifier. 

8.2 Installation 
The installation of MDT is accomplished by following the below installation instructions. These 
instructions assume that you have successfully downloaded and installed Eclipse (http://www.eclipse.org). 

1. Start Eclipse 
2. Select Help->Software Updates->Find and Install... from the menu 
3. Select ‘Search for new features to install’ and click ‘Next’ 
4. Select ‘New Remote Site...’ 
5. Enter ‘MDT’ as name and 

‘http://www.ida.liu.se/labs/pelab/modelica/OpenModelica/MDT’ as URL and click ‘OK’ 
6. Make sure ‘MDT’ is selected and click ‘Finish’ 
7. In the updates dialog select the ‘MDT’ feature and click ‘Next’ 
8. Read through the license agreement, select ‘I accept...’ and click ‘Next’ 
9. Click ‘Finish’ to install MDT 

http://www.ida.liu.se/labs/pelab/OpenModelica/MDT�
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8.3 Getting Started 

8.3.1 Configuring the OpenModelica Compiler 

MDT needs to be able to locate the binary of the compiler. It uses the environment variable 
OPENMODELICAHOME to do so. 

If you have problems using MDT, make sure that OPENMODELICAHOME is pointing to the folder 
where the Open Modelica Compiler is installed. In other words, OPENMODELICAHOME must point to 
the folder that contains the Open Modelica Compiler (OMC) binary. On the Windows platform it’s called 
omc.exe and on Unix platforms it’s called omc. 

8.3.2 Using the Modelica Perspective 

The most convenient way to work with Modelica projects is to use to the Modelica perspective. To switch 
to the Modelica perspective, choose the Window menu item, pick Open Perspective followed by 
Other... Select the Modelica option from the dialog presented and click OK.. 

8.3.3 Selecting a Workspace Folder 

Eclipse stores your projects in a folder called a workspace. You need to choose a workspace folder for this 
session, see Figure 5-8-1 

 

Figure 5-8-1.  Eclipse Setup – Switching Workspace. 

 

8.3.4 Creating one or more Modelica Projects 

To start a new project, use the New Modelica Project Wizard. It is accessible through File->New-> 
Modelica Project or by right-clicking in the Modelica Projects view and selecting New->Modelica 
Project. 

 

Figure 5-8-2.  Eclipse Setup – creating a Modelica project in the workspace. 

You need to disable automatic build for the project(s) (Figure 5-8-3). 

 

Figure 5-8-3.  Eclipse Setup – disable automatic build for the projects. 

Repeat the procedure for all the projects you need, e.g. for the exercises described in the MetaModelica 
users guide: 01_experiment, 02a_exp1, 02b_exp2, 03_assignment, 04a_assigntwotype, etc. 

NOTE: Leave open only the projects you are working on! Close all the others! 

8.3.5 Building and Running a Project 

After having created a project, you eventually need to build the project (Figure 8-4). 
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Figure 8-4.  Eclipse MDT – Building a project. 

There are several options: building, building from scratch (clean), running, see Figure 8-5. 

??missing figure 

Figure 8-5.  Eclipse – building and running a project. 

You may also open additional views, e.g as in Figure 8-6. 

??missing figure 

Figure 8-6.  Eclipse – Opening views. 

8.3.6 Switching to Another Perspective 

If you need, you can (temporarily) switch to another perspective, e.g. to the Java perspective for working 
with an OpenModelica Java client as in Figure 8-7. 
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Figure 8-7.  Eclipse – Switching to another perspective – e.g. the Java Perspective. 

8.3.7 Creating a Package 

To create a new package inside a Modelica project, select File->New->Modelica Package. Enter the 
desired name of the package and a description of what it contains. Note: for the exercises we already have 
existing packages. 

 
Figure 8-8.  Creating a new Modelica package. 

8.3.8 Creating a Class 

To create a new Modelica class, select where in the hierarchy that you want to add your new class and 
select File->New->Modelica Class. When creating a Modelica class you can add different restrictions 
on what the class can contain. These can for example be model, connector, block, record, or 
function. When you have selected your desired class type, you can select modifiers that add code blocks 
to the generated code. ‘Include initial code block’ will for example add the line ‘initial 
equation’ to the class. 



107 

 
 

 

 
Figure 8-9.  Creating a new Modelica class. 

8.3.9 Syntax Checking 

Whenever a build command is given to the MDT environment, modified and saved Modelica (.mo) files 
are checked for syntactical errors. Any errors that are found are added to the Problems view and also 
marked in the source code editor. Errors are marked in the editor as a red circle with a white cross, a 
squiggly red line under the problematic construct, and as a red marker in the right-hand side of the editor. If 
you want to reach the problem, you can either click the item in the Problems view or select the red box in 
the right-hand side of the editor. 

 

 
Figure 8-10.  Syntax checking. 
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8.3.10 Automatic Indentation Support 

MDT currently has support for automatic indentation. When typing the Return (Enter) key, the next line is 
indented correctly. You can also correct indentation of the current line or a range selection using CTRL+I 
or “Correct Indentation” action on the toolbar or in the Edit menu.  

8.3.11 Code Completion 

MDT supports Code Completion in two variants. The first variant, code completion when typing a dot after 
a class (package) name, shows alternatives in a menu. Besides the alternatives, Modelica documentation 
from comments is shown if is available. This makes the selection easyer. 

 
Figure 8-11.  Code completion when typing a dot. 

The second variant is useful when typing a call to a function. It shows the function signature (formal 
parameter names and types) in a popup when typing the parenthesis after the function name, here the 
signature Real sin(SI.Angle u) of the sin function: 

 

 
Figure 8-12.  Code completion at a function call when typing left parenthesis. 
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8.3.12 Code Assistance on Identifiers when Hovering  

When hovering with the mouse over an identifier a popup with information about the identifier is 
displayed. If the text is too long, the user can press F2 to focus the popup dialog and scroll up and down to 
examine all the text. As one can see the information in the popup dialog is syntax-highlighted. 

 
Figure 8-13.  Displaying information for identifiers on hovering  

8.3.13 Go to Definition Support 

Besides hovering information the user can press CTRL+click to go to the definition of  the identifier. 
When pressing CTRL the identifier will be presented as a link and when pressing mouse click the editor will 
go to the definition of the identifier. 

8.3.14 Code Assistance on Writing Records 

When writing records, the same functionality as for function calls is used. This is useful especially in 
MetaModelica when writing cases in match constructs.  
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Figure 8-14.  Code assistance when writing cases with records in MetaModelica. 

8.3.15 Using the MDT Console for Plotting 

 
Figure 8-15.  Activate the MDT Console 
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Figure 8-16.  Simulation from MDT Console 
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Chapter 9  
 
Modelica Performance Analyzer 

A common problem when simulating models in an equation-based language like Modelica is that the model 
may contain non-linear equation systems. These are solved in each time-step by extrapolating an initial 
guess and running a non-linear system solver. If the simulation takes too long to simulate, it is useful to run 
the performance analysis tool. The tool has around 5~25% overhead, which is very low compared to 
instruction-level profilers (30x-100x overhead). Due to being based on a single simulation run, the report 
may contain spikes in the charts. 

When running a simulation for performance analysis, execution times of user-defined functions as well 
as linear, non-linear and mixed equation systems are recorded.  

To start a simulation in this mode, just use the measureTime flag of the simulate command.  
simulate(modelname, measureTime = true) 

The generated report is in HTML format (with images in the SVG format), stored in a file 
modelname_prof.html, but the XML database and measured times that generated the report and graphs 
are also available if you want to customize the report for comparison with other tools. 

Below we use the performance profiler on the simple model A: 
model A 
   function f 
     input Real r; 
     output Real o := sin(r); 
   end f; 
   String s = "abc"; 
   Real x = f(x) "This is x"; 
   Real y(start=1); 
   Real z1 = cos(z2); 
   Real z2 = sin(z1); 
equation 
   der(y) = time; 
end A; 

We simulate as usual, but set measureTime=true to activate the profiling: 
simulate(A, measureTime = true) 
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// // record SimulationResult 
//  resultFile = "A_res.mat", 
//  messages = "Time measurements are stored in A_prof.html (human-readable) 

and A_prof.xml (for XSL transforms or more details)" 
// end SimulationResult; 

9.1 Example Report Generated for the A Model 

9.1.1 Information 

All times are measured using a real-time wall clock. This means context switching produces bad worst-case 
execution times (max times) for blocks. If you want better results, use a CPU-time clock or run the 
command using real-time priviliges (avoiding context switches). 

Note that for blocks where the individual execution time is close to the accuracy of the real-time clock, 
the maximum measured time may deviate a lot from the average. 

For more details, see  the generated file A_prof.xml, shown in Section 9.1.7 below. 

9.1.2 Settings 

The settings for the simulation are summarized in the table below: 
 

Name Value 
Integration method euler 
Output format mat 
Output name A_res.mat 
Output size 24.0 kB 
Profiling data A_prof.data 
Profiling size 27.3 kB 

9.1.3 Summary 

Execution times for different activities: 
 

Task Time Fraction 
Pre-Initialization 0.000401 19.17% 
Initialization 0.000046 2.20% 
Event-handling 0.000036 1.72% 
Creating output file 0.000264 12.62% 
Linearization 0.000000 0.00% 
Time steps 0.001067 51.00% 
Overhead 0.000273 13.05% 
Unknown 0.000406 0.24% 
Total simulation time 0.002092 100.00% 

http://www.ida.liu.se/~marsj/A_prof4/A_prof.xml�
http://www.ida.liu.se/~marsj/A_prof4/A_res.mat�
http://www.ida.liu.se/~marsj/A_prof4/A_prof.data�
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9.1.4 Global Steps 

  Steps Total Time Fraction Average Time Max Time Deviation 

 499 0.001067 51.00% 2.13827655310621e-06 0.000006611 2.09x 

9.1.5 Measured Function Calls 

  Name Calls Time Fraction Max Time Deviation 

 A.f 1506 0.000092990 4.45% 0.000000448 6.26x 

9.1.6 Measured Blocks 

  Name Calls Time Fraction Max Time Deviation 

 residualFunc3 2018 0.000521137 24.91% 0.000035456 136.30x 

 residualFunc1 1506 0.000393709 18.82% 0.000002735 9.46x 

9.1.6.1 Equations 

Name Variables 

SES_ALGORITHM 0   

SES_SIMPLE_ASSIGN 1 der(y) 

residualFunc3 z2, z1  

residualFunc1 x 

9.1.6.2 Variables 

Name Comment 

y   

der(y)   

x This is x 

z1   

z2   

http://www.ida.liu.se/~marsj/A_prof4/a.mo#line=2�
http://www.ida.liu.se/~marsj/A_prof4/A_prof.html#1009�
http://www.ida.liu.se/~marsj/A_prof4/A_prof.html#1010�
http://www.ida.liu.se/~marsj/A_prof4/A_prof.html#1001�
http://www.ida.liu.se/~marsj/A_prof4/A_prof.html#1004�
http://www.ida.liu.se/~marsj/A_prof4/A_prof.html#1003�
http://www.ida.liu.se/~marsj/A_prof4/A_prof.html#1002�
http://www.ida.liu.se/~marsj/A_prof4/a.mo#line=8�
http://www.ida.liu.se/~marsj/A_prof4/a.mo#line=8�
http://www.ida.liu.se/~marsj/A_prof4/a.mo#line=7�
http://www.ida.liu.se/~marsj/A_prof4/a.mo#line=9�
http://www.ida.liu.se/~marsj/A_prof4/a.mo#line=10�
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s   

9.1.7 Genenerated XML for the Example 
 
<!DOCTYPE doc (View Source for full doctype...)>  
- <simulation> 
- <modelinfo> 
  <name>A</name>  
  <prefix>A</prefix>  
  <date>2011-03-07 12:55:53</date>  
  <method>euler</method>  
  <outputFormat>mat</outputFormat>  
  <outputFilename>A_res.mat</outputFilename>  
  <outputFilesize>24617</outputFilesize>  
  <overheadTime>0.000273</overheadTime>  
  <preinitTime>0.000401</preinitTime>  
  <initTime>0.000046</initTime>  
  <eventTime>0.000036</eventTime>  
  <outputTime>0.000264</outputTime>  
  <linearizeTime>0.000000</linearizeTime>  
  <totalTime>0.002092</totalTime>  
  <totalStepsTime>0.001067</totalStepsTime>  
  <numStep>499</numStep>  
  <maxTime>0.000006611</maxTime>  
  </modelinfo> 
- <profilingdataheader> 
  <filename>A_prof.data</filename>  
  <filesize>28000</filesize>  
- <format> 
  <uint32>step</uint32>  
  <double>time</double>  
  <double>cpu time</double>  
  <uint32>A.f (calls)</uint32>  
  <uint32>residualFunc3 (calls)</uint32>  
  <uint32>residualFunc1 (calls)</uint32>  
  <double>A.f (cpu time)</double>  
  <double>residualFunc3 (cpu time)</double>  
  <double>residualFunc1 (cpu time)</double>  
  </format> 
  </profilingdataheader> 
- <variables> 
- <variable id="1000" name="y" comment=""> 
  <info filename="a.mo" startline="8" startcol="3" endline="8" endcol="18" 
readonly="writable" />  
  </variable> 
- <variable id="1001" name="der(y)" comment=""> 
  <info filename="a.mo" startline="8" startcol="3" endline="8" endcol="18" 
readonly="writable" />  
  </variable> 
- <variable id="1002" name="x" comment="This is x"> 
  <info filename="a.mo" startline="7" startcol="3" endline="7" endcol="28" 
readonly="writable" />  
  </variable> 
- <variable id="1003" name="z1" comment=""> 
  <info filename="a.mo" startline="9" startcol="3" endline="9" endcol="20" 
readonly="writable" />  
  </variable> 
- <variable id="1004" name="z2" comment=""> 
  <info filename="a.mo" startline="10" startcol="3" endline="10" endcol="20" 
readonly="writable" />  
  </variable> 

http://www.ida.liu.se/~marsj/A_prof4/a.mo#line=6�
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- <variable id="1005" name="s" comment=""> 
  <info filename="a.mo" startline="6" startcol="3" endline="6" endcol="19" 
readonly="writable" />  
  </variable> 
  </variables> 
- <functions> 
- <function id="1006"> 
  <name>A.f</name>  
  <ncall>1506</ncall>  
  <time>0.000092990</time>  
  <maxTime>0.000000448</maxTime>  
  <info filename="a.mo" startline="2" startcol="3" endline="5" endcol="8" 
readonly="writable" />  
  </function> 
  </functions> 
- <equations> 
- <equation id="1007" name="SES_ALGORITHM 0"> 
  <refs />  
  </equation> 
- <equation id="1008" name="SES_SIMPLE_ASSIGN 1"> 
- <refs> 
  <ref refid="1001" />  
  </refs> 
  </equation> 
- <equation id="1009" name="residualFunc3"> 
- <refs> 
  <ref refid="1004" />  
  <ref refid="1003" />  
  </refs> 
  </equation> 
- <equation id="1010" name="residualFunc1"> 
- <refs> 
  <ref refid="1002" />  
  </refs> 
  </equation> 
  </equations> 
- <profileblocks> 
- <profileblock> 
  <ref refid="1009" />  
  <ncall>2018</ncall>  
  <time>0.000521137</time>  
  <maxTime>0.000035456</maxTime>  
  </profileblock> 
- <profileblock> 
  <ref refid="1010" />  
  <ncall>1506</ncall>  
  <time>0.000393709</time>  
  <maxTime>0.000002735</maxTime>  
  </profileblock> 
  </profileblocks> 
  </simulation> 
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Chapter 10  
 
Modelica Algorithmic Subset Debugger 

This chapter presents a comprehensive Modelica debugger for an extended algorithmic subset of the 
Modelica language called MetaModelica. This replaces debugging of algorithmic code using primitive 
means such as print statements or asserts which is complex, time-consuming and error- prone.  

The debugger is portable since it is based on transparent source code instrumentation techniques that are 
independent of the implementation platform. 

The usual debugging functionality found in debuggers for procedural or traditional object-oriented 
languages is supported, such as setting and removing breakpoints, stepping, inspecting variables, etc. The 
debugger is integrated with Eclipse. 

10.1 The Eclipse-based Debugging Environment 
The debugging framework is based on the Eclipse environment and is implemented as a set of plugins 
which are available from Modelica Development Tooling (MDT) environment. Some of the debugger 
functionality is presented below. In the right part a variable value is explored. In the top-left part the stack 
trace is presented. In the middle-left part the execution point is presented. 

The debugger provides the following general functionalities: 

• Adding/Removing breakpoints. 
• Step Over – moves to the next line, skipping the function calls. 
• Step In – takes the user into the function call. 
• Step Return – complete the execution of the function and takes the user back to the point from 

where the function is called. 
• Suspend – interrupts the running program. 
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Figure 10-1.  Debugging functionality. 

10.2 Starting the Modelica Debugging Perspective 
To be able to run in debug mode, one has to go through the following steps: 

• create a mos file 
• setting the debug configuration 
• setting breakpoints 
• running the debug configuration 

All these steps are presented below using images. 

10.2.1 Create mos file 

In order to debug Modelica code we need to load the Modelica files into the OpenModelica Compiler. For 
this we can write a small script file like this, 

 
setCommandLineOptions({"+d=rml,noevalfunc","+g=MetaModelica"}); 
setEnvironmentVar("MODELICAUSERCFLAGS","-g"); 
loadFile("HelloWorld.mo"); 
getErrorString(); 
HelloWorld(120.0); 
getErrorString(); 

So lets say that we want to debug HelloWorld.mo. For that we must load it into the compiler using the 
script file. Put all the Modelica files there in the script file to be loaded. We should also initiate the 
debugger by calling the starting function, in the above code HelloWorld(120.0); 
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10.2.2 Setting the debug configuration 

While the Modelica perspective is activated the user should click on the bug icon on the toolbar and select 
Debug in order to access the dialog for building debug configurations. 

 
Figure 10-2.  Accessing the debug configuration dialog. 

To create the debug configuration, right click on the classification Modelica Development Tooling 
(MDT) GDB and select New as in figure below. Then give a name to the configuration, select the debugging 
executable to be executed and give it command line parameters. There are several tabs in which the user 
can select additional debug configuration settings like the environment in which the executable should be 
run. 

Note that we require Gnu Debugger (GDB) for debugging session. We must specify the GDB location, 
also we must pass our script file as an argument to OMC. 
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Figure 10-3.   Creating the Debug Configuration. 

10.2.3 Setting/Deleting Breakpoints 

The Eclipse interface allows to add/remove breakpoints. At the moment only line number based 
breakpoints are supported. Other alternative to set the breakpoints is; function breakpoints. 
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Figure 10-4.  Setting/deleting breakpoints. 

10.2.4 Starting the debugging session and enabling the debug perspective 

 
Figure 10-5.  Starting the debugging session. 
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Figure 10-6.  Eclipse will ask if the user wants to switch to the debugging perspective. 

10.3 Debugging OpenModelica 
• Compile and create OpenModelica executable as usual. 
• Go to /trunk/openmodelica/testsuite/bootstrapping and run command 

../../build/bin/omc.exe MainTest.mos 
• Now run make –f LinkMain.makefile.mingw (choose the right make file depending on your 

platform), this will create main.exe in the same directory. 
• Now in the debug configuration as explained in Section 10.2.2 choose main.exe as the program. 

10.4 The Debugging Perspective 
The debug view primarily consists of two main views: 

• Stack Frames View 
• Variables View 

The stack frame view, shown in the figure below, shows a list of frames that indicates how the flow had 
moved from one function to another or from one file to another. This allows backtracing of the code. It is 
very much possible to select the previous frame in the stack and inspect the values of the variables in that 
frame. However, it is not possible to select any of the previous frame and start debugging from there. Each 
frame is shown as <function_name at file_name:line_number>. 

The Variables view shows the list of variables at a certain point in the program, containing four colums: 

• Name – the variable name. 
• Declared Type – the Modelica type of the variable. 
• Value – the variable value. 
• Actual Type – the mapped C type. 
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By preserving the stack frames and variables it is possible to keep track of the variables values. If the value 
of any variable is changed while stepping then that variable will be highlighted yellow (the standard 
Eclipse way of showing the change). 

 
Figure 10-7.  The debugging perspective. 

 
Figure 10-8.  Switching between perspectives. 
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Chapter 11  
 
Modelica3D 

Modelica3D is a lightweight, platform independent 3D-visualisation library for Modelica. Read more about 
the Modelica3D library here https://mlcontrol.uebb.tu-berlin.de/redmine/projects/modelica3d-public. 

11.1 Windows 
In order to run Modelica3D on windows you need following softwares; 

• Python – Install python from http://www.python.org/download/. Python2.7.3 is recommended. 
• PyGTK – Install GTK+ for python from 

http://ftp.gnome.org/pub/GNOME/binaries/win32/pygtk/2.24/. Download the all-in-one package. 
Recommmended is pygtk-all-in-one-2.24.2.win32-py2.7.msi. 

Run the Modelica3D server by executing the dbus-server.py script located at 
OPENMODELICAHOME/lib/omlibrary-modelica3d/osg-gtk. 
python dbus-server.py 

This will start the Modelica3D server and on success you should see the output, 
Running dbus-server... 

Now run the simulation. The following commands will load the Modelica3D library and simulates the 
DoublePendulum example, 
loadModelica3D() 
simulate(Modelica.Mechanics.MultiBody.Examples.Elementary.DoublePendulum,stopTime=
30) 

If everything goes fine a visualization window will pop-up.  

To visualize any models from the MultiBody library you can use this script and change the extends to point 
to the model you want. 
 
loadModel(Modelica, {"3.1"}); getErrorString(); 
loadModel(ModelicaServices, {"1.0 modelica3d"}); getErrorString(); 
// get the path to modelica3d patches 
m3d_path := getInstallationDirectoryPath() + "/lib/omlibrary-modelica3d/"; 
// load the changed Modelica.Utilities.Internal 
loadFile(m3d_path + "Internal.mo"); 
loadString(" 
model Visualize_DoublePendulum   
  inner ModelicaServices.Modelica3D.Controller m3d_control; 
  extends Modelica.Mechanics.MultiBody.Examples.Elementary.DoublePendulum; 
end Visualize_DoublePendulum; 
"); 
simulate(Visualize_DoublePendulum, stopTime=30); getErrorString(); 
 

https://mlcontrol.uebb.tu-berlin.de/redmine/projects/modelica3d-public�
http://www.python.org/download/�
http://ftp.gnome.org/pub/GNOME/binaries/win32/pygtk/2.24/�
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Chapter 12  
 
Interoperability – C, Java, and Python 

Below is information and examples about the OpenModelica external C and Java interfaces, as well as 
examples of Python interoperability. 

12.1 Calling External C functions 
The following is a small example (ExternalLibraries.mo) to show the use of external C functions: 
 
model ExternalLibraries 
  Real x(start=1.0),y(start=2.0); 
equation 
  der(x)=-ExternalFunc1(x); 
  der(y)=-ExternalFunc2(y); 
end ExternalLibraries; 

function ExternalFunc1 
  input Real x; 
  output Real y; 
external 
  y=ExternalFunc1_ext(x) annotation(Library="libExternalFunc1_ext.o", 
                                    Include="#include \"ExternalFunc1_ext.h\"");  
end ExternalFunc1; 

 
function ExternalFunc2 
  input Real x; 
  output Real y; 
  external "C" annotation(Library="libExternalFunc2.a", 
                          Include="#include  \"ExternalFunc2.h\""); 
end ExternalFunc2; 

These C (.c) files and header files (.h) are needed: 
/* file: ExternalFunc1.c */ 
double ExternalFunc1_ext(double x) 
{ 
  double res; 
  res = x+2.0*x*x; 
  return res; 
}  
 
/* Header file ExternalFunc1_ext.h for ExternalFunc1 function */ 
double ExternalFunc1_ext(double); 
 
/* file: ExternalFunc2.c */ 
double ExternalFunc2(double x) 
{ 
  double res; 
  res = (x-1.0)*(x+2.0); 
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  return res; 
} 
 
/* Header file ExternalFunc2.h for ExternalFunc2 */ 
double ExternalFunc2(double); 

The following script file ExternalLibraries.mos will perform everything that is needed, provided you 
have gcc installed in your path: 
loadFile("ExternalLibraries.mo"); 
system("gcc -c -o libExternalFunc1_ext.o ExternalFunc1.c"); 
system("gcc -c -o libExternalFunc2.a ExternalFunc2.c"); 
simulate(ExternalLibraries); 

We run the script: 
>> runScript("ExternalLibraries.mos"); 

and plot the results: 
>> plot({x,y}); 

 
 

 
 

12.2 Calling External Java Functions 
There exists a bidirectional OpenModelica-Java CORBA interface, which is capable of passing both 
standard Modelica data types, as well as abstract syntax trees and list structures to and from Java and 
process them in either Java or the OpenModelica Compiler.  

The following is a small example (ExternalJavaLib.mo) to show the use of external Java function 
calls in Modelica, i.e., only the case calling Java from Modelica: 

 
model ExternalJavaLib 
  Real x(start=1.0); 
equation 
  der(x)=- ExternalJavaLog(x); 
end ExternalJavaLib; 
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function ExternalJavaLog 
  input Real x; 
  output Real y; 
external "Java" y=’java.lang.Math.log’(x) annotation(JavaMapping = "simple");  
end ExternalJavaLog; 

 
The datatypes are mapped according to the tables below. There is one mapping for interacting with 

existing Java code (simple), and a default mapping that handles all OpenModelica datatypes. The 
definitions of the default datatypes exist in the Java package org.openmodelica (see $OPENMODELICA-
HOME/share/java/modelica_java.jar). 

For more complete examples on how to use the Java interface, download the OpenModelica source code 
and view the examples in testsuite/openmodelica/java. 

 
Modelica Default Mapping JavaMapping = "simple" 
Real ModelicaReal double 
Integer ModelicaInteger int 
Boolean ModelicaBoolean bool 
String ModelicaString String 
Record ModelicaRecord  
T[:] ModelicaArray<T>  

 
MetaModelica Default Mapping 
list<T> ModelicaArray<T> 
tuple<T1, ... , Tn> ModelicaTuple 
Option<T> ModelicaOption<T> 
Uniontype IModelicaRecord 

12.3 Python Interoperability 
The interaction with Python can be perfomed in four different ways whereas one is illustrated below. 
Assume that we have the following Modelica code (CalledbyPython.mo): 
model CalledbyPython 
  Real x(start=1.0),y(start=2.0); 
  parameter Real b = 2.0; 
equation 
  der(x) = -b*y; 
  der(y) = x; 
end CalledbyPython; 

In the following Python (.py) files the above Modelica model is simulated via the OpenModelica scripting 
interface. 
# file: PythonCaller.py  
#!/usr/bin/python 
import sys,os  
global newb = 0.5 
os.chdir(r'C:\Users\Documents\python') 
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execfile('CreateMosFile.py') 
os.popen(r"C:\OpenModelica1.4.5\bin\omc.exe CalledbyPython.mos").read() 
execfile('RetrResult.py') 
 
# file: CreateMosFile.py 
#!/usr/bin/python 
mos_file = open('CalledbyPython.mos',’w’,1) 
mos_file.write("loadFile(\"CalledbyPython.mo\");\n") 
mos_file.write("setComponentModifierValue(CalledbyPython,b,$Code(="+str(newb)+") 

 );\n") 
mos_file.write("simulate(CalledbyPython,stopTime=10);\n") 
mos_file.close() 
 
# file: RetrResult.py 
#!/usr/bin/python 
def zeros(n): #  
  vec = [0.0] 
  for i in range(int(n)-1): vec = vec + [0.0] 
  return vec 
res_file = open("CalledbyPython_res.plt",'r',1)  
line = res_file.readline()  
size = int(res_file.readline().split('=')[1]) 
time = zeros(size) 
y    = zeros(size) 
while line != ['DataSet: time\n']: line = res_file.readline().split(',')[0:1] 
for j in range(int(size)): time[j]=float(res_file.readline().split(',')[0]) 
while line != ['DataSet: y\n']: line=res_file.readline().split(',')[0:1] 
for j in range(int(size)):  y[j]=float(res_file.readline().split(',')[1]) 
res_file.close() 

A second option of simulating the above Modelica model is to use the command  buildModel instead of 
the simulate command and setting the parameter value in the initial parameter file, 
CalledbyPython_init.txt  instead of using the command setComponentModifierValue. Then 
the file CalledbyPython.exe is just executed.  

The third option is to use the Corba interface for invoking the compiler and then just use the scripting 
interface to send commands to the compiler via this interface.  

The fourth variant is to use external function calls to directly communicate with the executing 
simulation process. 
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Chapter 13  
 
OMPython – OpenModelica Python Interface and 
PySimulator 

13.1 About OMPython 
OMPython – OpenModelica Python API is a free, open source, highly portable Python based interactive 
session handler for Modelica scripting. It provides the modeler with components for creating a complete 
Modelica modeling, compilation and simulation environment based on the latest OpenModelica library 
standard available. OMPython is architectured to combine both the solving strategy and model building. So 
domain experts (people writing the models) and computational engineers (people writing the solver code) 
can work on one unified tool that is industrially viable for optimization of Modelica models, while offering 
a flexible platform for algorithm development and research. OMPython v1.0 is not a standalone package, it 
depends upon the OpenModelica installation. 

OMPython v1.0 is implemented in Python using the OmniORB and OmniORBpy – high performance 
CORBA ORBs for Python and it supports the Modelica Standard Library version 3.2 that is included in the 
latest OpenModelica (version 1.9.0) installation. 

13.2 Features of OMPython 
OMPython provides user friendly features like, 

• Interactive session handling, parsing, interpretation of commands and Modelica expressions for 
evaluation, simulation, plotting, etc. 

• Interface to the latest OpenModelica API calls. 
• Optimized parser results that give control over every element of the output. 
• Helper functions to allow manipulation on Nested dictionaries. 
• Easy access to the library and testing of OpenModelica commands. 

13.3 Using OMPython 
The third party library of OMPython can be created by changing directory to,  
OpenModelicaInstallationDirectory/share/omc/scripts/PythonInterface/ 

And running the command, 
python setup.py install 

This will install the OMPython library into your Python’s third party libraries directory. Now OMPython 
can be imported and used within Python. 
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13.3.1 Test Commands 

To test the command outputs, simply import the OMPython library from Python and execute the run() 
method of OMPython. The module allows you to interactively send commands to the OMC server and 
display their output. 

For example: 
C:\>python 
>>> import OMPython 
>>> OMPython.run() 

Full example: 
C:\>python 
>>> import OMPython 
>>> OMPython.run() 
>>loadModel(Modelica) 
True 

13.3.2 Import As Library 

To use the module from within another python program, simply import OMPython from within the using 
program. Make use of the execute() function of the OMPython library to send commands to the OMC 
server. 

For example:  
answer = OMPython.execute(cmd) 

Full example: 
# test.py 
import OMPython 
cmds =  
    ["loadModel(Modelica)", 
    "model test end test;", 
    "loadFile(\"C:/OpenModelica1.9.0/testmodels/BouncingBall.mo\")", 
    "getIconAnnotation(Modelica.Electrical.Analog.Basic.Resistor)", 
    "getElementsInfo(Modelica.Electrical.Analog.Basic.Resistor)", 
    "simulate(BouncingBall)", 
    "plot(h)"] 
for cmd in cmds: 
    answer = OMPython.execute(cmd) 
    print "\nResult:\n%s"%answer 

13.3.3 Retrieve results from nested dictionaries 

Once the result is available from the OMPython.execute(), the OMPython.get() method can be used 
to retrieve and use specific values inside the dictionaries by simply querying the result dictionary with a 
string of nested dictionary names (keys). 

The query should define the complete nested structure of the dictionary starting from its root. 

Syntax: 
OMPython.get(dict, "dotted.dict.structure") 

For example: 
OMPython.execute("loadModel(Modelica)") 
result= 
OMPython.execute("getIconAnnotation(Modelica.Electrical.Analog.Basic.Resistor)") 
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inner = OMPython.get(result,'SET2.Elements.Line1.Properties') 

Full example: 
#test.py 
import OMPython 
OMPython.execute("loadModel(Modelica)") 
result= 
OMPython.execute("getIconAnnotation(Modelica.Electrical.Analog.Basic.Resistor)") 
inner = OMPython.get(result,'SET2.Elements.Line1.Properties') 
print "result of get is \n%s" %inner 

13.3.4 Set values to nested dictionaries 

New dictionaries can be added to the existing nested dictionary by using the OMPyhton.set() method. 

Syntax:  
OMPython.set(dict,"new.dotted.dict.structure", new_value) 

Note: new_value can be any of the Python supported datatypes. 

For example: 
OMPython.execute("loadModel(Modelica)") 
result= 
OMPython.execute("getIconAnnotation(Modelica.Electrical.Analog.Basic.Resistor)") 
value = OMPython.set(result,"SET2.Elements.Line1.Properties.NEW", 1e-05) 

The OMPython.set() method does not append dictionaries to the existing nest but creates new ones 
inside the existing. Design your query such that you don't overwrite the dictionaries if you don’t intend to. 

Full example: 
#test.py 
import OMPython 
OMPython.execute("loadModel(Modelica)") 
result = 
OMPython.execute("getIconAnnotation(Modelica.Electrical.Analog.Basic.Resistor)") 
inner = OMPython.get(result,'SET2.Elements.Line1.Properties') 
print "result of get is \n%s" %inner 
value = OMPython.set(result,"SET2.Elements.Line1.Properties.NEW", [1,2,3]) 
print "Result:: \n%s" % OMPython.get(value,'SET2.Elements.Line1.Properties.NEW') 
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13.3.5 Example 
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13.4 Implementation 

13.4.1 Client 

The OpenModelica Python API Interface – OMPython, attempts to mimic the OMShell's style of 
operations. 

OMPython is designed to, 

• Initialize the CORBA communication. 
• Send commands to the Omc server via the CORBA interface. 
• Receive the string results. 
• Use the Parser module to format the results. 
• Return or display the results. 

13.4.2 Parser 

Since the results of OMC are retrieved in a String format over CORBA, some housekeeping has to be done 
to make sure the results are usable in Python easily. 

The Parser is designed to do the following, 
 

• Analyze the result string for categorical data. 
• Group each category under a category name. 
• Type cast the data within these categories. 
• Build a suitable data structure to hold these data so that the results can be easily accessed and used. 

13.4.2.1 Understanding the Parsed output 

Each command in OpenModelica produces a result that can be categorized according to the statistics of the 
pattern of data presented in the text. Grammar based parsers were found to be tedious to use because of the 
complexity of the patterns of data. 

The parser just type casts the data without "curly brackets" to the appropriate data type and displays it as 
the result. 

For example: 
>> getVectorizationLimit() 
<< 20 
>> getNthInheritedClass(Modelica.Electrical.Analog.Basic.Resistor,1) 
<< Modelica.Electrical.Analog.Interfaces.OnePort 

However, multiple data types packed within a pair of quotations is always treated as a full string. 

For example: 
>> getModelicaPath() 
<< "C:/OpenModelica1.8.0/lib/omlibrary" 

 

13.4.2.2 The Dictionary data type in Python 

Dictionaries are found to be a useful datatype to pack data with different datatypes.  Dictionaries in Python 
are indexed by Keys unlike the sequences, which are indexed by a range of numbers.  

It is best to think of dictionaries as an unordered set of key:value pairs, with the requirement that the 
keys are always unique. The common operation on dictionaries is to store a value associated with a key and 
retrieve the value using the key. This provides us the flexibility of creating keys at runtime and accessing 
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these values using their keys later. All data within the dictionary are stored inside a named dictionary. An 
empty dictionary is represented by a pair of braces {}. 

From the reply of the OMC, the complicated result strings are usually the ones found within the curly 
braces, in order to make a meaningful categorization of the data  within these brackets and to avoid the 
potential complexities due to creating Dynamic variables, we introduce the following notations that can be 
used within dictionaries, 

• SET 
• Set 
• Subset 
• Element 
• Results 
• Values 

13.4.2.2.1 SET 

A SET (note the capital letters) is used to group data that belong to the first set of balanced curly brackets. 
According to the needed semantics of the results, a SET can contain Sets, Subsets, Elements, Values and 
Results. A SET can also be empty, denoted by {}. The SETs are named with an increasing index starting 
from 1(one). This feature was planned to eliminate the need for dynamic variable creation and having 
duplicate Keys. The SET belongs within the dictionary, result. 

For example: 
>> strtok("abcbdef","b") 
<< {'SET1': {'Values': ['"a","c","def"']}} 

The command strtok tokenizes the string "abcbdef" at every occurrence of b and produces a SET with 
values "a", "c", "def". 

13.4.2.2.2 Set 

A set is used to group all data within the a SET that is enclosed within a pair of balanced {}s. A Set can 
contain only Values and Elements. A set can also be empty, it can be depicted as {{}}, the outer brackets 
compose a SET, the inner brackets are the Set within the SET. 

13.4.2.2.3 Subset 

A Subset is a two-level deep set that is found within a SET. A subset can contain multiple Sets within its 
enclosure. 

For example: 
{SET1 {Subset1{Set1},{Set2},{Set3}}} 

13.4.2.2.4 Element 

Elements are the data which are grouped within a pair of Parenthesis ( ). As observed from the results 
string, elements have an element name that describes the data within them, so elements can be grouped by 
their names. Also, many elements have the same names, so they are indexed by increasing numbers starting 
from 1(one). Elements have the special property of having one or more Sets and Subsets within them. 
However, they are in turn enclosed within the SET. 

For example: 
>> getClassAttributes(test.mymodel) 
<< {'SET1': {'Elements': {'rec1': {'Properties': {'Results': {'comment': None, 
'res 
triction': 'MODEL', 'startLine': 1, 'partial': False, 'name': '"mymodel"', 'enca 
psulated': False, 'startColumn': 14, 'readonly': '"writable"', 'endColumn': 69, 
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'file': '"<interactive>"', 'endLine': 1, 'final': False}}}}}} 

The result contains, a SET with a Element named rec1 which has Properties which are Results (see below) 
of the element. 

13.4.2.2.5 Results 

Data that is related by the assignment operator "=", within the SETs are denoted as Results. These 
assignments cannot be assigned to their actual values unless they are related by a Name = Value 
relationship. So, they form the sub-dictionary called Results within the Element (for example). Then these 
values can be related by the key:value pair relationship. 

For example: 
>> getClassAttributes(test.mymodel) 
<< {'SET1': {'Elements': {'rec1': {'Properties': {'Results': {'comment': None, 
'res 
triction': 'MODEL', 'startLine': 1, 'partial': False, 'name': '"mymodel"', 'enca 
psulated': False, 'startColumn': 14, 'readonly': '"writable"', 'endColumn': 69, 
'file': '"<interactive>"', 'endLine': 1, 'final': False}}}}}} 

13.4.2.2.6 Values 

Data within any or all of SETs, Sets, Elements and Subsets that are not assignments and separated by 
commas are grouped together into a list called "Values". The Values list may also be empty, due to 
Python's representation of a null string "" as {}. Although a Null string is still a Null value, sometimes it is 
possible to observe data grouped into Values to look like Sets within the Values list.  

For example: 
>> getNthConnection(Modelica.Electrical.Analog.Examples.ChuaCircuit,2) 
<< {'SET1': {'Set1': ['G.n', 'Nr.p', {}]}} 

13.4.3 The Simulation Results 

The simulate() command produces output that has no SET or Set data in it. Instead, for simplicity,  it 
has two dictionaries namely, SimulationResults and SimulationOptions within the result dictionary. 

For example: 
OMPython.execute("simulate(BouncingBall)") 
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13.4.4 Record Construction 

The OpenModelica commands that produce output with Record constructs also do not have SET or Set data 
within them. The results of the output are packed within the RecordResults dictionary. 

For example: 
OMPython.execute("checkSettings()") 
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13.5 Examples 

13.5.1 Import As Library 
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13.5.2 Test Commands 

 

13.6 List of Commands 
The following table contains brief descriptions about the commands that are available in the OpenModelica 
environment. 

 
Command Description 

simulate Simulates a model. 
Interface: 
function simulate 
input TypeName className; 
input Real startTime=0; 
input Real stopTime=1; 
input Integer numberOfIntervals=500; 
input Real tolerance=1e-4; 
input String method=”dassl”; {euler, rungekutta, 

dopri5, inline-euler, inline-rungekutta} 
input String outputFormat=”mat”; {mat, plt, csv, 

empty} 
input String fileNamePrefix=””; 
input String variableFilter=””; 
input String cflags=””; 
input String simflags=””; 
ouput SimulationResult simRes; 

end simulate; 
SimulationResult: 
Record SimulationResult 
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String resultFile; 
String simulationOptions; 
String messages; 
Real timeFrontend; 
Real timeBackend; 
Real timeSimCode; 
Real timeTemplates; 
Real timeCompile; 
Real timeSimulation; 
Real timeTotal; 

End SimulationResult; 

appendEnvironmentVar Appends a variable to the environment variables list. 
Interface: 
function appendEnvironmentVar 
  input String var; 
  input String value; 
  output String result "returns \"error\" if the 

variable could not be appended"; 
end appendEnvironmentVar; 

basename Returns the base name (file part) of a file path. Similar to basename(3), but 
with the safety of Modelica strings. 
Interface: 
function basename 
  input String path; 
  output String basename; 

end basename; 

cd change directory to the given path (which may be either relative or absolute) 
returns the new working directory on success or a message on failure if the 
given path is the empty string, the function simply returns the current 
working directory. 
Interface: 
function cd 
  input String newWorkingDirectory = ""; 
  output String workingDirectory; 

end cd; 

checkAllModelsRecursive Checks all models recursively and returns number of variables and equations. 
Interface: 
function checkAllModelsRecursive 
  input TypeName className; 
  input Boolean checkProtected = false "Checks also 

protected classes if true"; 
  output String result; 

end checkAllModelsRecursive; 

checkModel Checks a model and returns number of variables and equations. 
Interface: 
function checkModel 
  input TypeName className; 
  output String result; 

end checkModel; 

checkSettings Display some diagnostics. 
Interface: 
function checkSettings 
  output CheckSettingsResult result; 

end checkSettings; 

http://linux.die.net/man/3/basename�
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CheckSettingsResult: 
String OPENMODELICAHOME,OPENMODELICALIBRARY,OMC_PATH; 
  Boolean OMC_FOUND; 
  String MODELICAUSERCFLAGS,WORKING_DIRECTORY; 
  Boolean CREATE_FILE_WORKS,REMOVE_FILE_WORKS; 
  String OS, SYSTEM_INFO,SENDDATALIBS,C_COMPILER; 
  Boolean C_COMPILER_RESPONDING; 
  String CONFIGURE_CMDLINE; 

end CheckSettingsResult; 

clear Clears everything: symboltable and variables. 
Interface: 
function clear 
  output Boolean success; 

end clear; 

clearMessages Clears the error buffer. 
Interface: 
function clearMessages 
  output Boolean success; 

end clearMessages; 

clearVariables Clear all user defined variables. 
Interface: 
function clearVariables 
  output Boolean success; 

end clearVariables; 

closeSimulationResultFile Closes the current simulation result file. Only needed by Windows. Windows 
cannot handle reading and writing to the same file from different processes. 
To allow OMEdit to make successful simulation again on the same file we 
must close the file after reading the Simulation Result Variables. Even 
OMEdit only use this API for Windows. 
Interface: 
function closeSimulationResultFile 
  output Boolean success; 

end closeSimulationResultFile; 

codeToString Interface: 
function codeToString 
  input $Code className; 
  output String string; 

end codeToString; 

compareSimulationResults Compares simulation results. 
Interface: 
function compareSimulationResults 
  input String filename; 
  input String reffilename; 
  input String logfilename; 
  input Real refTol; 
  input Real absTol; 
  input String[:] vars; 
  output String result; 

end compareSimulationResults; 

deleteFile Deletes a file with the given name. 
Interface: 
function deleteFile 
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  input String fileName; 
  output Boolean success; 
end deleteFile; 

dirname Returns the directory name of a file path. Similar to dirname(3), but with the 
safety of Modelica strings. 
Interface: 
function dirname 
  input String path; 
  output String dirname; 

end dirname; 

dumpXMLDAE Outputs the DAE system corresponding to a specific model. 
Interface: 
function dumpXMLDAE 
  input TypeName className; 
  input String translationLevel = "flat"; 
  input Boolean addOriginalIncidenceMatrix = false; 
  input Boolean addSolvingInfo = false; 
  input Boolean addMathMLCode = false; 
  input Boolean dumpResiduals = false; 
  input String fileNamePrefix = "<default>" "this is 

the className in string form by default"; 
  input Boolean storeInTemp = false; 
  output String result[2] "Contents, 

Message/Filename; why is this an array and not 2 
output arguments?"; 
end dumpXMLDAE; 

echo echo(false) disables Interactive output, echo(true) enables it again. 
Interface: 
function echo 
  input Boolean setEcho; 
  output Boolean newEcho; 

end echo; 

generateCode The input is a function name for which C-code is generated and compiled 
into a dll/so. 
Interface: 
function generateCode 
  input TypeName className; 
  output Boolean success; 

end generateCode; 

generateHeader Interface: 
function generateHeader 
  input String fileName; 
  output Boolean success; 

end generateHeader; 

generateSeparateCode Interface: 
function generateSeparateCode 
  output Boolean success; 

end generateSeparateCode; 

getAlgorithmCount Counts the number of Algorithm sections in a class. 
Interface: 
function getAlgorithmCount 
  input TypeName class_; 
  output Integer count; 

http://linux.die.net/man/3/dirname�
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end getAlgorithmCount; 

getAlgorithmItemsCount Counts the number of Algorithm items in a class. 
Interface: 
function getAlgorithmItemsCount 
  input TypeName class_; 
  output Integer count; 

end getAlgorithmItemsCount; 

getAnnotationCount Counts the number of Annotation sections in a class. 
Interface: 
function getAnnotationCount 
  input TypeName class_; 
  output Integer count; 

end getAnnotationCount; 

getAnnotationVersion Returns the current annotation version. 
Interface: 
function getAnnotationVersion 
  output String annotationVersion; 

end getAnnotationVersion; 

getAstAsCorbaString Print the whole AST on the CORBA format for records, e.g. 
  record Absyn.PROGRAM 
    classes = ..., 
    within_ = ..., 
    globalBuildTimes = ... 

  end Absyn.PROGRAM; 
Interface: 
function getAstAsCorbaString 
  input String fileName = "<interactive>"; 
  output String result "returns the string if 

fileName is interactive; else it returns ok or error 
depending on if writing the file succeeded"; 
end getAstAsCorbaString; 

getClassComment Returns the class comment. 
Interface: 
function getClassComment 
  input TypeName cl; 
  output String comment; 

end getClassComment; 

getClassNames Returns the list of class names defined in the class. 
Interface: 
function getClassNames 
  input TypeName class_ = $Code(AllLoadedClasses); 
  input Boolean recursive = false; 
  input Boolean qualified = false; 
  input Boolean sort = false; 
  input Boolean builtin = false "List also builtin 

classes if true"; 
  input Boolean showProtected = false "List also 

protected classes if true"; 
  output TypeName classNames[:]; 

end getClassNames; 

getClassesInModelicaPath Interface: 
function getClassesInModelicaPath 
  output String classesInModelicaPath; 
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end getClassesInModelicaPath; 

getCompileCommand Interface: 
function getCompileCommand 
  output String compileCommand; 

end getCompileCommand; 

getDocumentationAnnotation Returns the documentaiton annotation defined in the class. 
Interface: 
function getDocumentationAnnotation 
  input TypeName cl; 
  output String out[2] "{info,revision}"; 

end getDocumentationAnnotation; 

getEnvironmentVar Returns the value of the environment variable. 
Interface: 
function getEnvironmentVar 
  input String var; 
  output String value "returns empty string on 

failure"; 
end getEnvironmentVar; 

getEquationCount Counts the number of Equation sections in a class. 
Interface: 
function getEquationCount 
  input TypeName class_; 
  output Integer count; 

end getEquationCount; 

getEquationItemsCount Counts the number of Equation items in a class. 
Interface: 
function getEquationItemsCount 
  input TypeName class_; 
  output Integer count; 

end getEquationItemsCount; 

getErrorString Returns the current error message. [file.mo:n:n-n:n:b] Error: 
message 
Interface: 
function getErrorString 
  output String errorString; 

end getErrorString; 

getImportCount Counts the number of Import sections in a class. 
Interface: 
function getImportCount 
  input TypeName class_; 
  output Integer count; 

end getImportCount; 

getInitialAlgorithmCount Counts the number of Initial Algorithm sections in a class. 
Interface: 
function getInitialAlgorithmCount 
  input TypeName class_; 
  output Integer count; 

end getInitialAlgorithmCount; 

getInitialAlgorithmItemsCount Counts the number of Initial Algorithm items in a class. 
Interface: 
function getInitialAlgorithmItemsCount 
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  input TypeName class_; 
  output Integer count; 

end getInitialAlgorithmItemsCount; 

getInitialEquationCount Counts the number of Initial Equation sections in a class. 
Interface: 
function getInitialEquationCount 
  input TypeName class_; 
  output Integer count; 

end getInitialEquationCount; 

getInitialEquationItemsCount Counts the number of Initial Equation items in a class. 
Interface: 
function getInitialEquationItemsCount 
  input TypeName class_; 
  output Integer count; 

end getInitialEquationItemsCount; 

getInstallationDirectoryPath This returns OPENMODELICAHOME if it is set; on some platforms the default 
path is returned if it is not set. 
Interface: 
function getInstallationDirectoryPath 
  output String installationDirectoryPath; 

end getInstallationDirectoryPath; 

getLanguageStandard Returns the current Modelica Language Standard in use. 
Interface: 
function getLanguageStandard 
  output String outVersion; 

end getLanguageStandard; 

getMessagesString see getErrorString() 
Interface: 
function getMessagesString 
  output String messagesString; 

end getMessagesString; 

getMessagesStringInternal {{[file.mo:n:n-n:n:b] Error: message, TRANSLATION, 
Error, code}} 
Interface: 
function getMessagesStringInternal 
  output ErrorMessage[:] messagesString; 

end getMessagesStringInternal; 

getModelicaPath Get the Modelica Library Path. 
Interface: 
function getModelicaPath 
  output String modelicaPath; 

end getModelicaPath; 

getNoSimplify Returns true if noSimplify flag is set. 
Interface: 
function getNoSimplify 
  output Boolean noSimplify; 

end getNoSimplify; 

getNthAlgorithm Returns the Nth Algorithm section. 
Interface: 
function getNthAlgorithm 
  input TypeName class_; 
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  input Integer index; 
  output String result; 

end getNthAlgorithm; 

getNthAlgorithmItem Returns the Nth Algorithm Item. 
Interface: 
function getNthAlgorithmItem 
  input TypeName class_; 
  input Integer index; 
  output String result; 

end getNthAlgorithmItem; 

getNthAnnotationString Returns the Nth Annotation section as string. 
Interface: 
function getNthAnnotationString 
  input TypeName class_; 
  input Integer index; 
  output String result; 

end getNthAnnotationString; 

getNthEquation Returns the Nth Equation section. 
Interface: 
function getNthEquation 
  input TypeName class_; 
  input Integer index; 
  output String result; 

end getNthEquation; 

getNthEquationItem Returns the Nth Equation Item. 
Interface: 
function getNthEquationItem 
  input TypeName class_; 
  input Integer index; 
  output String result; 

end getNthEquationItem; 

getNthImport Returns the Nth Import as string. 
Interface: 
function getNthImport 
  input TypeName class_; 
  input Integer index; 
  output String out[3] "{\"Path\",\"Id\",\"Kind\"}"; 

end getNthImport; 

getNthInitialAlgorithm Returns the Nth Initial Algorithm section. 
Interface: 
function getNthInitialAlgorithm 
  input TypeName class_; 
  input Integer index; 
  output String result; 

end getNthInitialAlgorithm; 

getNthInitialAlgorithmItem Returns the Nth Initial Algorithm Item. 
Interface: 
function getNthInitialAlgorithmItem 
  input TypeName class_; 
  input Integer index; 
  output String result; 

end getNthInitialAlgorithmItem; 

getNthInitialEquation Returns the Nth Initial Equation section. 



147 

 
 

 

Interface: 
function getNthInitialEquation 
  input TypeName class_; 
  input Integer index; 
  output String result; 

end getNthInitialEquation; 

getNthInitialEquationItem Returns the Nth Initial Equation Item. 
Interface: 
function getNthInitialEquationItem 
  input TypeName class_; 
  input Integer index; 
  output String result; 

end getNthInitialEquationItem; 

getOrderConnections Returns true if orderConnections flag is set. 
Interface: 
function getOrderConnections 
  output Boolean orderConnections; 

end getOrderConnections; 

getPackages Returns the list of packages defined in the class. 
Interface: 
function getPackages 
  input TypeName class_ = $Code(AllLoadedClasses); 
  output TypeName classNames[:]; 

end getPackages; 

getPlotSilent Returns true if plotSilent flag is set. 
Interface: 
function getPlotSilent 
  output Boolean plotSilent; 

end getPlotSilent; 

getSettings Interface: 
function getSettings 
  output String settings; 

end getSettings; 

getShowAnnotations Interface: 
function getShowAnnotations 
  output Boolean show; 

end getShowAnnotations; 

getSourceFile Returns the filename of the class. 
Interface: 
function getSourceFile 
  input TypeName class_; 
  output String filename "empty on failure"; 

end getSourceFile; 

getTempDirectoryPath Returns the current user temporary directory location. 
Interface: 
function getTempDirectoryPath 
  output String tempDirectoryPath; 

end getTempDirectoryPath; 

getVectorizationLimit Interface: 
function getVectorizationLimit 
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  output Integer vectorizationLimit; 
end getVectorizationLimit; 

getVersion Returns the version of the Modelica compiler. 
Interface: 
function getVersion 
  input TypeName cl = $Code(OpenModelica); 
  output String version; 

end getVersion; 

help Display the OpenModelica help text. 
Interface: 
function help 
  output String helpText; 

end help; 

iconv The iconv() function converts one multibyte characters from one character 
  set to another. 
  See man(3) iconv for more information. 
Interface: 
function iconv 
  input String string; 
  input String from; 
  input String to = "UTF-8"; 
  output String result; 

end iconv; 

importFMU Imports the Functional Mockup Unit. 
  Example command: 
  importFMU("A.fmu"); 
Interface: 
function importFMU 
  input String filename "the fmu file name"; 
  input String workdir = "./" "The output directory 

for imported FMU files. <default> will put the files 
to current working directory."; 
  output Boolean success "Returns true on success"; 

end importFMU; 

instantiateModel Instantiates the class and returns the flat Modelica code. 
Interface: 
function instantiateModel 
  input TypeName className; 
  output String result; 

end instantiateModel; 

isModel Returns true if the given class has restriction model. 
Interface: 
function isModel 
  input TypeName cl; 
  output Boolean b; 

end isModel; 

isPackage Returns true if the given class is a package. 
Interface: 
function isPackage 
  input TypeName cl; 
  output Boolean b; 

end isPackage; 
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isPartial Returns true if the given class is partial. 
Interface: 
function isPartial 
  input TypeName cl; 
  output Boolean b; 

end isPartial; 

list Lists the contents of the given class, or all loaded classes. 
Pretty-prints a class definition. 
Syntax 
list(Modelica.Math.sin) 
list(Modelica.Math.sin,interfaceOnly=true) 
Interface: 
function list 
  input TypeName class_ = $Code(AllLoadedClasses); 
  input Boolean interfaceOnly = false; 
  input Boolean shortOnly = false "only short class 

definitions"; 
  output String contents; 

end list; 

listVariables Lists the names of the active variables in the scripting environment. 
Interface: 
function listVariables 
  output TypeName variables[:]; 

end listVariables; 

loadFile load file (*.mo) and merge it with the loaded AST. 
Interface: 
function loadFile 
  input String fileName; 
  output Boolean success; 

end loadFile; 

loadFileInteractive Interface: 
function loadFileInteractive 
  input String filename; 
  output TypeName names[:]; 

end loadFileInteractive; 

loadFileInteractiveQualified Interface: 
function loadFileInteractiveQualified 
  input String filename; 
  output TypeName names[:]; 

end loadFileInteractiveQualified; 

loadModel Loads a Modelica library. 
Syntax 
loadModel(Modelica) 
loadModel(Modelica,{"3.2"}) 
Interface: 
function loadModel 
  input TypeName className; 
  input String[:] priorityVersion = {"default"}; 
  output Boolean success; 

end loadModel; 

loadString Parses the data and merges the resulting AST with the loaded AST. If a 
filename is given, it is used to provide error-messages as if the string was 
read in binary format from a file with the same name.  The file is converted to 
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UTF-8 from the given character set. 
Interface: 
function loadString 
  input String data; 
  input String filename = "<interactive>"; 
  input String encoding = "UTF-8"; 
  output Boolean success; 

end loadString; 

parseFile Interface: 
function parseFile 
  input String filename; 
  output TypeName names[:]; 

end parseFile; 

parseString Interface: 
function parseString 
  input String data; 
  input String filename = "<interactive>"; 
  output TypeName names[:]; 

end parseString; 

plot Launches a plot window using OMPlot. Returns true on success. Don't 
require sendData support. 
Example command sequences: 
  simulate(A);plot({x,y,z}); 
 simulate(A);plot(x, externalWindow=true); 
 simulate(A,fileNamePrefix="B"); 
 simulate(C);plot(z,"B.mat",legend=false); 
Interface: 
function plot 
  input VariableNames vars "The variables you want 

to plot"; 
  input Boolean externalWindow = false "Opens the 

plot in a new plot window"; 
  input String fileName = "<default>" "The filename 

containing the variables. <default> will read the last 
simulation result"; 
  input String title = "Plot by OpenModelica" "This 

text will be used as the diagram title."; 
  input Boolean legend = true "Determines whether or 

not the variable legend is shown."; 
  input Boolean grid = true "Determines whether or 

not a grid is shown in the diagram."; 
  input Boolean logX = false "Determines whether or 

not the horizontal axis is logarithmically scaled."; 
  input Boolean logY = false "Determines whether or 

not the vertical axis is logarithmically scaled."; 
  input String xLabel = "time" "This text will be 

used as the horizontal label in the diagram."; 
  input String yLabel = "" "This text will be used 

as the vertical label in the diagram."; 
  input Real xRange[2] = {0.0,0.0} "Determines the 

horizontal interval that is visible in the diagram. 
{0,0} will select a suitable range."; 
  input Real yRange[2] = {0.0,0.0} "Determines the 

vertical interval that is visible in the diagram. 
{0,0} will select a suitable range."; 
  output Boolean success "Returns true on success"; 
  output String[:] result "Returns list i.e 
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{\"_omc_PlotResult\", \"<fileName>\", \"<title>\", 
\"<legend>\", \"<grid>\", \"<PlotType>\", \"<logX>\", 
\"<logY>\", \"<xLabel>\", \"<yLabel>\", \"<xRange>\", 
\"<yRange>\", \"<PlotVariables>\"}"; 
end plot; 

plotAll Works in the same way as plot(), but does not accept any variable names as 
input. Instead, all variables are part of the plot window. 
   
Example command sequences: 
  simulate(A); 
  plotAll(); 
  simulate(A); 
  plotAll(externalWindow=true); 
  simulate(A,fileNamePrefix="B"); 
  simulate(C); 
  plotAll(x,"B.mat"); 
Interface: 
function plotAll 
  input Boolean externalWindow = false "Opens the 

plot in a new plot window"; 
  input String fileName = "<default>" "The filename 

containing the variables. <default> will read the last 
simulation result"; 
  input String title = "Plot by OpenModelica" "This 

text will be used as the diagram title."; 
  input Boolean legend = true "Determines whether or 

not the variable legend is shown."; 
  input Boolean grid = true "Determines whether or 

not a grid is shown in the diagram."; 
  input Boolean logX = false "Determines whether or 

not the horizontal axis is logarithmically scaled."; 
  input Boolean logY = false "Determines whether or 

not the vertical axis is logarithmically scaled."; 
  input String xLabel = "time" "This text will be 

used as the horizontal label in the diagram."; 
  input String yLabel = "" "This text will be used 

as the vertical label in the diagram."; 
  input Real xRange[2] = {0.0,0.0} "Determines the 

horizontal interval that is visible in the diagram. 
{0,0} will select a suitable range."; 
  input Real yRange[2] = {0.0,0.0} "Determines the 

vertical interval that is visible in the diagram. 
{0,0} will select a suitable range."; 
  output Boolean success "Returns true on success"; 
  output String[:] result "Returns list i.e 

{\"_omc_PlotResult\", \"<fileName>\", \"<title>\", 
\"<legend>\", \"<grid>\", \"<PlotType>\", \"<logX>\", 
\"<logY>\", \"<xLabel>\", \"<yLabel>\", \"<xRange>\", 
\"<yRange>\", \"<PlotVariables>\"}"; 
end plotAll; 

plotParametric Launches a plotParametric window using OMPlot. Returns true on success.   
Example command sequences: 
  simulate(A);plotParametric2(x,y); 
  simulate(A);plotParametric2(x,y, 
externalWindow=true); 
Interface: 
function plotParametric 
  input VariableName xVariable; 
  input VariableName yVariable; 
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  input Boolean externalWindow = false "Opens the 
plot in a new plot window"; 
  input String fileName = "<default>" "The filename 

containing the variables. <default> will read the last 
simulation result"; 
  input String title = "Plot by OpenModelica" "This 

text will be used as the diagram title."; 
  input Boolean legend = true "Determines whether or 

not the variable legend is shown."; 
  input Boolean grid = true "Determines whether or 

not a grid is shown in the diagram."; 
  input Boolean logX = false "Determines whether or 

not the horizontal axis is logarithmically scaled."; 
  input Boolean logY = false "Determines whether or 

not the vertical axis is logarithmically scaled."; 
  input String xLabel = "time" "This text will be 

used as the horizontal label in the diagram."; 
  input String yLabel = "" "This text will be used 

as the vertical label in the diagram."; 
  input Real xRange[2] = {0.0,0.0} "Determines the 

horizontal interval that is visible in the diagram. 
{0,0} will select a suitable range."; 
  input Real yRange[2] = {0.0,0.0} "Determines the 

vertical interval that is visible in the diagram. 
{0,0} will select a suitable range."; 
  output Boolean success "Returns true on success"; 
  output String[:] result "Returns list i.e 

{\"_omc_PlotResult\", \"<fileName>\", \"<title>\", 
\"<legend>\", \"<grid>\", \"<PlotType>\", \"<logX>\", 
\"<logY>\", \"<xLabel>\", \"<yLabel>\", \"<xRange>\", 
\"<yRange>\",  \"<PlotVariables>\"}"; 
end plotParametric; 

plotParametric2 Plots the y-variables as a function of the x-variable. 
Example command sequences: 
  simulate(A); 
  plotParametric2(x,y); 
  simulate(A,fileNamePrefix="B"); 
  simulate(C); 
  plotParametric2(x,{y1,y2,y3},"B.mat"); 
Interface: 
function plotParametric2 
  input VariableName xVariable; 
  input VariableNames yVariables; 
  input String fileName = "<default>"; 
  output Boolean success "Returns true on success"; 

end plotParametric2; 

readFile The contents of the given file are returned. Note that if the function fails, the 
error message is returned as a string instead of multiple output or similar. 
Interface: 
function readFile 
  input String fileName; 
  output String contents; 

end readFile; 

readFileNoNumeric Returns the contents of the file, with anything resembling a (real) number 
stripped out, and at the end adding: 
  Filter count from number domain: n. 
  This should probably be changed to multiple outputs; the filtered string and 
an integer. 
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  Does anyone use this API call? 
Interface: 
function readFileNoNumeric 
  input String fileName; 
  output String contents; 

end readFileNoNumeric; 

readFilePostprocessLineDirective Searches lines for the #modelicaLine directive. If it is found, all lines up until 
the next #modelicaLine or #endModelicaLine are put on a single file, 
following a #line linenumber "filename" line.  This causes GCC to output an 
executable that we can set breakpoints in and debug. 
Note: You could use a stack to keep track of start/end of #modelicaLine and 
match them up. But this is not really desirable since that will cause extra 
breakpoints for the same line (you would get breakpoints before and after 
each case if you break on a match-expression, etc). 
Interface: 
function readFilePostprocessLineDirective 
  input String fileName; 
  output String out; 

end readFilePostprocessLineDirective; 

readFileShowLineNumbers Prefixes each line in the file with <n>:, where n is the line number. 
Note: Scales O(n^2) 
Interface: 
function readFileShowLineNumbers 
  input String fileName; 
  output String out; 

end readFileShowLineNumbers; 

readSimulationResult Reads a result file, returning a matrix corresponding to the variables and size 
given. 
Interface: 
function readSimulationResult 
  input String filename; 
  input VariableNames variables; 
  input Integer size = 0 "0=read any size... If the 

size is not the same as the result-file, this function 
fails"; 
  output Real result[:,:]; 

end readSimulationResult; 

readSimulationResultSize The number of intervals that are present in the output file. 
Interface: 
function readSimulationResultSize 
  input String fileName; 
  output Integer sz; 

end readSimulationResultSize; 

readSimulationResultVars Returns the variables in the simulation file; you can use val() and plot() 
commands using these names. 
Interface: 
function readSimulationResultVars 
  input String fileName; 
  output String[:] vars; 

end readSimulationResultVars; 

Regex Sets the error buffer and returns -1 if the regex does not compile. 
 
  The returned result is the same as POSIX regex(): 
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  The first value is the complete matched string 
  The rest are the substrings that you wanted. 
  For example: 
  regex(lorem," \([A-Za-z]*\) \([A-Za-z]*\) ",maxMatches=3) 
  => {" ipsum dolor ","ipsum","dolor"} 
  This means if you have n groups, you want maxMatches=n+1 
Interface: 
function regex 
  input String str; 
  input String re; 
  input Integer maxMatches = 1 "The maximum number 

of matches that will be returned"; 
  input Boolean extended = true "Use POSIX extended 

or regular syntax"; 
  input Boolean caseInsensitive = false; 
  output Integer numMatches "-1 is an error, 0 means 

no match, else returns a number 1..maxMatches"; 
  output String matchedSubstrings[maxMatches] 

"unmatched strings are returned as empty"; 
end regex; 

regexBool Returns true if the string matches the regular expression. 
Interface: 
function regexBool 
  input String str; 
  input String re; 
  input Boolean extended = true "Use POSIX extended 

or regular syntax"; 
  input Boolean caseInsensitive = false; 
  output Boolean matches; 

end regexBool; 

regularFileExists The contents of the given file are returned. 
Note that if the function fails, the error message is returned as a string instead 
of multiple output or similar. 
Interface: 
function regularFileExists 
  input String fileName; 
  output Boolean exists; 

end regularFileExists; 

reopenStandardStream Interface: 
function reopenStandardStream 
  input StandardStream _stream; 
  input String filename; 
  output Boolean success; 

end reopenStandardStream; 

runScript Runs the mos-script specified by the filename. 
Interface: 
function runScript 
  input String fileName "*.mos"; 
  output String result; 

end runScript; 

Save Interface: 
function save 
  input TypeName className; 
  output Boolean success; 

end save; 
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saveAll Save the entire loaded AST to file. 
Interface: 
function saveAll 
  input String fileName; 
  output Boolean success; 

end saveAll; 

saveModel Save class definition in a file. 
Interface: 
function saveModel 
  input String fileName; 
  input TypeName className; 
  output Boolean success; 

end saveModel; 

saveTotalModel Save total class definition into file of a class.  
Inputs: String fileName; TypeName className  
Outputs: Boolean res; 
Interface: 
function saveTotalModel 
  input String fileName; 
  input TypeName className; 
  output Boolean success; 

end saveTotalModel; 

saveTotalSCode Interface: 
function saveTotalSCode 
  input String fileName; 
  input TypeName className; 
  output Boolean success; 

end saveTotalSCode; 

setAnnotationVersion Sets the annotation version. 
Interface: 
function setAnnotationVersion 
  input String annotationVersion; 
  output Boolean success; 

end setAnnotationVersion; 

setCXXCompiler Interface: 
function setCXXCompiler 
  input String compiler; 
  output Boolean success; 

end setCXXCompiler; 

setClassComment Sets the class comment. 
Interface: 
function setClassComment 
  input TypeName class_; 
  input String filename; 
  output Boolean success; 

end setClassComment; 

setCommandLineOptions The input is a regular command-line flag given to OMC, e.g. +d=failtrace or 
+g=MetaModelica. 
Interface: 
function setCommandLineOptions 
  input String option; 
  output Boolean success; 

end setCommandLineOptions; 
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setCompileCommand Interface: 
function setCompileCommand 
  input String compileCommand; 
  output Boolean success; 

end setCompileCommand; 

setCompiler Interface: 
function setCompiler 
  input String compiler; 
  output Boolean success; 

end setCompiler; 

setCompilerFlags Interface: 
function setCompilerFlags 
  input String compilerFlags; 
  output Boolean success; 

end setCompilerFlags; 

setCompilerPath Interface: 
function setCompilerPath 
  input String compilerPath; 
  output Boolean success; 

end setCompilerPath; 

setDebugFlags example input: failtrace,-noevalfunc 
Interface: 
function setDebugFlags 
  input String debugFlags; 
  output Boolean success; 

end setDebugFlags; 

setEnvironmentVar Interface: 
function setEnvironmentVar 
  input String var; 
  input String value; 
  output Boolean success; 

end setEnvironmentVar; 

setIndexReductionMethod example input: dummyDerivative 
Interface: 
function setIndexReductionMethod 
  input String method; 
  output Boolean success; 

end setIndexReductionMethod; 

setInstallationDirectoryPath Sets the OPENMODELICAHOME environment variable. Use this method 
instead of setEnvironmentVar. 
Interface: 
function setInstallationDirectoryPath 
  input String installationDirectoryPath; 
  output Boolean success; 

end setInstallationDirectoryPath; 

setLanguageStandard Sets the Modelica Language Standard. 
Interface: 
function setLanguageStandard 
  input String inVersion; 
  output Boolean success; 

end setLanguageStandard; 
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setLinker Interface: 
function setLinker 
  input String linker; 
  output Boolean success; 

end setLinker; 

setLinkerFlags Interface: 
function setLinkerFlags 
  input String linkerFlags; 
  output Boolean success; 

end setLinkerFlags; 

setModelicaPath See loadModel() for a description of what the MODELICAPATH is used 
for. 
Interface: 
function setModelicaPath 
  input String modelicaPath; 
  output Boolean success; 

end setModelicaPath; 

setNoSimplify Sets the noSimplify flag. 
Interface: 
function setNoSimplify 
  input Boolean noSimplify; 
  output Boolean success; 

end setNoSimplify; 

setOrderConnections Sets the orderConnection flag. 
Interface: 
function setOrderConnections 
  input Boolean orderConnections; 
  output Boolean success; 

end setOrderConnections; 

setPastOptModules example input: lateInline,inlineArrayEqn,removeSimpleEquations 
Interface: 
function setPastOptModules 
  input String modules; 
  output Boolean success; 

end setPastOptModules; 

setPlotCommand Interface: 
function setPlotCommand 
  input String plotCommand; 
  output Boolean success; 

end setPlotCommand; 

setPlotSilent Sets the plotSilent flag. 
Interface: 
function setPlotSilent 
  input Boolean silent; 
  output Boolean success; 

end setPlotSilent; 

setPreOptModules example input: 
removeFinalParameters,removeSimpleEquations,expandDerOperator 
Interface: 
function setPreOptModules 
  input String modules; 
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  output Boolean success; 
end setPreOptModules; 

setShowAnnotations Interface: 
function setShowAnnotations 
  input Boolean show; 
  output Boolean success; 

end setShowAnnotations; 

setSourceFile Interface: 
function setSourceFile 
  input TypeName class_; 
  input String filename; 
  output Boolean success; 

end setSourceFile; 

setTempDirectoryPath Interface: 
function setTempDirectoryPath 
  input String tempDirectoryPath; 
  output Boolean success; 

end setTempDirectoryPath; 

setVectorizationLimit Interface: 
function setVectorizationLimit 
  input Integer vectorizationLimit; 
  output Boolean success; 

end setVectorizationLimit; 

solveLinearSystem Solve A*X = B, using dgesv or lp_solve (if any variable in X is integer). 
Returns for solver dgesv: info>0: Singular for element i. info<0: Bad input. 
Interface: 
function solveLinearSystem 
  input Real[size(B, 1),size(B, 1)] A; 
  input Real[:] B; 
  input LinearSystemSolver solver = 

LinearSystemSolver.dgesv; 
  input Integer[:] isInt = {-1} "list of indices 

that are integers"; 
  output Real[size(B, 1)] X; 
  output Integer info; 

end solveLinearSystem; 

strictRMLCheck Checks if any loaded function. 
Interface: 
function strictRMLCheck 
  output String message "empty if there was no 

problem"; 
end strictRMLCheck; 

stringReplace Interface: 
function stringReplace 
  input String str; 
  input String source; 
  input String target; 
  output String res; 

end stringReplace; 

Strtok Splits the strings at the places given by the token, for example: 
  strtok("abcbdef","b") => {"a","c","def"} 
Interface: 
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function strtok 
  input String string; 
  input String token; 
  output String[:] strings; 

end strtok; 

System Similar to system(3). Executes the given command in the system shell. 
Interface: 
function system 
  input String callStr "String to call: bash -c 

$callStr"; 
  output Integer retval "Return value of the system 

call; usually 0 on success"; 
end system; 

translateGraphics Interface: 
function translateGraphics 
  input TypeName className; 
  output String result; 

end translateGraphics; 

typeNameString Interface: 
function typeNameString 
  input TypeName cl; 
  output String out; 

end typeNameString; 

typeNameStrings Interface: 
function typeNameStrings 
  input TypeName cl; 
  output String out[:]; 

end typeNameStrings; 

typeOf Interface: 
function typeOf 
  input VariableName variableName; 
  output String result; 

end typeOf; 

uriToFilename Handles modelica:// and file:// URI's. The result is an absolute path on the 
local system. The result depends on the current MODELICAPATH. Returns 
the empty string on failure. 
Interface: 
function uriToFilename 
  input String uri; 
  output String filename; 

end uriToFilename; 

val Works on the filename pointed to by the scripting variable 
currentSimulationResult. The result is the value of the variable at a certain 
time point. For parameters, any time may be given. For variables the 
startTime<=time<=stopTime needs to hold. On error, nan (Not a Number) is 
returned and the error buffer contains the message. 
Interface: 
function val 
  input VariableName var; 
  input Real time; 
  output Real valAtTime; 

end val; 
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verifyCompiler Interface: 
function verifyCompiler 
  output Boolean compilerWorks; 

end verifyCompiler; 

visualize Uses the 3D visualization package, SimpleVisual.mo, to  visualize the model. 
See chapter 3.4 (3D Animation) of the OpenModelica System Documentation 
for more details. Writes the visulizations objects into the file 
"model_name.visualize".   
Example command sequence: 
  simulate(A,outputFormat="mat"); 
  visualize(A); 
  visualize(A,"B.mat"); 
  visualize(A,"B.mat", true); 
Interface: 
function visualize 
  input TypeName className; 
  input Boolean externalWindow = false "Opens the 

visualize in a new window"; 
  input String fileName = "<default>" "The filename 

containing the variables. <default> will read the last 
simulation result"; 
  output Boolean success "Returns true on success"; 

end visualize; 

writeFile Write the data to file. Returns true on success. 
Interface: 
function writeFile 
  input String fileName; 
  input String data; 
  input Boolean append = false; 
  output Boolean success; 

end writeFile; 

13.7 PySimulator 
PySimulator provides a graphical user interface for simulating different model types (currently Functional 
Mockup Units and Modelica Models), plotting result variables and applying simulation result analysis tools 
like Fast Fourier Transform. Read more about the PySimulator here https://code.google.com/p/pysimulator/ 

13.7.1 Installation under Windows 

In order to run PySimulator on windows you need to install the following softwares; 

• Python – Install python from http://www.python.org/download/. Python2.7.3 is recommended. 

• Numpy1.7.1 – Install numpy from http://sourceforge.net/projects/numpy/files/NumPy/1.7.1rc1/. 
numpy-1.7.1rc1-win32-superpack-python2.7.exe is recommended. 

• PySide1.1.1 – Install PySide from http://releases.qt-project.org/pyside/. PySide-1.1.1qt474.win32-
py2.7.exe is recommended. 

• Scipy0.10.1 – Install scipy from http://sourceforge.net/projects/scipy/files/scipy/0.10.1rc2/. scipy-
0.10.1rc2-win32-superpack-python2.7.exe is recommended. 

• h5py – Install h5py from https://code.google.com/p/h5py/downloads/list. h5py-2.0.1.win32-
py2.7.msi is recommended. 

https://code.google.com/p/pysimulator/�
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• enable4.3.0, chaco4.3.0, and traits4.3.0 – Install the all-in-one package from ETS, the Enthought 
Tool Suite, available also from http://www.lfd.uci.edu/~gohlke/pythonlibs/. ets-4.3.0.win32-
py2.7.exe is recommended. 

• python-sundials0.5 – Install python-sundials from https://code.google.com/p/python-
sundials/downloads/list . python-sundials-0.5.win32-py2.7.exe is recommended. 

13.7.2 Running PySimulator 

Run the PySimulator by executing the PySimulator.py script located at OpenModelica1.9.0/share/omc/scri- 
pts/PythonInterface/PySimulator. 
python PySimulator.py 

This will start the PySimulator and on success you should see the output, 
Dymola plug-in loading 

FMUSimulator plug-in loading 

OpenModelica plug-in loading 

OMC Server is up and running at file . . . 

 

DymolaMat plug-in loading 

Mtsf plug-in loading 

EigenvalueAnalysis plug-in loading 

LinearSystemAnalysis plug-in loading 

MinMax plug-in loading 

SignalProcessing plug-in loading 

13.7.3 Loading a Modelica Model  

The integration of the OMPython module within the OpenModelica plugin for PySimulator makes it 
possible for the modeler to quickly load Modelica files such as models (.mo) or load a simulated model's 
executable file.  

The user can open these files from the menu bar by selecting File > Open Model > OpenModelica. 
In this introductory example we will use a pre-defined model named Influenza to demonstrate the use of 
OMPython in PySimulator. Figure 13-13-1 depicts the graphical user interface of PySimulator when 
opening a model file. Once the model file is selected, the model is loaded into the variables browser and is 
ready to be configured for simulations. 
 

http://code.enthought.com/projects/�
http://www.lfd.uci.edu/~gohlke/pythonlibs/�
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Figure 13-13-2: Loading Modelica models or model executables in PySimulator 

13.7.4 Using the OpenModelica plugin  

The loaded Modelica model can be simulated from PySimulator using the default simulation options or by 
setting the simulation options before simulating from the Integrator Control dialog box. The OpenModelica 
plugin defines the simulation routine for the Modelica models by using the execute method of the 
OMPython API.  

Figure 13-2 shows how the simulation options can be set using PySimulator's Integrator control feature. 



163 

 
 

 

 
 

Figure 13-2. Preparing the simulation settings using the Integrator Control. 

13.7.5 Simulating the model  

The initial simulation parameters and settings are provided as inputs to the OMC via the front-end of 
PySimulator. The Run button of the Integrator control triggers the simulate command of the OMC with the 
supplied simulation options. The simulate command has the following parameters,  

• Simulation Interval  

o Start Time  

o Stop Time  

• Algorithm  

• Error Tolerance  
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• Step size  
 

The user has the option to choose from a range of Numerical integration algorithms from the Algorithm 
selection box. The Integrator control dialog box also filters some parameters that are not available for some 
integration solvers by disabling the field; avoiding error and providing more accuracy in the results.  

The Variables browser builds a tree structure of the instance variables and highlights time-continuous 
variables in blue. The user can select these variables and plot them in the Plot window by checking the 
check box near the highlighted variables.  

Figure 13-3 illustrates the Variables browser that allows users to access the variables after the Influenza 
model has been simulated with some simulation parameters set.  
 

 
 

Figure 13-3. Variables browser of the simulated model. 

13.7.6 Plotting variables from the simulated models 

The Plot window of the PySimulator GUI provides additional user interface controls for comparing 
different plots side-by-side, adding and removing plots and also to save the plots.  

Figure 13-4 shows the plotted variables in the plot window and the list of simulation variables in the 
Variables browser along with the variables selected for plotting. 
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Figure 13-4. Plotted variables using PySimulator. 

13.7.7 Using Simulated results 

It is desirable to avoid simulating the model again every time the user needs the simulation results. It is 
instead preferable to use an existing simulation result file for the calculations, this saves resources and time. 
PySimulator supports opening the OpenModelica simulation result files (.mat) and the model's executable 
file to build the variable tree in the variables browser. The user can then adjust some parameters from the 
variable tree or the Integrator control to achieve the desired results. 
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Chapter 14 Model-Based Dynamic Optimization 
with OpenModelica and CasADi 

OpenModelica coupling with CasADi supports dynamic optimization of models. In order to convey the 
dynamic system model information between Modelica and CasADi, we use an XML-based model 
exchange format for differential-algebraic equations (DAE). OpenModelica supports export of models 
written in Modelica and the Optimization language extension using this XML format, while CasADi 
supports import of models represented in this format. This allows users to define optimal control problems 
(OCP) using Modelica and Optimization language specifications, and solve the underlying model 
formulation using a range of optimization methods, including direct collocation and direct multiple 
shooting. 

14.1 Compiling the Modelica code 
Before exporting a model to XML, the model should be symbolically instantiated by the compiler in order 
to get a single flat system of equations. The model variables should also be scalarized. The compiler 
frontend performs this, including syntax checking, semantics and type checking, simplification and 
constant evaluation etc. are applied. Then the complete flattened model is exported to XML code. The 
exported XML document can then be imported to CasADi for model-based dynamic optimization. 

The OpenModelica command translateModelXML(ModelName) from OMShell, OMNotebook or 
MDT exports the XML. The export XML command is also integrated with OMEdit. Select XML > Export 
XML the XML document is generated in the current directory of omc. You can use the cd() command to 
see the current location. After the command execution is complete you will see that a file ModelName.xml 
has been exported. As depicted in Figure 14-1, we first changed the current directory to 
C:/OpenModelica1.9.0/bin, and then we loaded a Modelica file with BatchReactor example model 
and finally exported an XML for it using the translateModelXML call. 

Assuming that the model is defined in the modelName.mo, the model can also be exported to an XML 
code using the following steps from the terminal window: 

• Go to the path where your model file found(C:/<%path to modelName .mo file%>).  

• Go to omc path (<%path to omc%>/omc) and write the flag +s +g=Optimica 

+simCodeTarget=XML <%your.mo file name%>.mo>  
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Figure 14-1: OMShell screenshot for exporting an XML 

14.2. An example 
In this section, a simple optimal control problem will be solved. When formulating the optimization 
problems, models are expressed in the Modelica language and optimization specifications. The 
optimization language specification allows users to formulate dynamic optimization problems to be solved 
by a numerical algorithm. It includes several constructs including a new specialized class optimization, 
a constraint section, startTime, finalTime etc. See the optimal control problem for batch 
reactor model below. 
 
optimization BatchReactor(objective=-x2(finalTime), 
                    startTime = 0, finalTime =1) 
    Real x1(start =1, fixed=true, min=0, max=1); 
    Real x2(start =0, fixed=true, min=0, max=1); 
    input Real u(min=0, max=5); 
equation 
    der(x1) = -(u+u^2/2)*x1; 
    der(x2) = u*x1; 
end BatchReactor; 
Create a new file named BatchReactor.mo and save it in you working directory. Notice that this model 

contains both the dynamic system to be optimized and the optimization specification.  
One we have formulated the undelying optimal control problems, we can export the XML by using 

OMShell, OMNotebook , MDT, OMEdit or command line terminals which are described in section 14.1. 
To export XML using terminals as depicted in Figure 14-2, we first changed the current directory to 

C:/TestCases, and run command ../Dev/OpenModleica/build/bin omc +s +g=Optimica 
+simCodeTarget=XML BatchReactor.mo. This will generate an XML file under C:/TestCases 
directory named BatchReactor.xml shown in section 14.3 that contains a symbolic representation of the 
optimal control problem and can be inspected in a standard XML editor. 
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Figure 14-2: Terminal screenshot for exporting an XML 

14.3. Generated XML for Example 
<?xml version="1.0" encoding="UTF-8"?> 
<OpenModelicaModelDescription 
   xmlns:exp="https://svn.jmodelica.org/trunk/XML/daeExpressions.xsd" 
   xmlns:equ="https://svn.jmodelica.org/trunk/XML/daeEquations.xsd" 
   xmlns:fun="https://svn.jmodelica.org/trunk/XML/daeFunctions.xsd" 
   xmlns:opt="https://svn.jmodelica.org/trunk/XML/daeOptimization.xsd" 
   xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
   fmiVersion="1.0" 
   modelName="BatchReactor" 
   modelIdentifier="BatchReactor" 
   guid="{d06ca497-3a14-4c61-ab0a-ee9f3edfca73}" 
   generationDateAndTime="2012-05-18T17:47:35" 
   variableNamingConvention="Structured" 
   numberOfContinuousStates="2" 
   numberOfEventIndicators="0"> 
   <VendorAnnotations> 
       <Tool name="OpenModelica Compiler 1.8.1+ (r11925)"> 
       </Tool> 
   </VendorAnnotations>   
   <ModelVariables> 
       <ScalarVariable name="finalTime" valueReference="0"  
     variability="parameter" causality="internal" alias="noAlias"> 
           <Real relativeQuantity="false" start="1.0" free="false"     
                initialGuess="0.0" /> 
           <QualifiedName> 
    <exp:QualifiedNamePart name="finalTime"/> 
           </QualifiedName> 
           <isLinear>true</isLinear> 
           <isLinearTimedVariables> 
               <TimePoint index="0" isLinear="true"/> 
           </isLinearTimedVariables> 
           <VariableCategory>independentParameter</VariableCategory> 
       </ScalarVariable> 
       <ScalarVariable name="startTime" valueReference="1"  
              variability="parameter" causality="internal" alias="noAlias"> 
           <Real relativeQuantity="false" start="0.0" free="false"   
                 initialGuess="0.0" /> 
           <QualifiedName> 
                <exp:QualifiedNamePart name="startTime"/> 
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           </QualifiedName> 
           <isLinear>true</isLinear> 
           <isLinearTimedVariables> 
               <TimePoint index="0" isLinear="true"/> 
           </isLinearTimedVariables> 
           <VariableCategory>independentParameter</VariableCategory> 
       </ScalarVariable> 
       <ScalarVariable name="x1" valueReference="2" variability="continuous"   
            causality="internal" alias="noAlias"> 
            <Real relativeQuantity="false" min="0.0" max="1.0" start="1.0"   
                 fixed="true"  /> 
            <QualifiedName> 
     <exp:QualifiedNamePart name="x1"/> 
            </QualifiedName> 
            <VariableCategory>state</VariableCategory> 
       </ScalarVariable>  
       <ScalarVariable name="x2" valueReference="3"  
             variability="continuous" causality="internal" alias="noAlias"> 
             <Real relativeQuantity="false" min="0.0" max="1.0" start="0.0"  
                   fixed="true"  /> 
             <QualifiedName> 
      <exp:QualifiedNamePart name="x2"/> 
             </QualifiedName> 
             <VariableCategory>state</VariableCategory> 
       </ScalarVariable>  
       <ScalarVariable name="der(x1)" valueReference="4"  
               variability="continuous" causality="internal" alias="noAlias"> 
 <Real relativeQuantity="false" /> 
 <QualifiedName> 
      <exp:QualifiedNamePart name="x1"/> 
 </QualifiedName> 
 <VariableCategory>derivative</VariableCategory> 
       </ScalarVariable>  
       <ScalarVariable name="der(x2)"  valueReference="5"  
    variability="continuous" causality="internal" alias="noAlias"> 
 <Real relativeQuantity="false"  /> 
 <QualifiedName> 
          <exp:QualifiedNamePart name="x2"/> 
 </QualifiedName> 
 <VariableCategory>derivative</VariableCategory> 
       </ScalarVariable>  
       <ScalarVariable name="u"  valueReference="6"  
     variability="continuous" causality="input" alias="noAlias"> 
 <Real relativeQuantity="false" min="0.0" max="5.0"/> 
 <QualifiedName> 
        <exp:QualifiedNamePart name="u"/> 
 </QualifiedName> 
 <VariableCategory>algebraic</VariableCategory> 
       </ScalarVariable>  
</ModelVariables> 
<equ:BindingEquations> 
      <equ:BindingEquation> 
            <equ:Parameter>     
      <exp:QualifiedNamePart name="startTime"/> 
 </equ:Parameter> 
 <equ:BindingExp> 
      <exp:IntegerLiteral>0</exp:IntegerLiteral> 
 </equ:BindingExp> 
      </equ:BindingEquation> 
      <equ:BindingEquation> 
 <equ:Parameter>     
      <exp:QualifiedNamePart name="finalTime"/> 
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 </equ:Parameter> 
 <equ:BindingExp> 
       <exp:IntegerLiteral>1</exp:IntegerLiteral> 
 </equ:BindingExp> 
      </equ:BindingEquation> 
</equ:BindingEquations> 
<equ:DynamicEquations> 
     <equ:Equation> 
          <exp:Sub> 
    <exp:Der> 
         <exp:Identifier> 
   <exp:QualifiedNamePart name="x2"/> 
         </exp:Identifier> 
    </exp:Der> 
    <exp:Mul> 
         <exp:Identifier> 
   <exp:QualifiedNamePart name="u"/> 
         </exp:Identifier> 
         <exp:Identifier> 
   <exp:QualifiedNamePart name="x1"/> 
         </exp:Identifier> 
     </exp:Mul> 
          </exp:Sub> 
     </equ:Equation>   
     <equ:Equation> 
          <exp:Sub> 
    <exp:Der> 
         <exp:Identifier> 
   <exp:QualifiedNamePart name="x1"/> 
         </exp:Identifier> 
    </exp:Der> 
    <exp:Mul> 
                    <exp:Sub> 
   <exp:Div> 
        <exp:Neg> 
                        <exp:Pow> 
       <exp:Identifier> 
                       <exp:QualifiedNamePart name="u"/> 
       </exp:Identifier> 
                  <exp:RealLiteral>2.0</exp:RealLiteral> 
             </exp:Pow> 
                   </exp:Neg> 
                   <exp:RealLiteral>2.0</exp:RealLiteral> 
         </exp:Div> 
              <exp:Identifier> 
                   <exp:QualifiedNamePart name="u"/> 
              </exp:Identifier> 
                    </exp:Sub> 
                    <exp:Identifier> 
                         <exp:QualifiedNamePart name="x1"/> 
         </exp:Identifier> 
    </exp:Mul> 
          </exp:Sub> 
     </equ:Equation>   
</equ:DynamicEquations> 
<equ:InitialEquations> 
     <equ:Equation> 
          <exp:Sub> 
               <exp:Identifier> 
         <exp:QualifiedNamePart name="x1"/> 
    </exp:Identifier> 
    <exp:RealLiteral>1.0</exp:RealLiteral> 
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          </exp:Sub> 
     </equ:Equation> 
     <equ:Equation> 
          <exp:Sub> 
               <exp:Identifier> 
         <exp:QualifiedNamePart name="x2"/> 
               </exp:Identifier> 
               <exp:RealLiteral>0.0</exp:RealLiteral> 
          </exp:Sub> 
     </equ:Equation> 
</equ:InitialEquations> 
<opt:Optimization> 
      <opt:ObjectiveFunction> 
           <exp:Neg> 
                <exp:TimedVariable timePointIndex = "0" > 
                     <exp:Identifier> 
                          <exp:QualifiedNamePart name="x2"/> 
          </exp:Identifier> 
                </exp:TimedVariable> 
           </exp:Neg> 
      </opt:ObjectiveFunction> 
      <opt:IntervalStartTime> 
 <opt:Value>0.0</opt:Value> 
 <opt:Free>false</opt:Free> 
 <opt:InitialGuess>0.0</opt:InitialGuess> 
      </opt:IntervalStartTime> 
      <opt:IntervalFinalTime> 
 <opt:Value>1.0</opt:Value> 
 <opt:Free>false</opt:Free> 
 <opt:InitialGuess>1.0</opt:InitialGuess> 
      </opt:IntervalFinalTime> 
      <opt:TimePoints> 
 <opt:TimePoint index = "0" value = "1.0"> 
       <opt:QualifiedName> 
            <exp:QualifiedNamePart name="x2"/> 
       </opt:QualifiedName> 
 </opt:TimePoint> 
       </opt:TimePoints> 
       <opt:Constraints> 
       </opt:Constraints> 
   </opt:Optimization> 
   <fun:FunctionsList> 
   </fun:FunctionsList> 
</OpenModelicaModelDescription> 

14.4 XML Import to CasADi via OpenModelica Python Script 
The symbolic optimal control problem representation (or just model description) contained in 
BatchReactor.xml can be imported into CasADi in the form of the SymbolicOCP class via OpenModelica 
python script. 

The SymbolicOCP class contains symbolic representation of the optimal control problem designed to be 
general and allow manipulation. For a more detailed description of this class and its functionalities, we 
refer to the API documentation of CasADi.  

The following step compiles the model to an XML format, imports to CasADi and solves an 
optimization problem in windows PowerShell: 

1. Create a new file named BatchReactor.mo and save it in you working directory. 
E.g. C:\OpenModelica1.9.0\share\casadi\testmodel 

2. Perform compilation  and generate the XML file 
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a. Go to your working directory 
E.g. cd C:\OpenModelica1.9.0\share\casadi\testmodel 

b. Go to omc path from working directory and run the following command 
E.g.  ..\..\..\bin\omc +s +g=Optimica +simCodeTarget=XML 
BatchReactor.mo 

3. Run defaultStart.py python script from OpenModelica optimization directory 
      E.g.  Python.exe ..\share\casadi\scripts defaultStart.py BatchReactor.xml 

 
The control and state trajectories of the optimization results are shown in Figure 14.3. 
 

 

 
 

Figure 14.3: Optimization results for Btach Reactor model – state and control variables. 
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Chapter 15  
 
Frequently Asked Questions (FAQ) 

Below are some frequently asked questions in three areas, with associated answers. 

15.1 OpenModelica General 
• Q: OpenModelica does not read the MODELICAPATH environment variable, even though this is 

part of the Modelica Language Specification. 
• A: Use the OPENMODELICALIBRARY environment variable instead. We have temporarily 

switched to this variable, in order not to interfere with other Modelica tools which might be 
installed on the same system. In the future, we might switch to a solution with a settings file, that 
also allows the user to turn on the MODELICAPATH functionality if desired. 

• Q: How do I enter multi-line models into OMShell since it evaluates when typing the Enter/Return 
key? 

• A: There are basically three methods: 1) load the model from a file using the pull-down menu or the 
loadModel command. 2) Enter the model/function as one (possibly long) line. 3) Type in the model 
in another editor, where using multiple lines is no problem, and copy/paste the model into OMShell 
as one operation, then push Enter. Another option is to use OMNotebook instead to enter and 
evaluate models. 

15.2 OMNotebook 
• Q: OMNotebook hangs, what to do? 
• A: It is probably waiting for the omc.exe (compiler) process. (Under windows): Kill the processes 

omc.exe, g++.exe (C-compiler), as.exe (assembler), if present. If OMNotebook then asks whether 
to restart OMC, answer yes. If not, kill the process OMNotebook.exe and restart manually. 

• Q: I always get simulation failed, and plotting does not work.. 
• A: This is cause by problems compiling and linking the generated simulation code with the 

MINGW (Gnu) C compiler under Windows. You probably have some Logitech software installed 
that prevents Corba communication to start the compilation. There is a known bug/incompatibility 
in Logitech products. For example, if  lvprcsrv.exe is running, kill it and/or prevent it to start again 
at reboot; it does not do anything really useful, not needed for operation of web cameras or mice.  
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• Q: After a previous session, when starting OMNotebook again, I get a strange message. 
• A: You probably quit the previous OpenModelica session in the wrong way, which left the process 

omc.exe running. Kill that process, and try starting OMNotebook again. 

• Q: I copy and paste a graphic figure from Word or some other application into OMNotebook, but 
the graphic does not appear. What is wrong? 

• A: OMNotebook supports the graphic picture formats supported by Qt 4, including the .png, .bmp 
(bitmap) formats, but not for example the gif format. Try to convert your picture into one of the 
supported formats, (e.g. in Word, first do paste as bitmap format), and then copy the converted 
version into a text cell in OMNotebook. 

• Q: Plotting does not work in OMNotebook. 
• A: You probably have an old version of Java installed. Update your installation, and try again. 

(Another known problem, soon to be fixed, is that plotting of parameters and constants does not yet 
work). 

• Q: I select a cell, copy it (e.g. Ctrl-C), and try to paste it at another place in the notebook. However, 
this does not work. Instead some other text that I earlier put on the clipboard is pasted into the 
nearest text cell. 

• A: The problem is wrong choice of cursor mode, which can be text insertion or cell insertion. If you 
click inside a cell, the cursor become vertical, and OMNotebook expects you to paste text inside the 
cell. To paste a cell, you must be in cell insertion mode, i.e., click between two cells (or after a 
cell), you will get a vertical line. Place the cursor carefully on that vertical line until you see a small 
horizontal cursor. Then you should past the cell. 

• Q: I am trying to click in cells to place the vertical character cursor, but it does not seem to react. 
• A: This seems to be a Qt feature. You have probably made a selection (e.g. for copying) in the 

output section of an evaluation cell. This seems to block cursor position. Click again in the output 
section to disable the selection. After that it will work normally. 

• Q: I have copied a text cell and start writing at the beginning of the cell. Strangely enough, the font 
becomes much smaller than it should be. 

• A: This seems to be a Qt feature. Keep some of the old text and start writing the new stuff inside the 
text, i.e., at least one character position to the right. Afterwards, delete the old text at the beginning 
of the cell. 

15.3 OMDev - OpenModelica Development Environment 
• Q: I get problems compiling and linking some files when using OMDev with the MINGW (Gnu) C 

compiler under Windows. 
• A: You probably have some Logitech software installed. There is a known bug/incompatibility in 

Logitech products. For example, if  lvprcsrv.exe is running, kill it and/or prevent it to start again at 
reboot; it does not do anything really useful, not needed for operation of web cameras or mice. 
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Appendix A  
 
Major OpenModelica Releases 

This Appendix lists the most important OpenModelica releases and a brief description of their contents. 
Right now the versions from 1.3.1 to 1.9.0 are described.  

 

A.1 OpenModelica 1.9.0, October 2013 
The three most important enhancements in the OpenModelica 1.9.0 release: 

• OpenModelica compiler support for most of the Fluid library. 
• Support for the significantly updated library MSL 3.2.1 final version. 
• Significantly enhanced graphical user interface in OMEdit. 

New features: integration of the PySimulator analysis package; Dynamic Optimization with CasADi. 

A.1.1 OpenModelica Compiler (OMC) 
This release mainly includes improvements of the OpenModelica Compiler (OMC), including, but not 
restricted to the following: 

• A more stable and complete OMC model compiler. The 1.9.0 final version simulates many more 
models than the previous 1.8.1 version and OpenModelica 1.9.0 beta versions. 

• Much better simulation support for MSL 3.2.1, now 270 out of 274 example models compile (98%) 
and 247 (90%) simulate, compared to 30% simulating in the 1.9.0 beta1 release. 

• Much better simulation for the ModelicaTest 3.2.1 library, now 412 out of 428 models compile 
(96%), and 380 (88%) simulate, compared to 32% in November 2012. 

• Improved tearing algorithm for the compiler backend. Tearing is by default used. 
• Much faster matching and dynamic state selection algorithms for the compiler backend. 
• New index reduction algorithm implementation. 
• New default initialization method that symbolically solves the initialization problem much faster 

and more accurately. This is the first version that in general initialize hybrid models correctly. 
• Better class loading from files. The package.order file is now respected and the file structure is 

more thoroughly examined. 
• Basic support for pure/impure functions. 
• It is now possible to translate the error messages in the omc kernel. 
• Enhanced ModelicaML version with support for value bindings in requirements-driven modeling 

available for the latest Eclipse and Papyrus versions. GUI specific adaptations. Automated model 
composition workflows (used for model-based design verification against requirements) are 
modularized and have improved in terms of performance. 

• FMI for co-simulation with OMC as master. Improved FMI import/export, model exchange. 
• Checking (when possible) that variables have been assigned to before they are used in algorithmic 

code. 
• Full version of Python scripting. 
• 3D graphics visualization using the Modelica3D library. 
• The PySimulator package from DLR for additional analysis is integrated with OpenModelica (see 

Modelica2012 paper), and included in the OpenModelica distribution. 
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• Prototype support for uncertainty computations, special feature enabled by special flag. 
• Parallel algorithmic Modelica support (ParModelica) for efficient portable parallel algorithmic 

programming based on the OpenCL standard, for CPUs and GPUs. 
• Support for optimization of semiLinear according to MSL 3.3 chapter 3.7.2.5 semiLinear. 

A.1.2 OpenModelica Notebook (OMNotebook) 
The DrModelica interactive document has been updated and the models tested. Almost all models now 
simulate with OpenModelica. 

A.1.3 OpenModelica Shell (OMShell) 
No changes. 

A.1.4 OpenModelica Eclipse Plug-in (MDT) 
Enhanced debugger for algorithmic Modelica code, supporting both standard Modelica algorithmic code 
called from simulation models, and MetaModelica code. 

A.1.5 OpenModelica Development Environment (OMDev) 
Migration of version handling and configuration management from CodeBeamer to Trac. 

A.1.6 Graphic Editor OMEdit 
• General GUI: backward and forward navigation support in Documentation view, enhanced 

parameters window with support for Dialog annotation. Most of the images are converted from 
raster to vector graphics i.e PNG to SVG. 

• Libraries Browser: better loading of libraries, library tree can now show protected classes, show 
library items class names as middle ellipses if the class name text is larger, more options via the 
right click menu for quick usage. 

• ModelWidget: add the partial class as a replaceable component, look for the default component 
prefixes and name when adding the component. 

• GraphicsView: coordinate system manipulation for icon and diagram layers. Show red box for 
models that do not exist. Show default graphical annotation for the components that doesn’t have 
any graphical annotations. Better resizing of the components. Properties dialog for primitive shapes 
i.e Line, Polygon, Rectangle, Ellipse, Text and Bitmap. 

• File Opening: open one or more Modelica files, allow users to select the encoding while opening 
the file, convert files to UTF-8 encoding, allow users to open the OpenModelica result files. 

• Variables Browser: find variables in the variables browser, sorting in the variables browser. 
• Plot Window: clear all curves of the plot window, preserve the old selected variable and update its 

value with the new simulation result. 
• Simulation: support for all the simulation flags, read the simulation output as soon as is is obtained, 

output window for simulations, options to set matching algorithm and index reduction method for 
simulation. Display all the files generated during the simulation is now supported. Options to set 
OMC command line flags. 

• Options: options for loading libraries via loadModel and loadFile each time GUI starts, save the last 
open file directory location, options for setting line wrap mode and syntax highlighting. 

• Modelica Text Editor: preserving user customizations, new search & replace functionality, support 
for comment/uncomment. 

• Notifications: show custom dialogs to users allowing them to choose whether they want to see this 
dialog again or not. 

• Model Creation: Better support for creating new classes. Easy creation of extends classes or nested 
classes. 
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• Messages Widget: Multi line error messages are now supported. 
• Crash Detection: The GUI now automatically detects the crash and writes a stack trace file. The 

user is given an option to send a crash report along with the stack trace file and few other useful 
files via email.  

• Autosave: OMEdit saves the currently edited model regularly, in order to avoid losing edits after 
GUI or compiler crash. The save interval can be set in the Options menu. 

A.1.7 Optimization 
Dynamic optimization with XML export to the CaSAdi package is now integrated with OpenModelica.  
Moreover, a native integrated Dynamic Optimization prototype using Ipopt is now in the OpenModelica 
release, but currently needs a special flag to be turned on since it needs more testing and refinement before 
being generally made available. 

A.1.8 FMI Support 
FMI co-simulation with OpenModelica as master. Improved FMI Import and export for model exchange. 
Simulation of multiple instances of the FMU is now possible. Partial support for FMI 2.0 model exchange. 

A.2 OpenModelica 1.8.1, March 2012 
The OpenModelica 1.8.1 release has a faster and more stable OMC model compiler. It flattens and 
simulates more models than the previous 1.8.0 version. Significant flattening speedup of the compiler has 
been achieved for certain large models. It also contains a New ModelicaML version with support for value 
bindings in requirements-driven modeling and importing Modelica library models into ModelicaML 
models. A beta version of the new OpenModelica Python scripting is also included. 

A.2.1 OpenModelica Compiler (OMC) 
This release includes bug fixes and improvements of the flattening frontend part of the OpenModelica 
Compiler (OMC) and several improvements of the backend, including, but not restricted to: 

• A faster and more stable OMC model compiler. The 1.8.1 version flattens and simulates more 
models than the previous 1.8.0 version. 

• Support for operator overloading (except Complex numbers). 
• New ModelicaML version with support for value bindings in requirements-driven modeling and 

importing Modelica library models into ModelicaML models. 
• Faster plotting in OMNotebook. The feature sendData has been removed from OpenModelica. As a 

result, the kernel no longer depends on Qt. The plot3() family of functions have now replaced to 
plot(), which in turn have been removed. The non-standard visualize() command has been removed 
in favour of more recent alternatives. 

• Store OpenModelica documentation as Modelica Documentation annotations. 
• Re-implementation of the simulation runtime using C instead of C++ (this was needed to export 

FMI source-based packages). 
• FMI import/export bug fixes. 
• Changed the internal representation of various structures to share more memory. This significantly 

improved the performance for very large models that use records. 
• Faster model flattening, Improved simulation, some graphical API bug fixes. 
• More robust and general initialization, but currently time-consuming. 
• New initialization flags to omc and options to simulate(), to control whether fast or robust 

initialization is selected, or initialization from an external (.mat) data file. 
• New options to API calls list, loadFile, and more. 
• Enforce the restriction that input arguments of functions may not be assigned to. 
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• Improved the scripting environment. cl := $TypeName(Modelica);getClassComment(cl); now 
works as expected. As does looping over lists of typenames and using reduction expressions. 

• Beta version of Python scripting. 
• Various bugfixes. 

• NOTE: interactive simulation is not operational in this release. It will be put back again in the near 
future, first available as a nightly build. It is also available in the previous 1.8.0 release. 

A.2.2 OpenModelica Notebook (OMNotebook) 
Faster and more stable plottning. 

A.2.3 OpenModelica Shell (OMShell) 
No changes. 

A.2.4 OpenModelica Eclipse Plug-in (MDT) 
Small fixes and improvements. 

A.2.5 OpenModelica Development Environment (OMDev) 
No changes. 

A.2.6 Graphic Editor OMEdit 
Bug fixes.  

A.2.7 New OMOptim Optimization Subsystem 
Bug fixes. 

A.2.8 FMI Support 
Bug fixes. 

A.3 OpenModelica 1.8, November 2011 
The OpenModelica 1.8 release contains OMC flattening improvements for the Media library – it now 
flattens the whole library and simulates about 20% of its example models. Moreover, about half of the 
Fluid library models also flatten. This release also includes two new tool functionalities – the FMI for 
model exchange import and export, and a new efficient Eclipse-based debugger for 
Modelica/MetaModelica algorithmic code. 

A.3.1 OpenModelica Compiler (OMC) 
This release includes bug fixes and improvements of the flattening frontend part of the OpenModelica 
Compiler (OMC) and several improvements of the backend, including, but not restricted to: 

• A faster and more stable OMC model compiler. The 1.8.1 version flattens and simulates more 
models than the previous 1.7.0 version. 

•  Flattening of the whole Media library, and about half of the Fluid library. Simulation of 
approximately 20% of the Media library example models. 

• Functional Mockup Interface FMI 1.0 for model exchange, export and import, for the Windows 
platform. 

• Bug fixes in the OpenModelica graphical model connection editor OMEdit, supporting easy-to-use 
graphical drag-and-drop modeling and MSL 3.1. 
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• Bug fixes in the OMOptim optimization subsystem. 
• Beta version of compiler support for a new Eclipse-based very efficient algorithmic code debugger 

for functions in MetaModelica/Modelica, available in the development environment when using the 
bootstrapped OpenModelica compiler.  

• Improvements in initialization of simulations. 
• Improved index reduction with dynamic state selection, which improves simulation. 
• Better error messages from several parts of the compiler, including a new API call for giving better 

error messages. 
• Automatic partitioning of equation systems and multi-core parallel simulation of independent parts 

based on the shared-memory OpenMP model. This version is a preliminary experimental version 
without load balancing. 

A.3.2 OpenModelica Notebook (OMNotebook) 
No changes. 

A.3.3 OpenModelica Shell (OMShell) 
Small performance improvements. 

A.3.4 OpenModelica Eclipse Plug-in (MDT) 
Small fixes and improvements. MDT now also includes a beta version of a new Eclipse-based very 
efficient algorithmic code debugger for functions in MetaModelica/Modelica.  

A.3.5 OpenModelica Development Environment (OMDev) 
Third party binaries, including Qt libraries and executable Qt clients, are now part of the OMDev package. 
Also, now uses GCC 4.4.0 instead of the earlier GCC 3.4.5. 

A.3.6 Graphic Editor OMEdit 
Bug fixes. Access to FMI Import/Export through a pull-down menu. Improved configuration of library 
loading. A function to go to a specific line number. A button to cancel an on-going simulation. Support for 
some updated OMC API calls. 

A.3.7 New OMOptim Optimization Subsystem 
Bug fixes, especially in the Linux version. 

A.3.8 FMI Support 
The Functional Mockup Interface FMI 1.0 for model exchange import and export is supported by this 
release. The functionality is accessible via API calls as well as via pull-down menu commands in OMEdit. 

 

A.4 OpenModelica 1.7, April 2011 
The OpenModelica 1.7 release contains OMC flattening improvements for the Media library, better and 
faster event handling and simulation, and fast MetaModelica support in the compiler, enabling it to 
compiler itself. This release also includes two interesting new tools – the OMOpttim optimization 
subsystem, and a new performance profiler for equation-based Modelica models. 

A.4.1 OpenModelica Compiler (OMC) 
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This release includes bug fixes and performance improvements of the flattening frontend part of the 
OpenModelica Compiler (OMC) and several improvements of the backend, including, but not restricted to: 

• Flattening of the whole Modelica Standard Library 3.1 (MSL 3.1), except Media and Fluid. 
• Progress in supporting the Media library, some models now flatten. 
• Much faster simulation of many models through more efficient handling of alias variables, binary 

output format, and faster event handling. 
• Faster and more stable simulation through new improved event handling, which is now default. 
• Simulation result storage in binary .mat files, and plotting from such files. 
• Support for Unicode characters in quoted Modelica identifiers, including Japanese and Chinese. 
• Preliminary MetaModelica 2.0 support. (use setCommandLineOptions({"+g=MetaModelica"}) ). 

Execution is as fast as MetaModelica 1.0, except for garbage collection. 
• Preliminary bootstrapped OpenModelica compiler: OMC now compiles itself, and the bootstrapped 

compiler passes the test suite. A garbage collector is still missing. 
• Many bug fixes. 

A.4.2 OpenModelica Notebook (OMNotebook) 
Improved much faster and more stable 2D plotting through the new OMPlot module. Plotting from binary 
.mat files. Better integration between OMEdit and OMNotebook, copy/paste between them. 

A.4.3 OpenModelica Shell (OMShell) 
Same as previously, except the improved 2D plotting through OMPlot. 

A.4.4 OpenModelica Eclipse Plug-in (MDT) 
Same as previously. 

A.4.5 OpenModelica Development Environment (OMDev)  
No changes. 

A.4.6 Graphic Editor OMEdit 
Several enhancements of OMEdit are included in this release. Support for Icon editing is now available. 
There is also an improved much faster 2D plotting through the new OMPlot module. Better integration 
between OMEdit and OMNotebook, with copy/paste between them. Interactive on-line simulation is 
available in an easy-to-use way. 

A.4.7 New OMOptim Optimization Subsystem 
A new optimization subsystem called OMOptim has been added to OpenModelica. Currently, parameter 
optimization using genetic algorithms is supported in this version 0.9. Pareto front optimization is also 
supported. 

A.4.8 New Performance Profiler 
A new, low overhead, performance profiler for Modelica models has been developed. 

A.5 OpenModelica 1.6, November 2010 
The OpenModelica 1.6 release primarily contains flattening, simulation, and performance improvements 
regarding Modelica Standard Library 3.1 support, but also has an interesting new tool – the OMEdit 
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graphic connection editor, and a new educational material called DrControl, and an improved ModelicaML 
UML/Modelica profile with better support for modeling and requirement handling. 

A.5.1 OpenModelica Compiler (OMC) 
This release includes bug fix and performance improvemetns of the flattening frontend part of the 
OpenModelica Compiler (OMC) and some improvements of the backend, including, but not restricted to: 

• Flattening of the whole Modelica Standard Library 3.1 (MSL 3.1), except Media and Fluid. 
• Improved flattening speed of a factor of 5-20 compared to OpenModelica 1.5 for a number of 

models, especially in the MultiBody library. 
• Reduced memory consumption by the OpenModelica compiler frontend, for certain large models a 

reduction of a factor 50. 
• Reorganized, more modular OpenModelica compiler backend, can now handle approximately 

30 000 equations, compared to previously approximately 10 000 equations. 
• Better error messages from the compiler, especially regarding functions. 
• Improved simulation coverage of MSL 3.1. Many models that did not simulate before are now 

simulating. However, there are still many models in certain sublibraries that do not simulate. 
• Progress in supporting the Media library, but simulation is not yet possible. 
• Improved support for enumerations, both in the frontend and the backend. 
• Implementation of stream connectors. 
• Support for linearization through symbolic Jacobians. 
• Many bug fixes. 

A.5.2 OpenModelica Notebook (OMNotebook) 
A new DrControl electronic notebook for teaching control and modeling with Modelica. 

A.5.3 OpenModelica Shell (OMShell) 
Same as previously. 

A.5.4 OpenModelica Eclipse Plug-in (MDT) 
Same as previously. 

A.5.5 OpenModelica Development Environment (OMDev)  
Several enhancements. Support for match-expressions in addition to matchcontinue. Support for real if-
then-else. Support for if-then without else-branches. Modelica Development Tooling 0.7.7 with small 
improvements such as more settings, improved error detection in console, etc. 

A.5.6 New Graphic Editor OMEdit 
A new improved open source graphic model connection editor called OMEdit, supporting 3.1 graphical 
annotations, which makes it possible to move models back and forth to other tools without problems. The 
editor has been implemented by students at Linköping University and is based on the C++ Qt library. 

A.6 OpenModelica 1.5, July 2010 
This OpenModelica 1.5 release has major improvements in the OpenModelica compiler frontend and some 
in the backend. A major improvement of this release is full flattening support for the MultiBody library as 
well as limited simulation support for MultiBody. Interesting new facilities are the interactive simulation 
and the integrated UML-Modelica modeling with ModelicaML. Approximately 4 person-years of 
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additional effort have been invested in the compiler compared to the 1.4.5 version, e.g., in order to have a 
more complete coverage of Modelica 3.0, mainly focusing on improved flattening in the compiler frontend. 

A.6.1 OpenModelica Compiler (OMC) 
This release includes major improvements of the flattening frontend part of the OpenModelica Compiler 
(OMC) and some improvements of the backend, including, but not restricted to: 

• Improved flattening speed of at least a factor of 10 or more compared to the 1.4.5 release, primarily 
for larger models with inner-outer, but also speedup for other models, e.g. the robot model flattens 
in approximately 2 seconds. 

• Flattening of all MultiBody models, including all elementary models, breaking connection graphs, 
world object, etc. Moreover, simulation is now possible for at least five MultiBody models: 
Pendulum, DoublePendulum, InitSpringConstant, World, PointGravityWithPointMasses.  

• Progress in supporting the Media library, but simulation is not yet possible. 
• Support for enumerations, both in the frontend and the backend. 
• Support for expandable connectors. 
• Support for the inline and late inline annotations in functions. 
• Complete support for record constructors, also for records containing other records. 
• Full support for iterators, including nested ones. 
• Support for inferred iterator and for-loop ranges. 
• Support for the function derivative annotation. 
• Prototype of interactive simulation. 
• Prototype of integrated UML-Modelica modeling and simulation with ModelicaML. 
• A new bidirectional external Java interface for calling external Java functions, or for calling 

Modelica functions from Java. 
• Complete implementation of replaceable model extends. 
• Fixed problems involving arrays of unknown dimensions. 
• Limited support for tearing. 
• Improved error handling at division by zero. 
• Support for Modelica 3.1 annotations. 
• Support for all MetaModelica language constructs inside OpenModelica. 
• OpenModelica works also under 64-bit Linux and Mac 64-bit OSX. 
• Parallel builds and running test suites in parallel on multi-core platforms. 
• New OpenModelica text template language for easier implementation of code generators, XML 

generators, etc. 
• New OpenModelica code generators to C and C# using the text template language. 
• Faster simulation result data file output optionally as comma-separated values. 
• Many bug fixes. 

It is now possible to graphically edit models using parts from the Modelica Standard Library 3.1, since the 
simForge graphical editor (from Politecnico di Milano) that is used together with OpenModelica has been 
updated to version 0.9.0 with a important new functionality, including support for Modelica 3.1 and 3.0 
annotations. The 1.6 and 2.2.1 Modelica graphical annotation versions are still supported. 

A.6.2 OpenModelica Notebook (OMNotebook) 
Improvements in platform availability. 

• Support for 64-bit Linux. 
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• Support for Windows 7. 
• Better support for MacOS, including 64-bit OSX. 

A.6.3 OpenModelica Shell (OMShell) 
Same as previously. 

A.6.4 OpenModelica Eclipse Plug-in (MDT) 
Minor bug fixes. 

A.6.5 OpenModelica Development Environment (OMDev)  
Minor bug fixes. 

A.7 OpenModelica 1.4.5, January 2009 
This release has several improvements, especially platform availability, less compiler memory usage, and 
supporting more aspects of  Modelica 3.0. 

A.7.1 OpenModelica Compiler (OMC) 
This release includes small improvements and some bugfixes of the OpenModelica Compiler (OMC): 

• Less memory consumption and better memory management over time. This also includes a better 
API supporting automatic memory management when calling C functions from within the compiler.  

• Modelica 3.0 parsing support. 
• Export of DAE to XML and MATLAB. 
• Support for several platforms Linux, MacOS, Windows (2000, Xp, Vista). 
• Support for record and strings as function arguments. 
• Many bug fixes. 
• (Not part of OMC): Additional free graphic editor SimForge can be used with OpenModelica. 

A.7.2 OpenModelica Notebook (OMNotebook) 
A number of improvements, primarily in the plotting functionality and platform availability. 

• A number of improvements in the plotting functionality: scalable plots, zooming, logarithmic plots, 
grids, etc. 

• Programmable plotting accessible through a Modelica API. 
• Simple 3D visualization. 
• Support for several platforms Linux, MacOS, Windows (2000, Xp, Vista). 

A.7.3 OpenModelica Shell (OMShell) 
Same as previously. 

A.7.4 OpenModelica Eclipse Plug-in (MDT) 
Minor bug fixes. 

A.7.5 OpenModelica Development Environment (OMDev)  
Same as previously. 

A.1 OpenModelica 1.4.4, Feb 2008 
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This release is primarily a bug fix release, except for a preliminary version of new plotting functionality 
available both from the OMNotebook and separately through a Modelica API. This is also the first release 
under the open source license OSMC-PL (Open Source Modelica Consortium Public License), with 
support from the recently created Open Source Modelica Consortium. An integrated version handler, bug-, 
and issue tracker has also been added. 

A.7.6 OpenModelica Compiler (OMC) 
This release includes small improvements and some bugfixes of the OpenModelica Compiler (OMC): 

• Better support for if-equations, also inside when. 
• Better support for calling functions in parameter expressions and interactively through dynamic 

loading of functions. 
• Less memory consumtion during compilation and interactive evaluation. 
• A number of bug-fixes. 

A.7.7 OpenModelica Notebook (OMNotebook) 
Test release of improvements, primarily in the plotting functionality and platform availability. 

• Preliminary version of improvements in the plotting functionality: scalable plots, zooming, 
logarithmic plots, grids, etc., currently available in a preliminary version through the plot2 function. 

• Programmable plotting accessible through a Modelica API. 

A.7.8 OpenModelica Shell (OMShell) 
Same as previously. 

A.7.9 OpenModelica Eclipse Plug-in (MDT) 
This release includes minor bugfixes of MDT and the associated MetaModelica debugger: 

A.7.10 OpenModelica Development Environment (OMDev)  
Extended test suite with a better structure. Version handling, bug tracking, issue tracking, etc. now 
available under the integrated Codebeamer  

A.8 OpenModelica 1.4.3, June 2007 
This release has  a number of significant improvements of the OMC compiler, OMNotebook, the MDT 
plugin and the OMDev. Increased platform availability now also for Linux and Macintosh, in addition to 
Windows. OMShell is the same as previously, but now ported to Linux and Mac. 

A.8.1 OpenModelica Compiler (OMC) 
This release includes a number of  improvements of the OpenModelica Compiler (OMC): 

• Significantly increased compilation speed, especially with large models and many packages. 
• Now available also for Linux and Macintosh platforms. 
• Support for when-equations in algorithm sections, including elsewhen.  
• Support for inner/outer prefixes of components (but without type error checking). 
• Improved solution of nonlinear systems. 
• Added ability to compile generated simulation code using Visual Studio compiler. 
• Added "smart setting of fixed attribute to false. If initial equations, OMC instead has fixed=true as 

default for states due to allowing overdetermined initial equation systems. 
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• Better state select heuristics. 
• New function getIncidenceMatrix(ClassName) for dumping the incidence matrix. 
• Builtin functions String(), product(), ndims(), implemented. 
• Support for terminate() and assert() in equations. 
• In emitted flat form: protected variables are now prefixed with protected when printing flat class. 
• Some support for  tables, using omcTableTimeIni instead of dymTableTimeIni2. 
• Better support for empty arrays, and support for matrix operations like  a*[1,2;3,4]. 
• Improved val() function can now evaluate array elements and record fields, e.g. val(x[n]), val(x.y) . 
• Support for reinit in algorithm sections. 
• String support in external functions. 
• Double precision floating point precision now also for interpreted expressions 
• Better simulation error messages. 
• Support for der(expressions). 
• Support for iterator expressions such as {3*i for i in 1..10}. 
• More test cases in the test suite. 
• A number of bug fixes, including sample and event handling bugs. 

A.8.2 OpenModelica Notebook (OMNotebook) 
A number of improvements, primarily in the platform availability. 

• Available on the Linux and Macintosh platforms, in addition to Windows. 
• Fixed cell copying bugs, plotting of derivatives now works, etc. 

A.8.3 OpenModelica Shell (OMShell) 
Now available also on the Macintosh platform. 

A.8.4 OpenModelica Eclipse Plug-in (MDT) 
This release includes major improvements of MDT and the associated MetaModelica debugger: 

• Greatly improved browsing and code completion works both for standard Modelica and for 
MetaModelica. 

• Hovering over identifiers displays type information. 
• A new and greatly improved implementation of the debugger for MetaModelica algorithmic code, 

operational in Eclipse. Greatly improved performance – only approx 10% speed reduction even for 
100 000 line programs. Greatly improved single stepping, step over, data structure browsing, etc. 

• Many bug fixes. 

A.8.5 OpenModelica Development Environment (OMDev)  
Increased compilation speed for MetaModelica. Better if-expression support in MetaModelica. 

A.9 OpenModelica 1.4.2, October 2006 
This release has improvements and bug fixes of the OMC compiler, OMNotebook, the MDT plugin and the 
OMDev. OMShell is the same as previously. 

A.9.1 OpenModelica Compiler (OMC) 
This release includes further improvements of the OpenModelica Compiler (OMC): 
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• Improved initialization and index reduction. 
• Support for integer arrays is now largely implemented. 
• The val(variable,time) scripting function for accessing the value of a simulation result variable at a 

certain point in the simulated time. 
• Interactive evalution of for-loops, while-loops, if-statements, if-expressions, in the interactive 

scripting mode. 
• Improved documentation and examples of calling the Model Query and Manipulation API. 
• Many bug fixes. 

A.9.2 OpenModelica Notebook (OMNotebook) 
Search and replace functions have been added. The DrModelica tutorial (all files) has been updated, 
obsolete sections removed, and models which are not supported by the current implementation marked 
clearly. Automatic recognition of the .onb suffix (e.g. when double-clicking) in Windows makes it even 
more convenient to use. 

A.9.3 OpenModelica Eclipse Plug-in (MDT) 
Two major improvements are added in this release: 

• Browsing and code completion works both for standard Modelica and for MetaModelica. 
• The debugger for algorithmic code is now available and operational in Eclipse for debugging of 

MetaModelica programs. 

A.9.4 OpenModelica Development Environment (OMDev)  
Mostly the same as previously. 

A.10 OpenModelica 1.4.1, June 2006 
This release has only improvements and bug fixes of the OMC compiler, the MDT plugin and the OMDev 
components. The OMShell and OMNotebook are the same. 

A.10.1 OpenModelica Compiler (OMC) 
This release includes further improvements of the OpenModelica Compiler (OMC): 

• Support for external objects. 
• OMC now reports the version number (via command line switches or CORBA API getVersion()). 
• Implemented caching for faster instantiation of large models. 
• Many bug fixes. 

A.10.2 OpenModelica Eclipse Plug-in (MDT) 
Improvements of the error reporting when building the OMC compiler. The errors are now added to the 
problems view. The latest MDT release is version 0.6.6 (2006-06-06). 

A.10.3 OpenModelica Development Environment (OMDev)  
Small fixes in the MetaModelica compiler. MetaModelica Users Guide is now part of the OMDev release. 
The latest OMDev was release in 2006-06-06. 

A.11 OpenModelica 1.4.0, May 2006 
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This release has a number of improvements described below. The most significant change is probably that 
OMC has now been translated to an extended subset of Modelica (MetaModelica), and that all development 
of the compiler is now done in this version.. 

A.11.1 OpenModelica Compiler (OMC) 
This release includes further improvements of the OpenModelica Compiler (OMC): 

• Partial support for mixed system of equations. 
• New initialization routine, based on optimization (minimizing residuals of initial equations). 
• Symbolic simplification of builtin operators for vectors and matrices. 
• Improved code generation in simulation code to support e.g. Modelica functions. 
• Support for classes extending basic types, e.g. connectors (support for MSL 2.2 block connectors). 
• Support for parametric plotting via the plotParametric command. 
• Many bug fixes. 

A.11.2 OpenModelica Shell (OMShell) 
Essentially the same OMShell as in 1.3.1. One difference is that now all error messages are sent to the 
command window instead of to a separate log window. 

A.11.3 OpenModelica Notebook (OMNotebook) 
Many significant improvements and bug fixes. This version supports graphic plots within the cells in the 
notebook. Improved cell handling and Modelica code syntax highlighting. Command completion of the 
most common OMC commands is now supported. The notebook has been used in several courses. 

A.11.4 OpenModelica Eclipse Plug-in (MDT) 
This is the first really useful version of MDT. Full browsing of Modelica code, e.g. the MSL 2.2, is now 
supported. (MetaModelica browsing is not yet fully supported). Full support for automatic indentation of 
Modelica code, including the MetaModelica extensions. Many bug fixes. The Eclipse plug-in is now in use 
for OpenModelica development at PELAB and MathCore Engineering AB since approximately one month. 

A.11.5 OpenModelica Development Environment (OMDev) 
The following mechanisms have been put in place to support OpenModelica development. 

• A separate web page for OMDev  (OpenModelica Development Environment). 

• A pre-packaged OMDev zip-file with precompiled binaries for development under Windows using 
the mingw Gnu compiler from the Eclipse MDT plug-in. (Development is also possible using 
Visual Studio). 

• All source code of the OpenModelica compiler has recently been translated to an extended subset of 
Modelica, currently called MetaModelica. The current size of OMC is approximately 100 000 lines 
All development is now done in this version. 

• A new tutorial and users guide for development in MetaModelica. 
• Successful builds and tests of OMC under Linux and Solaris. 
 

A.12 OpenModelica 1.3.1, November 2005 
This release has several important highlights. 
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This is also the first release for which the New BSD (Berkeley) open-source license applies to the source 
code, including the whole compiler and run-time system. This makes is possible to use OpenModelica for 
both academic and commercial purposes without restrictions. 

A.12.1 OpenModelica Compiler (OMC) 
This release includes a significantly improved OpenModelica Compiler (OMC): 

• Support for hybrid and discrete-event simulation (if-equations, if-expressions, when-equations;    
not yet if-statements and when-statements). 

• Parsing of full Modelica 2.2 
• Improved support for external functions. 
• Vectorization of function arguments; each-modifiers, better implementation of replaceable, better 

handling of structural parameters, better support for vector and array operations, and many other 
improvements. 

• Flattening of the Modelica Block library version 1.5 (except a few models), and simulation of most 
of these. 

• Automatic index reduction (present also in previous release). 
• Updated User's Guide including examples of hybrid simulation and external functions. 

A.12.2 OpenModelica Shell (OMShell) 
An improved window-based interactive command shell, now including command completion and better 
editing and font size support.  

A.12.3 OpenModelica Notebook (OMNotebook) 
A free implementation of an OpenModelica notebook (OMNOtebook), for electronic books with course 
material, including the DrModelica interactive course material. It is possible to simulate and plot from this 
notebook. 

A.12.4 OpenModelica Eclipse Plug-in (MDT) 
An early alpha version of the first Eclipse plug-in (called MDT for Modelica Development Tooling) for 
Modelica Development. This version gives compilation support and partial support for browsing Modelica 
package hierarchies and classes. 

A.12.5 OpenModelica Development Environment (OMDev) 
The following mechanisms have been put in place to support OpenModelica development. 

• Bugzilla support for OpenModelica bug tracking, accessible to anybody. 
• A system for automatic regression testing of the compiler and simulator, (+ other system parts) 

usually run at check in time. 
• Version handling is done using SVN, which is better than the previously used CVS system. For 

example, name change of modules is now possible within the version handling system. 
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Appendix B  
 
Contributors to OpenModelica 

This Appendix lists the individuals who have made significant contributions to OpenModelica, in the form 
of software development, design, documentation, project leadership, tutorial material, promotion, etc. The 
individuals are listed for each year, from 1998 to the current year: the project leader and main author/editor 
of this document followed by main contributors followed by contributors in alphabetical order. 

B.1 OpenModelica Contributors 2013 
Peter Fritzson, PELAB, Linköping University, Linköping, Sweden. 

Adrian Pop, PELAB, Linköping University, Linköping, Sweden. 
Adeel Asghar, PELAB, Linköping University, Linköping, Sweden. 
Willi Braun, Fachhochschule Bielefeld, Bielefeld, Germany. 
Jens Frenkel, TU Dresden, Dresden, Germany. 
Lennart Ochel, Fachhochschule Bielefeld, Bielefeld, Germany. 
Martin Sjölund, PELAB, Linköping University, Linköping, Sweden. 
Per Östlund, PELAB, Linköping University, Linköping, Sweden. 

Peter Aronsson, MathCore Engineering AB, Linköping, Sweden. 
Bernhard Bachmann, Fachhochschule Bielefeld, Bielefeld, Germany. 
Vasile Baluta, PELAB, Linköping University, Linköping, Sweden. 
Robert Braun, IEI, Linköping University, Linköping, Sweden. 
David Broman, PELAB, Linköping University, Linköping, Sweden. 
Stefan Brus, PELAB, Linköping University, Linköping, Sweden. 
Lena Buffoni, PELAB, Linköping University, Linköping, Sweden. 
Francesco Casella, Politecnico di Milano, Milan, Italy. 
Filippo Donida, Politecnico di Milano, Milan, Italy. 
Mahder Gebremedhin, PELAB, Linköping University, Linköping, Sweden. 
Pavel Grozman, Equa AB, Stockholm, Sweden. 
Michael Hanke, NADA, KTH, Stockholm. 
Daniel Hedberg, MathCore Engineering AB, Linköping, Sweden. 
Zoheb Hossain, PELAB, Linköping University, Linköping, Sweden. 
Alf Isaksson, ABB Corporate Research, Västerås, Sweden. 
Daniel Kanth, Bosch-Rexroth, Lohr am Main, Germany. 
Tommi Karhela, VTT, Espoo, Finland. 
Petter Krus, IEI, Linköping University, Linköping, Sweden. 
Juha Kortelainen, VTT, Espoo, Finland.  
Abhinn Kothari, PELAB, Linköping University, Linköping, Sweden. 
Alexey Lebedev, Equa Simulation AB, Stockholm, Sweden. 
Oliver Lenord, Siemens PLM, California, USA. 
Ariel Liebman, Energy Users Association of Australia, Victoria, Australia. 
Henrik Magnusson, Linköping, Sweden. 
Abhi Raj Metkar, CDAC, Trivandrum, Kerala, India. 
Eric Meyers, Pratt & Whitney Rocketdyne, Palm City, Florida, USA. 
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Tuomas Miettinen, VTT, Espoo, Finland. 
Afshin Moghadam, PELAB, Linköping University, Linköping, Sweden. 
Maroun Nemer, CEP Paristech, Ecole des Mines, Paris, France. 
Hannu Niemistö, VTT, Espoo, Finland. 
Peter Nordin, IEI, Linköping University, Linköping, Sweden. 
Arunkumar Palanisamy, PELAB, Linköping University, Linköping, Sweden. 
Karl Pettersson, IEI, Linköping University, Linköping, Sweden. 
Pavol Privitzer, Institute of Pathological Physiology, Praha, Czech Republic. 
Jhansi Remala, PELAB, Linköping University, Linköping, Sweden. 
Reino Ruusu, VTT, Espoo, Finland. 
Per Sahlin, Equa Simulation AB, Stockholm, Sweden. 
Wladimir Schamai, EADS, Hamburg, Germany. 
Gerhard Schmitz, University of Hamburg, Hamburg, Germany. 
Alachew Shitahun, PELAB, Linköping University, Linköping, Sweden. 
Anton Sodja, University of Ljubljana, Ljubljana, Slovenia 
Ingo Staack, IEI, Linköping University, Linköping, Sweden. 
Kristian Stavåker, PELAB, Linköping University, Linköping, Sweden. 
Sonia Tariq, PELAB, Linköping University, Linköping, Sweden. 
Hubert Thierot, CEP Paristech, Ecole des Mines, Paris, France. 
Mohsen Torabzadeh-Tari, PELAB, Linköping University, Linköping, Sweden. 
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